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Chapter 1| About Scopia Desktop

Scopia Desktop is a desktop videoconferencing system turning Windows PCs, Apple Macintosh computers and
mobile devices into videoconferencing endpoints. It includes the latest in video technology including support for HD
video, NetSense for video quality optimization, Scalable Video Coding (SVC) for unsurpassed error resiliency and
H.264 for viewing both meeting participants and data collaboration. Its audio system provides echo cancellation,
background noise suppression, and is highly resilient to network errors common on the Internet.

Scopia Desktop is comprised of the Scopia Desktop Server and a lightweight Scopia Desktop Client which turns a
PC or Mac into a videoconferencing endpoint. Scopia Mobile users can also access the Scopia Desktop Server from
their iOS and Android devices. For more information on Scopia Mobile, see the User Guide for Scopia Mobile.

Navigation

* About Scopia Desktop Server on page 6

* About Components of the Scopia Desktop Server on page 7

* About Scopia Desktop Client on page 8

About Scopia Desktop Server

Scopia Desktop Server is easy to use and includes firewall traversal features to ensure call connectivity
and quality videoconferencing. Additionally, Scopia Desktop Server supports advanced
videoconferencing features such as Continuous Presence video, H.239 data collaboration, PIN
protected meetings, conference moderation, full authentication and authorization, and SIP point-to-point
communication between Scopia Desktop Clients.

The Scopia Desktop Server requires Scopia Elite MCU as part of its deployment.
Scopia Desktop offers the following additional features:
* Integration with Microsoft Outlook

Users can send invitations to videoconferences directly from Microsoft Outlook using the Scopia
Add-in for Microsoft Outlook. The 32 bit version works directly with the Scopia Desktop Server,
while the 64 bit version works directly with Scopia Management. For more information, see User
Guide for Scopia Add-in for Microsoft Outlook.

* Streaming and recording

You can create webcasts for others to view your videoconference, and you can record meetings
for later viewing.

* Chat messages to meeting participants

Users can send public or private chat messages to meeting participants, including those
connecting via dedicated endpoints or room systems.

* Service provider (multi-tenant) support
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Scopia Desktop works alongside Scopia Management to support service provider deployments
which cater for multiple organizations (tenants). In a multi-tenant deployment, each Scopia
Desktop meeting is associated with only one tenant. Multi-tenant features include:

— All Scopia Desktop Clients only see contacts (users or endpoints) belonging to their own
organization.

— When browsing or searching a recording, Scopia Desktop Clients only see recordings
belonging to their own organization.

* Scalability with an external load balancer

Scopia Desktop works with load balancers like F5 and Radware's AppDirector, providing unlimited
scalability, high availability and redundancy for large deployments.

* Microsoft Lync support

With Scopia Video Gateway in your deployment, Scopia Desktop Clients can invite Microsoft Lync
users to a meeting.

About Components of the Scopia Desktop Server

Scopia Desktop Server includes a variety of different servers, each fulfilling its own function (Figure
1: Components of the Scopia Desktop Server on page 7).

Scopia Desktop Server

Scopia Desktop Recording Server | Streaming § XMPP STUN
Conference Server § Content Slider Server Server Server

Dial directto
Web.Ser':.rer Server [J a bbe.r] Scopin Dekiop
Application Server EoNe Clients behind

(Tomcat)

sl NATz or firewalls

34

Figure 1: Components of the Scopia Desktop Server

* Scopia Desktop Conference Server

At the center of Scopia Desktop Server, the conference server creates conferences with Scopia
Desktop Clients and Scopia Mobile devices, relaying media to the MCU to enable transparent
connectivity with H.323 and SIP endpoints.

* Scopia Desktop Application Server (Tomcat)

The underlying Scopia Desktop web server and application server is implemented by Tomcat. It
serves as the login server, the update server, the recording server, the Scopia Content Slider
server and the Scopia Desktop web portal.

Administrator Guide for Scopia Desktop Server Version 7.7.3 About Scopia Desktop | 7




* Scopia Desktop Streaming Server (Darwin)
Responsible for streaming webcasts.
* Scopia Desktop Recording Server

Part of the Tomcat Application Server, this service is responsible for recording meetings, storing
the recordings and providing HTTP access to the recordings.

* Scopia Content Slider server

Part of the Tomcat Application Server, it stores the data already presented in the videoconference
and makes it available for participants to view during the meeting.

* STUN Server

Enables you to directly dial a Scopia Desktop Client behind a NAT or firewall in point-to-point
implementations by giving that computer’s public internet address. Third-party STUN Servers are
supported.

Place the STUN Server in the DMZ, accessible by the Scopia Desktop Clients participating in a
call. The STUN Server should have its own public IP address, not a NAT address.

Scopia Desktop Presence (XMPP) Server (Jabber)

Maintains a live list of contacts which are available or unavailable for video chat or
videoconference. This information is presented in the Contact List of Scopia Desktop Pro. The
XMPP server is also responsible for user authentication, and it is used for attendee registration and
invitations.

About Scopia Desktop Client

The Scopia Desktop Client is a simple web browser plug-in for interactive videoconferencing using high
definition or standard definition with superb quality. It is part of Scopia Desktop, the desktop
videoconferencing solution which provides the client/server application that extends videoconferencing
to remote and desktop users for voice, video and data communications.

Clients can be centrally managed and deployed without complex licensing fees or installation issues.
Users receive a web link in their invitation to join a videoconference, and in moments they are connected
and participating. The standard Scopia Desktop Client includes the main videoconference client with a
built-in chat window and presentation viewing abilities (Figure 2: The Scopia Desktop Client user
interface on page 9).

Administrator Guide for Scopia Desktop Server Version 7.7.3 About Scopia Desktop | 8




T T TTTITRE e ve I resere B woorans -

Dona - Paris

Figure 2: The Scopia Desktop Client user interface

Users can have their own login, enabling each to have a virtual room to invite people to meetings.

A Scopia Add-in for Microsoft Outlook enables easy scheduling of meetings directly from within Microsoft
Outlook. There are two types of Scopia Add-in for Microsoft Outlook: the 32 bit version works directly
with the Scopia Desktop Server, while the 64 bit version works directly with Scopia Management. The 32
bit version of Scopia Add-in for Microsoft Outlook is installed together with Scopia Desktop Client, as
described in Installing Scopia Desktop Client Locally on a PC on page 73. You can also configure the

64 bit version to install together with Scopia Desktop Client, or run a standalone installation. For more
information, see the User Guide for Scopia Add-in for Microsoft Outlook.

Administrator Guide for Scopia Desktop Server Version 7.7.3 About Scopia Desktop | 9




Chapter 2| Planning your Scopia Desktop
Server Deployment

When planning your Scopia Desktop Server deployment, consider the following:
* How many users will be simultaneously connecting to videoconferences?

* Will most Scopia Desktop Clients connect to videoconferences from within the enterprise, or from outside? For
example, if there are many internal Scopia Desktop Clients, consider placing a dedicated Conference Server in
the enterprise.

* If reliability is a requirement, consider deploying redundant Scopia Desktop Servers.

* How often will your organization record videoconferences? How often will those recordings be viewed? Are
there likely to be many simultaneous viewers?

For example, if recording is a major part of your videoconferencing experience, you may decide to deploy a
dedicated Recording Server.

* Will most users join videoconferences as participants, or view webcasts of meetings?
* What is your network's security policy?

Depending on where you deploy the Scopia Desktop Server and other video network devices, you may need to
open different ports on the firewall.

* How much internal and external bandwidth is required, based on the number of simultaneous users joining
videoconferences? Consider also whether most users will be joining in standard or high definition.

Based on the factors above, decide whether to deploy all Scopia Desktop Server components on one server or on
multiple dedicated servers. See the following sections for details on the different deployment options and how to plan
your bandwidth:

Navigation

* Minimum Requirements and Specifications of Scopia Desktop Server on page 10

* Sizing your Scopia Desktop Server Deployment on page 14

* Planning your Topology for Scopia Desktop Server on page 17

* Deploying Scopia Desktop Server with Dual-NIC on page 27

* Planning your Bandwidth Requirements on page 27

* Ports to Open on Scopia Desktop on page 37

* Obtaining the Scopia Desktop License keys on page 47

Minimum Requirements and Specifications of Scopia
Desktop Server
This section details the system specifications of the Scopia Desktop Server you purchased. Refer to this

data when preparing system setup and afterwards as a means of verifying that the environment still
complies with these requirements.
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Scopia Desktop Server Software Requirements

The minimum software requirements for the Scopia Desktop Server are:
Operating systems:
* Windows 2003 SP2 or Windows 2003 R2, 32 and 64 bit (English, Japanese)
* Windows 2008 SP2 or Windows 2008 R2, 32 and 64 bit (English, Japanese)
* Windows Server 2012

* Windows® 2008 Datacenter or Enterprise Edition (English) with more than 4GB of RAM, or
Windows® 2008 Standard Edition (English) with 4GB or less of RAM

O important:
Scopia Desktop Servers should be deployed on a physical server, not virtual machines like VMware.

Web browsers (for the Scopia Desktop Server Administration):
* Internet Explorer 6, 7, 8, 9 and 10 (Windows)
* Firefox 3.5 or later (Mac and Windows)
* Safari 6 or later (Mac and Windows)
* Google Chrome (Mac and Windows)

The following add-ins for Scopia Desktop integrate it with various third-party products. For more
information, see the relevant add-in documentation.

* The Scopia Connector for IBM Lotus Sametime Connect works with IBM Lotus Sametime 8.0,
8.0.1,8.0.2,8.0.5, 8.5, 8.5.1, and IBM Lotus Notes 8.0.

* The Scopia Connector for IBM Lotus Sametime Web Conferencing works with IBM Lotus
Sametime versions 8.0, 8.0.1, 8.0.2, and 8.0.5.

* The Scopia Add-in for Microsoft Outlook supports Microsoft Office 32 bit and Office 64 bit, but
requires Office 2007 minimum.

Scopia Desktop Server Hardware Requirements

Table 1: Call capacity and minimum hardware requirements for Scopia Desktop Server on page 12
lists the minimum hardware requirements and call capacity for the Scopia Desktop Server.

O important:

* All hard disks should have a minimum of 20Gb.

* The NIC card on the Scopia Desktop Server should be 1Gb full duplex, except for the Scopia
Desktop 25 product, which can use a 100Mb NIC.

* When you initiate a 1MB high definition call, scalability is reduced by fifty percent.

* If the server PC is not strong enough for the maximum number of connections, you can limit the
number of calls in the Scopia Desktop Server. For more information, see Defining Scopia
Desktop Server Public Address and Other Client Connection Settings on page 63.
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Table 1: Call capacity and minimum hardware requirements for Scopia Desktop Server

Product name

Deployment

Maximum ports available

Minimum server hardware required

Scopia Management

15 Scopia Content Slider
sessions

225 streaming sessions

3 recording sessions

Scopia Desktop 25 On the same 25 interactive participants | Dual Intel® Xeon 5120, 1.86 GHz
gomput(;; with 5 Scopia Content Slider RAM: 2GB (3GB with Scopia
copia Management gqqgjons Management and Scopia ECS
75 streaming sessions Gatekeeper on the same computer)
1 recording session 2 virtual cores
100Mb NIC
Scopia Desktop 50 On the same 50 interactive participants | Dual Intel® Xeon 5120, 1.86 GHz
gomp_ut(;; with 10 Scopia Content Slider  |RAM: 2GB (3GB with Scopia
copia Management ¢qqgjons Management and Scopia ECS
150 streaming sessions Gatekeeper on the same computer)
3 recording sessions 2 virtual cores
Scopia Desktop 75 On the same 75 interactive participants | Intel X3430, 2.40GHz
computer with

RAM: 3GB - DDR Il SDRAM — 400
MHz

4 virtual cores

Scopia Desktop 100

On the same
computer with
Scopia Management

100 interactive participants

20 Scopia Content Slider
sessions

300 streaming sessions

5 recording sessions

Intel X3440, 2.53GHz

RAM: 4GB - DDR Il SDRAM — 400
MHz

8 virtual cores

Scopia Desktop 150

Dedicated
conference server
for Scopia Desktop

150 interactive participants

Intel X3430, 2.40GHz

RAM: 3GB - DDR Il SDRAM - 400
MHz

4 virtual cores

conference server
for Scopia Desktop

Scopia Desktop 200 Dedicated 200 interactive participants |Intel X3440, 2.53GHz
g;’r”;ecr:;‘;e;:;‘k’gp RAM: 3GB - DDR Il SDRAM — 400
MHz
8 virtual cores
Scopia Desktop 250 Dedicated 250 interactive participants | Dual Intel X5570, 2.93GHz

RAM: 8GB - 1333 Single Ranked
UDIMM

16 virtual cores

Content Center Server
600/10

Dedicated server for
recording, streaming,
and content slider

40 Scopia Content Slider
sessions

600 streaming sessions

10 recording sessions

Dual Intel X5570, 2.93GHz

RAM: 5GB - DDR Il SDRAM - 400
MHz

16 virtual cores
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Product name Deployment Maximum ports available Minimum server hardware required
Content Center Server |Dedicated server for |20 Scopia Content Slider Intel X3440, 2.53GHz

300/10 recording, streaming, | sessions

. RAM: 3GB - DDR Il SDRAM — 400
and content slider

300 streaming sessions MHz

10 recording sessions 8 virtual cores

Scopia Content Slider |Dedicated server for 100 Scopia Content Slider | Dual Intel X5570, 2.93GHz

Server content slider sessions RAM: 5GB - DDR Il SDRAM — 400
MHz

16 virtual cores

You can store recordings locally on the Content Center Server or on any network server visble from the
Content Center Server. Configure the location of recordings during the server installation (see
Installation Guide for Scopia Desktop Server).

Use the following formula to calculate the space required for recordings:
Recording Bandwidth (in megabytes) x Time (in seconds) + 20% Overhead

For example, for a call of 1 hour at 384 Kbps (standard definition), calculate as follows:

384 Kbps x (60 minutes x 60 seconds) = 1382400 kilobits
1382400 + 1024 = 1350 megabits

1350 + 8 = 168.75 megabytes (MB)

168.75 x 20% = 33.75MB (overhead)

Total is 168.75 + 33.75 = 202.5MB (including overhead)

Scopia Desktop Server Audio and Video Specifications

Scopia Desktop interoperates with both SIP and H.323 endpoints to provide a seamless user experience
joining the ease of use of Scopia Desktop Clients and Scopia Mobile devices with dedicated endpoints
like Scopia XT Executive and the Scopia XT Series.

* Audio support:

— G.722.1 codec

— DTMF tone detection (in-band, H.245 tones, and RFC2833)
* Video support:

— High Definition (HD) Continuous Presence video with a maximum resolution of 720p at 30
frames per second (fps).

— Video codec: H.264 with SVC (Scalable Video Coding)
— Video send resolutions: Up to HD 720p
— Video receive resolution: HD 720p

— Video bandwidth: HD up to 4Mbps for 720p resolutions; standard definition up to 448Kbps for
352p or lower

— Presentation video: H.239 dual stream

— Scopia Content Slider can now function with presentation set to H.263 or H.264 on the MCU.
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Scopia Desktop Server Security Specifications

Scopia Desktop Server has extensive support for security, both standard encryption with certificates and
a proprietary secure protocol between the client and server;

* HTTPS protocol between Scopia Desktop Client and Scopia Desktop Server.
* SRTP encryption between Scopia Desktop Client and Scopia Desktop Server

* TLS encryption between Scopia Desktop Server and Scopia Management

Sizing your Scopia Desktop Server Deployment

Based on your organization's requirements, you can choose to deploy your Scopia Desktop Server in
one of the following ways:

* Topology for Small Scopia Desktop Server Deployment on page 17

* Medium Scopia Desktop Server Deployment with Dedicated Servers on page 18

* Large Scopia Desktop Server Deployment with Dedicated Servers on page 21

Figure 3: Typical Scopia Desktop Server setups based on size of deployment on page 15 illustrates
typical deployments for small, medium, and large organizations. For details on the complete deployment,
including other video infrastructure devices such as Scopia PathFinder Server, see Solution Guide for
Scopia Solution.
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Figure 3: Typical Scopia Desktop Server setups based on size of deployment

Choose a deployment based on factors such as number of users and bandwidth efficiency. Refer to
Table 2: Sizing your Scopia Desktop Server deployment on page 16 for detalils.
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Table 2: Sizing your Scopia Desktop Server deployment

Number of

Simultaneous

Deployment

Participants

Number of Scopia Desktop
Servers

Bandwidth
Considerations

Up to 100

Single all-in-one Scopia Desktop
Server with Scopia Management
(small centralized deployment)

One

To increase reliability, you
can deploy a redundant
server.

To increase the number of
users, you can deploy an
additional Conference Server
for Scopia Desktop.

server

Up to 250 per

Dedicated Servers for medium
organizations (large centralized
deployment)

Typically two Conference
Servers for Scopia Desktop.
One of these servers may
include the Content Center
Server.

Dedicated servers for service providers
(large centralized deployment)

Typically three servers,
depending on how the
Scopia Desktop components
are allocated.

Can be deployed as a cluster
behind a load balancer.

In centralized deployments,
all calls are directed to the
MCUs located in one place.
This puts a strain on
bandwidth if
videoconferences involve
many remote endpoints.

For details on ensuring
sufficient bandwidth for your
deployment, see Planning
your Bandwidth

Requirements on page
27.

Dedicated servers for service providers
(distributed deployment)

One server or cluster in each
location.

Distributed deployments
save bandwidth in large
videoconferences including
many remote endpoints.
However, smaller
videoconferences might be
unnecessarily cascaded
between different MCUs
and therefore use more
bandwidth.

For details on ensuring
sufficient bandwidth for your
deployment, see Planning
your Bandwidth

Requirements on page
27.

You can store recordings locally on the Content Center Server or on any network server visble from the
dedicated Content Center Server. Configure the location of recordings during the server installation (see
Installation Guide for Scopia Desktop Server).

Use the following formula to calculate the space required for recordings:

Recording Bandwidth (in megabytes) x Time (in seconds) + 20% Overhead

For example, for a call of 1 hour at 384 Kbps (standard definition), calculate as follows:

384 Kbps x (60 minutes x 60 seconds) = 1382400 kilobits

1382400 + 1024 = 1350 megabits

Administrator Guide for Scopia Desktop Server Version 7.7.3
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1350 + 8 = 168.75 megabytes (MB)
168.75 x 20% = 33.75MB (overhead)
Total is 168.75 + 33.75 = 202.5MB (including overhead)

Planning your Topology for Scopia Desktop Server

You can deploy the Scopia Desktop components in various ways, depending on factors such as the
number of videoconferencing users in your organization. For guidelines on how to assess your
deployment's capacity, refer to Sizing your Scopia Desktop Server Deployment on page 14.

Scopia Desktop includes the following components:

* Conference Server for Scopia Desktop, to create videoconferences with Scopia Desktop Clients
and Scopia Mobile devices

* Streaming Server for Scopia Desktop (Darwin), to stream webcasts
* Recording Server for Scopia Desktop (Tomcat), to record videoconferences

* Scopia Content Slider (Tomcat) to store data already presented in the videoconference, allowing
participants to view previously shared content during the meeting

* STUN Server for Scopia Desktop to directly dial a Scopia Desktop Client behind a NAT or firewall
in point-to-point implementations
* XMPP Presence Server (Jabber) for Scopia Desktop to maintain the contact list
For more information about the Scopia Desktop components, see About Components of the Scopia
Desktop Server on page 7.

Depending on the size and capacity of your deployment, you can deploy these components on a single
Scopia Desktop Server or install specific components on dedicated servers. See the following sections
for the different deployment options:

Navigation

* Topology for Small Scopia Desktop Server Deployment on page 17

* Medium Scopia Desktop Server Deployment with Dedicated Servers on page 18

* Large Scopia Desktop Server Deployment with Dedicated Servers on page 21

Topology for Small Scopia Desktop Server Deployment

In a standard Scopia Desktop Server installation, you deploy a single all-in-one server with the following
installed (see Figure 4: Typical small deployment of Scopia Desktop Server on page 18):

* A complete Scopia Desktop installation, which includes the Conference Server, as well as any
other Scopia Desktop components used in your organization.

Scopia Desktop Server includes various components, such as the Streaming Server, which allows
users to view the videoconference webcast. For a detailed list of all Scopia Desktop components,
see About Components of the Scopia Desktop Server on page 7.

* Scopia Management, an application used to control your video network devices and schedule
videoconferences. Scopia Management includes a built-in gatekeeper.
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Complete Scopia Desktop Installation Scopia Elite MCU
Scopia Management
Built-in Scopia Gatekeeper

Figure 4: Typical small deployment of Scopia Desktop Server

For information on the capacity of a single server, see Minimum Requirements and Specifications of
Scopia Desktop Server on page 10.

The all-in-one server is typically deployed in the DMZ (see Figure 5: Deploying a Single Scopia Desktop
Server in a Small Centralized Topology on page 18). Scopia Desktop Clients can connect from the
internal enterprise network, a public network, or from a partner network.

Scopia Elite MCU

Scopia
Desktop Scopia Desktop Installation
Clients Scopia Management )

o . Scopia
. Built-in 5copia Gatekeeper ;
Public Desktop Scopia
XT Series

Clients

Figure 5: Deploying a Single Scopia Desktop Server in a Small Centralized Topology

This topology serves as the baseline deployment and is typically used for smaller organizations. To
increase capacity, you can install Scopia Desktop components on dedicated servers (see Medium
Scopia Desktop Server Deployment with Dedicated Servers on page 18).

Scopia Desktop Server deployments require an MCU to host videoconferences, and Scopia
Management to control your video network devices and schedule videoconferences.

Medium Scopia Desktop Server Deployment with Dedicated
Servers

To increase the capacity of the deployment, you can dedicate a server for specific Scopia Desktop
components, as follows:

* A dedicated Conference Server for Scopia Desktop, which includes the Conference Server and
Web Server.

* A dedicated Content Center Server, which includes the recording, streaming, and content slider
components. Depending on how these functions are used in your organization, you can deploy
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them separately. For example, if recording is a major part of your videoconferencing experience,
you may decide to deploy a dedicated Recording Server.

* A dedicated XMPP Presence (Jabber) and STUN Server

4 @3 3

Dedicated Dedicated Dedicated 5STUN Scopia Scopia Elite
Conference Content Center & Presence Management MCU
Server for Server for Server for Built-in

Scopia Desktop Scopia Desktop Scopia Desktop gatekeeper

Figure 6: Typical medium-sized deployment

Each Scopia Desktop Server deployed should match the minimum requirements detailed in Minimum
Requirements and Specifications of Scopia Desktop Server on page 10. For more information about the
Scopia Desktop components, see About Components of the Scopia Desktop Server on page 7.

Typically, you deploy the dedicated Scopia Desktop Servers in the DMZ, to provide connection to
participants and webcast viewers connecting from both the internal and external networks (Figure
7: Deploying dedicated Scopia Desktop Servers in the DMZ on page 20). You can also deploy an
additional server in the enterprise, so that internal participants do not need to connect through the
firewall.

Depending on where you deploy the dedicated servers, you may need to open additional ports. For
details, see Ports to Open on Scopia Desktop on page 37.
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Figure 7: Deploying dedicated Scopia Desktop Servers in the DMZ

This is typically relevant for larger deployments. You can also cluster the Scopia Desktop Servers behind
a load balancer, as described in Large Scopia Desktop Server Deployment with Dedicated Servers on
page 21. Smaller deployments, on the other hand, might install all components on the same Scopia
Desktop Server with a Scopia Management (see Topology for Small Scopia Desktop Server Deployment
on page 17).

Scopia Desktop Server deployments require an MCU to host videoconferences, and Scopia
Management to control your video network devices and schedule videoconferences.

For more information about Scopia Solution deployments, see the Solution Guide for Scopia Solution.

When deciding which components are suitable for your organization, refer to Table 3: Deploying
dedicated Scopia Desktop Servers on page 21.
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Table 3: Deploying dedicated Scopia Desktop Servers

Dedicated Scopia Desktop Server Function

Dedicated Conference Server for Scopia Desktop Mandatory

Responsible for creating videoconferences with Scopia
Desktop Clients and Scopia Mobile devices, and connects to
the MCU for connectivity with H.323 and SIP endpoints.

Also provides access to the Scopia Desktop web portals for
the user and administrator.

Dedicated Content Center Server for Scopia Optional (install for the functionality listed below)

Desktop Install a dedicated Content Center Server with one or more of

the following components:

* Recording: To record meetings, perform user
authentication, and provide access to the web portal.

* Streaming: To stream live webcasts of
videoconferences.

¢ Content Slider: To allow participants to catch up with
previously presented slides.

For increased capacity, you can deploy the recording or
streaming components on two different servers.

If installing the Scopia Content Slider, install it on the
Recording Server.

Scopia Content Slider can now function with presentation set
to H.263 or H.264 on the MCU.

If you have more than one Recording Server, you access
each one to view the recordings stored by that specific server.
For example, if you want to access a recording stored on
Recording Server A, you must connect to Recording Server A.
You cannot access it from Recording Server B.

Dedicated XMPP Presence Server & STUN Server Optional (install for the functionality listed below)

for Scopia Desktop Install a dedicated server with the following components:

* XMPP Presence: To maintain a live list of contacts
which are available or unavailable for video chat or
videoconference.

* STUN: To enable users to directly dial a Scopia Desktop
Client or Server behind a NAT or firewall in point-to-point
implementations.

Large Scopia Desktop Server Deployment with Dedicated Servers

Large deployments, such as service providers or large organizations, typically deploy multiple dedicated
Scopia Desktop Servers. To provide scalability and high availability, with service preservation for up to
100,000 registered users, you can cluster several dedicated Conference Servers behind a load balancer
as described in Deploying Scopia Desktop with a Load Balancer on page 24.
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Figure 8: Typical large deployment

The videoconferencing infrastructure, including the Scopia Desktop Server, is typically deployed in the
DMZ to provide connection to participants and webcast viewers connecting from both the internal and
external networks (Figure 9: Large Scopia Desktop Server Deployment with Dedicated Servers on page

22).

You can also deploy an additional Conference Server in the enterprise, so that participants in internal
videoconferences do not need to connect through the firewall.

- N
Scopia Management i
Scopia ECS
Dedicated . Gatekeeper
Conference Serversfor
Scopia Desktop Load
Balancer

3 5%

Dedicated
Content Center Server
for Scopia Desktop

Dedicated
STUN & XMPP Server
for S5copia Desktop

Clients

Scopia Elite MCU

Figure 9: Large Scopia Desktop Server Deployment with Dedicated Servers

Enterprises can deploy the videoconferencing infrastructure in more than one location. This can be done
either for redundancy or, if there are many customers in different regions of the world, you can deploy a
full set of videoconferencing infrastructure in the headquarters, and another set of infrastructure in a
branch.

See the Solution Guide for Scopia Solution for detailed information about different ways to deploy your
videoconferencing infrastructure.

When deciding which components are suitable for your organization, refer to Table 4: Deploying
dedicated Scopia Desktop Servers on page 23.
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Table 4: Deploying dedicated Scopia Desktop Servers

Dedicated Scopia Desktop Server Function

Dedicated Conference Server for Scopia Desktop Mandatory

Responsible for creating videoconferences with Scopia
Desktop Clients and Scopia Mobile devices, and connects to
the MCU for connectivity with H.323 endpoints.

Also provides access to the Scopia Desktop web portals for
the user and administrator.

Dedicated Content Center Server for Scopia Optional

Desktop Install a dedicated Content Center Server with one or more of

the following components:

* Recording: To record meetings, perform user
authentication, and provide access to the web portal.

¢ Streaming: To stream live webcasts of
videoconferences.

¢ Content Slider: To allow participants to catch up with
previously presented slides.

For increased capacity, you can deploy the recording or
streaming components on two different servers.

If installing the Scopia Content Slider, install it on the
Recording Server.

Scopia Content Slider can now function with presentation set
to H.263 or H.264 on the MCU.

If you have more than one Recording Server, you access
each one to view the recordings stored by that specific server.
For example, if you want to access a recording stored on
Recording Server A, you must connect to Recording Server A.
You cannot access it from Recording Server B.

Dedicated XMPP Presence Server & STUN Server Optional (install for the functionality listed below)

for Scopia Desktop Install a dedicated server with the following components:

* XMPP Presence: To maintain a live list of contacts
which are available or unavailable for video chat or
videoconference.

* STUN: To enable users to directly dial a Scopia Desktop
Client or Server behind a NAT or firewall in point-to-point
implementations.

Each Scopia Desktop Server deployed should match the minimum requirements detailed in Minimum
Requirements and Specifications of Scopia Desktop Server on page 10.

Scopia Desktop Server deployments require an MCU to host videoconferences, and Scopia
Management to control your video network devices and schedule videoconferences.
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Deploying Scopia Desktop with a Load Balancer

For increased reliability and scalability, you can deploy multiple Scopia Desktop Servers behind a load
balancer such as Radware's AppDirector or another load balancer (Figure 11: Typical load balanced
Scopia Desktop deployment on page 25).

A load balancer groups together a set (or cluster) of servers to give them a single IP address, known as
a virtual IP address. It distributes client service requests amongst a group of servers. It distributes loads
according to different criteria such as bandwidth, CPU usage, or cyclic (round robin). Load balancers are
also known as application delivery controllers (ADC).

Scopia Desktop Servers

Load Balancer
sd.company.com

Figure 10: Deploying Scopia Desktop with a Load Balancer

All servers in the cluster should have identical functionality enabled, since one server must take over if
another is overloaded or fails. If you deploy dedicated servers for the different components of Scopia
Desktop (for example, a dedicated recording or streaming server), these dedicated servers should be
located outside the cluster. For more information, see Configuring Streaming and Recording in a Load
Balancing Environment on page 133.

Typically, the Scopia Desktop cluster is deployed in the DMZ, to enable both internal and external
participants to join the videoconference. If many videoconferences include only internal participants,
consider deploying an additional Conference Server in the enterprise, or, for increased capacity, an
additional cluster with a load balancer.
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Figure 11: Typical load balanced Scopia Desktop deployment

When clustering multiple Scopia Desktop Servers in your deployment, all servers must be configured
with the same security mode. When a device establishes a secure connection with another component,
it sends a signed certificate verifying its identity. The signature on the certificate must be from a known
(trusted) certification authority (CA). For more information about security, see Securing a Load Balanced
Environment on page 136.

O important:

Using encryption is subject to local regulation. In some countries it is restricted or limited for usage.
For more information, consult your local reseller.

You can configure the load balancer to route all network traffic or only part of it, depending on the load
balancer's capacity and your deployment requirements (Figure 12: Media can either bypass or travel via
the load balancer (example) on page 26):

* In full load balancing deployments, all network traffic between servers and clients, including the
media (audio, video, data presentations), is routed via the load balancer. This is best for powerful
load balancer servers, and has the added security advantage of withholding the private IP of a
Scopia Desktop Server to the outside world.

* In partial load balancing deployments, the media data travels directly between client and server,
bypassing the load balancer, while signaling and management still travel via the load balancer.
This is better for less powerful load balancer computers, but directly exposes the servers' private IP
addresses to the outside world.
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Figure 12: Media can either bypass or travel via the load balancer (example)
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If your deployment includes dedicated servers for streaming and/or recording in a load balancing
environment, you can choose one of the following deployments:

* Point all Scopia Desktop Servers in the cluster to a single dedicated streaming and/or recording
server outside the cluster. The playback client communicates directly with the dedicated server.

* Enable streaming capabilities in each Scopia Desktop Server in the cluster .

Dedicated Streaming
Recording / Streaming Server Enabled Locally
Rer.urdi'gj'trm&uvcr ScopiaDesktopServers

-

Scopia Desitop Serverswith
streaming enabled

iRl clifc
;
=

Streaming
Clients Clients

Figure 13: Deploying either a dedicated recording/streaming server, or enabling local streaming

Streaming / Playback
Clients

For details about configuring load balancing, see Deploying Multiple Scopia Desktop Servers with a
Load Balancer on page 119.

Administrator Guide for Scopia Desktop Server Version 7.7.3 Planning your Scopia Desktop Server Deployment | 26




Deploying Scopia Desktop Server with Dual-NIC

Scopia Desktop Server can be installed on servers with multiple Network Interface Cards (NICs).
Depending on the deployment and network configuration, you may want to control which NIC is used for
various server communications.

O important:

Use bonded 100 Mbit NICs or a Gigabyte NIC. The default settings are 384Kbps for every participant
connection, and 256 Kbps for webcast viewers.

For example, in secure multiple NIC deployments you can use a NIC configured behind the firewall to
communicate with various servers, while using another NIC for Scopia Desktop Client connections
(Figure 14: Scopia Desktop Server with a dual-NIC deployment on page 27). In this case, configure
the Scopia Desktop IP address to represent the NIC behind the firewall. For the Scopia Desktop public
address, use a DNS name which resolves to the NIC outside the firewall, and is accessible both inside
and outside the enterprise.

For more information and to configure the public address, see Defining Scopia Desktop Server Public
Address and Other Client Connection Settings on page 63.

ScupTa Desktop Scopia Management

Public IP Server
of Scopia . 1 |
Desktop .
Server .
Scopia Elite &
MCU

Scopia
XT Series

Enterprise
Figure 14: Scopia Desktop Server with a dual-NIC deployment

Scopia Desktop Clients can connect to the Scopia Desktop Server either by an IP address or a DNS
name. In many deployments the Scopia Desktop Server IP address is not accessible to clients outside
the enterprise due to NAT or firewall restrictions. Therefore, Scopia Desktop Server has a public
address, which must be a DNS name resolving to the correct Scopia Desktop Server IP address both
inside and outside the corporate network.

Planning your Bandwidth Requirements

The Scopia Solution supports a number of technologies designed to minimize the bandwidth used in
videoconferences. For more information on the bandwidth-saving features of Scopia Solution, see
Scopia Solution Guide. Even so, there are policy decisions you can make to reduce bandwidth further by
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deciding on the location of video network components and setting bandwidth management policies in
your organization. You can estimate the total bandwidth required for Scopia Desktop, which includes:

* Bandwidth consumed by videoconference participants connecting to the Scopia Desktop Server
(Scopia Desktop Clients and Scopia Mobile devices)

* Bandwidth consumed by viewers of videoconference webcasts
* Bandwidth consumed by users downloading a recorded videoconference
Use your Scopia Desktop bandwidth estimation to do the following:

* Calculate your bandwidth costs, for both external and internal bandwidth (see Calculating the
Bandwidth Used by Scopia Desktop Participants on page 29).

For example, to reduce bandwidth, you may decide that all calls going outside your organization
are limited to standard definition (SD), or that all calls are SD by default.

* Use Scopia Management to define the bandwidth policies for different user profiles.

For example, company executives are usually allocated more bandwidth. For details, see
Administrator Guide for Scopia Management.

* Define the maximum bandwidth of MCU meeting types (also known as services), which define the
videoconference parameters, including the bandwidth.

For example, you can define a dial prefix which restricts the meeting to audio-only or SD, to
consume much less bandwidth than an HD videoconference. For details, see Administrator Guide
for Scopia Elite MCU.

* Decide how many users can actively participate or watch the videoconference as a webcast only.

Participants take up four times the bandwidth of webcast viewers. For details, see Calculating
Scopia Desktop Bandwidth in a Centralized Deployment on page 30 and Calculating Scopia
Desktop Bandwidth in a Distributed Deployment on page 31.

O important:

When calculating the total bandwidth required for videoconferencing, you need to also consider the
bandwidth required by other Scopia Solution products included in your deployment, such as the MCU

and Scopia XT Series.
E""-—. “

ScopiaManagement ScopiaElite MCU ScopiaManagement Metwork Admin

Figure 15: Planning your Scopia Desktop bandwidth
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For details on how to calculate the bandwidth, see the following sections:
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Navigation

* Calculating the Bandwidth Used by Scopia Desktop Participants on page 29

* Allocating Bandwidth for Downloading Recordings on page 35

* Calculating the Total Required Bandwidth for Scopia Desktop on page 36

Calculating the Bandwidth Used by Scopia Desktop Participants

This section describes how to calculate the bandwidth required for videoconferences with Scopia
Desktop participants and webcast viewers (both Scopia Desktop Clients and Scopia Mobile devices).

The Scopia Desktop Server coordinates videoconferences between Scopia Desktop Clients/Scopia
Mobile devices and the MCU.

Typically, Scopia Desktop Servers are deployed in the same location as the MCU, hence the bandwidth
between the Scopia Desktop Servers and the MCU is internal. However, if your deployment is set up
with the Scopia Desktop Servers in a different location than the MCU, you also need to consider the
bandwidth between the Scopia Desktop Servers and the MCU when considering bandwidth costs. For
more information about distributed deployments, see Solution Guide for Scopia Solution.

O important:

The bandwidth used by the Recording Server is managed separately, as described in Allocating
Bandwidth for Downloading Recordings on page 35, except when it is installed on the same PC as
other Scopia Desktop components. In such cases, users watching recorded meetings would consume
bandwidth which would otherwise be used by videoconferences.

Table 5: Default bandwidth used for one connection on page 29 lists the default bandwidth used for
each connection between the participant/webcast viewer and the Scopia Desktop Server.

Table 5: Default bandwidth used for one connection

Type of connection Default bandwidth required

Upload bandwidth for one SD participant 384 Kbps

Download bandwidth for one SD participant 384 Kbps

Download bandwidth for one SD webcast viewer 384 Kbps

Upload bandwidth for one HD participant 768 Kbps

Download bandwidth for one HD participant 1024 Kbps

Download bandwidth for one HD webcast viewer 1024 Kbps

O important:

The upload and download call rates may be different. For HD (720p) videoconferencing, the Scopia
Desktop Client sends 768 Kbps and receives 1024 Kbps by default.

Depending on your deployment, see the following sections to calculate the bandwidth for Scopia
Desktop calls:
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Navigation

* Calculating Scopia Desktop Bandwidth in a Centralized Deployment on page 30

* Calculating Scopia Desktop Bandwidth in a Distributed Deployment on page 31

Calculating Scopia Desktop Bandwidth in a Centralized Deployment

This topic describes how to calculate the bandwidth required for Scopia Desktop calls when the Scopia
Desktop Server is deployed in the same physical location as the MCU (also known as a centralized
deployment).

If the Scopia Desktop Server is deployed in a different location than the MCU (also known as a
distributed deployment), or if your deployment requires cascading between multiple branches, see
Calculating Scopia Desktop Bandwidth in a Distributed Deployment on page 31.

Figure 16: Upload and download bandwidths for centralized deployments on page 30 illustrates the
bandwidth to take into account when planning your resources.

Upload Bandwidth Inpernal
Ny BEFT;}.
nj .
i
ScopiaDesktop Download Bandwidth ScopiaElite MCU
Clients/ Mobile

Q Download only \ =
Streaming Clients Bandwidth Internal ScopiaManagement
[Streaming) \

Enterprise Headquarters

Figure 16: Upload and download bandwidths for centralized deployments

The bandwidth used for each Scopia Desktop Client participant is defined in the server settings (see
Figure 17: Setting bandwidth defaults for Standard and High Definition on page 31). For viewing
streamed videoconferences, there is only the download bandwidth to consider. For more information on
defining these settings, see Defining Bandwidth Settings in Scopia Desktop Server on page 62.
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Maximum Video Quality

The Maximum Call Rate defines the maximum bandwidth used between the SCOFIA Desktop
client and the SCOPIA Desktop server.

Standard Definition

Maximum Call Rate (kKb/=): |-1-18 (352p) V|

High Crefinition

Maximum Call Rate (kb/=): | 1024 (720p) V|

[] Allow SCOPIA MCU version 5.x to negotiate high definition calls down to 480p

Figure 17: Setting bandwidth defaults for Standard and High Definition

The formula is:

Total upload bandwidth = upload bandwidth per participant x # internet participants
Total download bandwidth = download bandwidth per participant
x (# internet participants + # internet webcast viewers)

For example, if the defined call rate is 384 Kbps, each participant uses 384 Kbps for uploading and 384
Kbps for downloading. So if 10 Scopia Desktop participants connect to a videoconference at 384 Kbps,
the bandwidth for these participants is 3,840 Kbps for upload and 3840 Kbps for download. 50 users is
19,200 Kbps (or 19 Mbps) for uploads and 19 Mbps for downloads.

You should also consider whether the participants and webcast viewers are connecting from the internal
or external network, to ensure there is sufficient internal and external bandwidth. For example, if your
organization typically has 100 simultaneous participants connecting in SD, you require 38,400 Kbps of
bandwidth for uploading and 38,400 Kbps for downloading. If 80 of these participants are connecting
from the public network, you need to increase your organization's external bandwidth by an additional
30,720 Kbps for both uploading and downloading media.

To calculate the total bandwidth required for Scopia Desktop, including both the bandwidth consumed by
participants/webcast viewers, and downloading recordings, see Calculating the Total Required
Bandwidth for Scopia Desktop on page 36.

Calculating Scopia Desktop Bandwidth in a Distributed Deployment

This topic describes how to calculate the bandwidth required for Scopia Desktop calls in distributed
deployments. For centralized deployments, see Calculating Scopia Desktop Bandwidth in a Centralized

Deployment on page 30.
There are several types of distributed Scopia Desktop deployment:

* Standard distributed deployment with cascading
* Distributed deployments without cascading
* Fragmented distributed deployments

In each case, the external bandwidth costs vary significantly because of the cascading or the location of
video network components in your deployment. The list below identifies the bandwidth formula for each
distributed deployment type.

* Standard distributed deployment with cascading

Each location has its own MCU and Scopia Desktop Server, so any local videoconference would
not incur external bandwidth costs. Meetings which cross locations are created via a cascaded link
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between the two local MCUSs, thereby using much less bandwidth, enabling all local clients to
participate in the same meeting (Figure 18: Cascading meetings in a distributed deployment:
clients connect to local MCU on page 32).

Upload
= ﬁp_{;’
Download R _
ScopiaDesktop aun {:f Scopia
Clients/ Mobile £ Deskop
'ﬁq_‘_ Server
*‘é;&
Low ba ndwidth Esml:"::u
- lite
Downiload onby furi?csazued }
Streaming Clients Bandwidth |
[Streaming) i
Scopia Desktop Scopia Desktop
Clients Clients

Figure 18: Cascading meetings in a distributed deployment: clients connect to local MCU

The bandwidth used by a cascaded link is equivalent to only a single client connection in each
direction: upload and download. The bandwidth value is determined by the MCU meeting type (or
service), which is invoked when choosing a dial prefix for the meeting. You define the maximum
bandwidth for each meeting type in the MCU. For more information on defining meeting types, see
Administrator Guide for Scopia Elite MCU.

You can configure Scopia Management to determine whether your distributed MCUs form
cascaded meetings. For more information, see Administrator Guide for Scopia Management.

Each external Scopia Desktop Client connects with its own bandwidth usage as defined in the
server settings (see Figure 19: Setting bandwidth defaults for Standard and High Definition on
page 33). For viewing streamed videoconferences, there is only the download bandwidth to
consider. For more information on defining these settings, see Defining Bandwidth Settings in
Scopia Desktop Server on page 62.
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Maximum Video Quality

The Maximum Call Rate defines the maximum bandwidth used between the SCOPIA Desktop
client and the SCOPIA Desktop =erver.

Standard Definition

Maximum Call Rate (Kb/s): |448 (332p) V|

High Cefinition

Maximum Call Rate (Kb/s): | 1024 (720p) v|

[ Allow SCOPLA MCU version 5.x to negotiate high definition calls down to 480p

Figure 19: Setting bandwidth defaults for Standard and High Definition

The formula is to calculate external bandwidth usage is:

Total upload bandwidth = (upload bandwidth per participant x # internet participants)
(

+ (upload bandwidth of cascading MCU service x # simultaneous cascaded links)

Total download bandwidth = (download bandwidth per participant x # internet participants)
+ (download bandwidth of cascaded MCU service x # cascaded links)
+ (download bandwidth per participant x # internet streaming viewers)

* Distributed deployments without cascading

Without cascading, internal meetings still only use internal bandwidth, but when participants
connect to a meeting hosted in another location, each client uses the same bandwidth as though
they were connecting externally (Figure 20: Participants connect to a remote server on page 33).

Upload
4] 1 .
j U %% 7
D load : C |
Scopia Deskiop s Scopia 7%}, & b"t‘
Clients/ Mobile Deskiop [} £ g
Server \l < Server
- *
Scopiz g Scopia |
- EliteMCU EliteMCU |
Download only |
- - Bandwidth ’ | |
Streaming Clients tSweaming] |l
Bandwidth used
Scopia Desktop 10 CONNECT 1D Scopia Desktop
Clients reMmote Servers Clients

| Branch

Figure 20: Participants connect to a remote server

Headquarters

The bandwidth used for each Scopia Desktop Client participant (external or in a different branch)
connecting to a remote server is defined in the server settings (see Figure 19: Setting bandwidth
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defaults for Standard and High Definition on page 33). For viewing streamed videoconferences,
there is only the download bandwidth to consider.

The formula is to calculate external bandwidth usage is:

Total upload bandwidth = upload bandwidth per participant x
(# branch participants + # Internet participants)

Total download bandwidth = download bandwidth per participant
x (# branch participants + # internet participants + # internet stream viewers)

* Fragmented distributed deployments

In fragmented deployments, each location houses different components of the deployment, making
it the most bandwidth-intensive solution. External bandwidth costs are incurred for every
participant, and furthermore, each connection's media is relayed again externally between the
Scopia Desktop Server and the MCU (Figure 21: Fragmented distributed deployment requires
more external bandwidth on page 34).

5 Upload Bandwidthh_. Upload Bandwicth
- ; N Scopia
ScopiaDesktop Download Bandwidth Scopia Download Bandw idth Elite MCU
Clients/ Mobilke Desktop
Server
Nraar
y P
- Scopia
Download only Managemert
Streaming Clients Bandwidth
(Streaming)

Figure 21: Fragmented distributed deployment requires more external bandwidth

In this case, the bandwidth for each participant's upload or download is double the bandwidth
defined on the server (Figure 19: Setting bandwidth defaults for Standard and High Definition on
page 33), because it needs to be transmitted twice, once from the client to server and another
between the server and the MCU. Even Scopia Desktop Clients in the same location as the MCU
must upload and download twice, since everything must be routed via the Scopia Desktop Server
which is in a different location.

The formula is to calculate external bandwidth usage is:

Total upload bandwidth = 2 x (upload bandwidth per participant x # participants)

Total download bandwidth = (2 x download bandwidth per participant x # participants)
(download bandwidth per participant x # streaming viewers)

d
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To calculate the total bandwidth required for Scopia Desktop, including both the bandwidth consumed by
participants/webcast viewers, and downloading recordings, see Calculating the Total Required
Bandwidth for Scopia Desktop on page 36.

Allocating Bandwidth for Downloading Recordings

This section describes how to allocate bandwidth to users who download recorded videoconferences.

Typically, the bandwidth used for playback of recordings is managed separately from the bandwidth of
videoconference participation and webcast viewing. Server hardware capabilities often determine the
maximum bandwidth for playback, since the quality of playback is directly related to the number of
people viewing the playback at the same time. For more information on hardware requirements, see
Minimum Requirements and Specifications of Scopia Desktop Server on page 10.

If the Recording Server is installed on the same server as the other components of the Scopia Desktop
Server, users playing back recorded meetings consume part of the same bandwidth which might have
been used for other purposes, such as videoconferences.

The bandwidth allocated for recording is divided between the number of users who simultaneously
watch a recording. For example, if you allocate 100 Mbps for recording bandwidth, Scopia Desktop
allows all 100 Mbps if one user watches a recording, or 50 Mbps per user if two users watch recordings
simultaneously. To prevent too many users from watching recordings at the same time, you can define
the minimum bandwidth that must be available before a user starts watching a recording.

One user is viewing a Two users areviewing a Three users are viewing

recording: recording: a recording:

100% of recording 50% of recording 33% of recording

handwidth is handwidth is allocated to bandwidth is allocated

allocated to this user. each user. to each user.
33% 33%

100% 50% 50%
33%

Figure 22: Allocating Recording Bandwidth

Estimate the number of remote and internal users who would simultaneously download recordings, to
calculate the required internal and external bandwidth.

You can configure the recording bandwidth in the Scopia Desktop Server, by defining both the total
bandwidth allocated for downloading recordings, and limit how many users can download recordings at
the same time (Figure 23: Defining playback bandwidth on page 36). For details, see Defining Scopia
Desktop Recording Settings on page 79.
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Playback Bandwidth

Define bandwidth allocation for downloading and watching recorded meetings.
Total Bandwidth Allowed (Mb/=): |1IIIIII

Minimum Bandwidth required for

download (Kb/s): |25'5

Figure 23: Defining playback bandwidth

To calculate the total bandwidth required for Scopia Desktop, including both the bandwidth consumed by
participants/webcast viewers, and downloading recordings, see Calculating the Total Required
Bandwidth for Scopia Desktop on page 36.

Calculating the Total Required Bandwidth for Scopia Desktop

The total bandwidth required for Scopia Desktop requires differentiating between internal bandwidth,
which has its own cost considerations, and external bandwidth which is used when Scopia Desktop
usage crosses site boundaries.

You should also consider whether the participants and webcast viewers are connecting from the internal
or external network, to ensure there is sufficient internal and external bandwidth. For example, if your
organization typically has 100 simultaneous participants connecting in SD, you require 38,400 Kbps of
bandwidth for uploading and 38,400 Kbps for downloading. If 80 of these participants are connecting
from the public network, you need to increase your organization's external bandwidth by an additional
30,720 Kbps for both uploading and downloading media.

Upload and download bandwidths can comprise of the following components:

* Bandwidth consumed by videoconference patrticipants connecting to the Scopia Desktop Server
(Scopia Desktop Clients and Scopia Mobile devices)

* Bandwidth consumed by viewers of videoconference webcasts
* Bandwidth consumed by users downloading a recorded videoconference

Total bandwidth is calculated as follows:

Total Upload Bandwidth = Total upload bandwidth from participants
Total Download Bandwidth = Total download bandwidth from participants

Total download bandwidth from webcast viewers

Total download bandwidth from viewers replaying recordings

+ + 1l

To calculate bandwidth required by participants and webcast viewers, see Calculating the Bandwidth
Used by Scopia Desktop Participants on page 29. To calculate the bandwidth used to play back
recordings, see Allocating Bandwidth for Downloading Recordings on page 35.

You can allocate the bandwidth depending on the specific needs of your organization. For example, if
your organization has many participants connecting in standard definition and very few users
downloading recordings, you may decide to increase the default rate for SD calls from 384 Kbps, and
decrease the bandwidth allocated for recordings.
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B S5D & HD participants

B Webcast viewers

B Recording downloads

Figure 24: Total bandwidth for Scopia Desktop (example)

After calculating the total bandwidth, define your Scopia Desktop bandwidth settings as follows:

* Define the default call rates used by Scopia Desktop Clients, for standard and high definition (see
Defining Bandwidth Settings in Scopia Desktop Server on page 62).

* Define the default call rates used to stream webcasts, for standard and high definition (see
Defining Webcast Streaming on page 89).

* Define the bandwidth used for downloading recordings (see Defining Scopia Desktop Recording
Settings on page 79).

* Define a default meeting type in your MCU with the correct bandwidth limit. For more information,
see Administrator Guide for Scopia Elite MCU.

Ports to Open on Scopia Desktop

The Scopia Desktop Server is typically located in the DMZ (see Figure 25: Locating the Scopia Desktop
Server in the DMZ on page 38) and is therefore connected to both the enterprise and the public

networks. Scopia Desktop Clients can be located in the internal enterprise network, in the public
network, or in a partner network.
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Figure 25: Locating the Scopia Desktop Server in the DMZ

When opening ports between the DMZ and the enterprise on the Scopia Desktop Server, use the
following as a reference:

* When opening ports that are both in and out of the Scopia Desktop Server, see Table
6: Bidirectional Ports to Open Between the Scopia Desktop Server and the Enterprise on page
30.

* When opening ports that are outbound from the Scopia Desktop Server, see Table 7: Outbound
Ports to Open from the Scopia Desktop Server to the Enterprise on page 39.

* When opening ports that are inbound to the Scopia Desktop Server, see Table 8: Inbound Ports to
Open from the Enterprise to the Scopia Desktop Server on page 40.

When opening ports between the DMZ and the public on the Scopia Desktop Server, use the following
as a reference:

* When opening ports that are both in and out of the Scopia Desktop Server, see Table
9: Bidirectional Ports to Open Between the Scopia Desktop Server and the Public on page 41.

* When opening ports that are inbound from the Scopia Desktop Server, see Table 10: Inbound
Ports to Open from the Public to the Scopia Desktop Server on page 42.

When opening ports to and from the XMPP server (which is necessary when the XMPP server is
separated by a firewall from the Scopia Desktop Server), use the following as a reference:

* When opening outbound ports from the XMPP server, see Table 11: Outbound Ports to Open from
the XMPP Server on page 42.

* When opening inbound ports to the XMPP server, see Table 12: Inbound Ports to Open on the
XMPP Server on page 43.

When opening bidirectional ports between Scopia Desktop Clients, see Table 13: Bidirectional Ports to
Open Between Scopia Desktop Clients on page 43.

When opening inbound ports from the Scopia Desktop Clients to the STUN server, see Table
14: Inbound Ports to Open from the Scopia Desktop Client to the STUN Server on page 43.
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O important:

The specific firewalls you need to open ports on depends on where your Scopia Desktop and other
Scopia Solution products are deployed.

Table 6: Bidirectional Ports to Open Between the Scopia Desktop Server and the Enterprise

Port Range Protocol

Destination

Functionality

Result of
Blocking Port

Required

7640 TCP Content Center Enables connection | Cannot Mandatory
Server between the Scopia | communicate with
Desktop Server and the Content
the Content Center Center Server and
Server, when installed some capabilities
on different servers. |(such as recording
and streaming) do
not function
properly
1024- 65535 |TCP MCU or ECS, Enables connection to |Cannot connect to |Mandatory
(H.245/ depending on Scop_ia Desktop the meeting To limit range, see
Q.931) deployment meetings. Limiting the TCP Port
Range for H.245/Q.931
on the Scopia Desktop
Server on page 45
10000-65535 (UDP MCU, MVP, or Enables media Media cannot be |Mandatory
(RTP) Sqopia Desktop  |connection to the passed from t_he To limit range, see
Client MCU_or MVP, and the  MCU to chp|a Limiting the UDP Port
Sc_opla Desktop Desktop Cllen_ts. ~ |Range for RTP/RTCP on
Client. Also, conngctlon IS he Scopia Desktop
tunneled via TQP Server on page 44
port 443 resulting o
inadrop in
performance.

Table 7: Outbound Ports to Open from the Scopia Desktop Server to the Enterprise

Port Range Protocol

Destination

Functionality

Result of

Required

Blocking Port

137,138 UDP Active Directory  |Enables auto-discovery and |Cannot perform Recommended for
authentication auto-discovery performing Active
and authentication | Directory
authentication
139,445 TCP Active Directory  |Enables auto-discovery and |Cannot perform Recommended for
authentication auto-discovery Active Directory
and authentication |authentication
1719 UDP (RAS) | Scopia ECS Enables communication with | Cannot connect to Mandatory
Gatekeeper Scopia ECS Gatekeeper the meeting
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Port Range

Protocol

Destination

Functionality

Result of
Blocking Port

Required

1720 TCP MCU or Scopia Enables connection to Cannot connect to | Mandatory
ECS Gatekeeper, Scopia Desktop meetings.  the meeting
depending on
deployment
3337 TCP (XML) MCU Enables meeting cascading Meeting cascading  Mandatory
connection to the MCU connection is
disabled
5269 TCP XMPP Server Enables sever-to-server Scopia Desktop Mandatory only in
connections in cases where | Clients cannot deployments of
multiple Jabber servers are login and use the |two or more
deployed as a federation or | contact list. Jabber servers
cluster. deployed as a
federation or
cluster which must
communicate via a
firewall
6972- 65535 | UDP Streaming Server Enables media connection to |Cannot connect to | Mandatory
the chpia Desktop the Scopia To avoid opening
Streaming Server, if . Desktop these ports, place
separated from Scoplg Streaming server. the Scopia
Desktop Server by a firewall. Desktop Server in
the same zone as
the streaming
server.

Table 8: Inbound Ports to Open from the Enterprise to the Scopia Desktop Server

Port

Result of Blocking

Protocol Destination Functionality Required
80 TCP Web client Provides access to the Cannot access the Mandatory if using
(HTTP) Scopia Desktop Server Web | Scopia Desktop Server |HTTP.
Portal (yt_)u can configure Web Portal You can configure
port 443 instead) this port during
installation. For
more information,
see Installation
Guide for Scopia
Desktop Server.
443 TCP Scopia Enables sending control Scopia Desktop Client | Mandatory
(TLS) Desktop messages between the cannot connect to the
Clients Scopia Desktop Server and | Scopia Desktop Server
Clients, and is also used to
tunnel RTP media if the UDP
ports are blocked

Planning your Scopia Desktop Server Deployment | 40

Administrator Guide for Scopia Desktop Server Version 7.7.3




Result of Blocking

Port

Range Protocol Destination Functionality Port Required
3340 TCP Scopia Enables meeting control Meeting control Mandatory
Management | connection with Scopia connection to Scopia
Management Management is disabled
7070 TCP Streaming Enables Scopia Desktop Scopia Desktop Clients  Mandatory
Server Clients to send tunneled cannot receive video

To configure, see

Configuring the
TCP Streaming
Port on the Scopia

Desktop Server on
page 46

RTSP traffic streams

Table 9: Bidirectional Ports to Open Between the Scopia Desktop Server and the Public

Result of Blocking

Port Range  Protocol Destination Functionality Port Required
10000-65535 UDP (RTP/ Scopia Desktop Enables media Connection is Recommended
RTCP) Client c;onngctg)n \|,<v'th the tunnifg we;TCP To configure, see
?opla esktop por; and. Limiting the UDP Port
Client. performance is not Range for RTP/RTCP
optimal

on the Scopia Desktop
Server on page 44
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Table 10: Inbound Ports to Open from the Public to the Scopia Desktop Server

Port Protocol Destination Functionality Resulf @i Eleedng Required
Range Port
80 TCP Web client Provides access to the web |Cannot access the  Mandatory if using
(HTTP) user interface (you can web user interface  |HTTP.

configure port 443 instead) You can configure this

port during installation.
For more information,
see Installation Guide

for Scopia Desktop
Server.
443 TCP Scopia Enables sending control Scopia Desktop Mandatory
(TLS) Desktop messages between the Clients cannot
Clients Scopia Desktop Server and | connect to the
Clients, and is also used to | Scopia Desktop
tunnel RTP media if the Server
UDP ports are blocked
7070 TCP Streaming Enables Scopia Desktop Scopia Desktop Mandatory
Server Clients to send tunneled Clients cannot To configure, see
RTSP traffic receive video Confiquring t’h e TCP
streams

Streaming Port on the

Scopia Desktop
Server on page 46.

Table 11: Outbound Ports to Open from the XMPP Server on page 42 and Table 12: Inbound Ports to
Open on the XMPP Server on page 43 list the ports that should be opened on the XMPP Presence
server, if the XMPP server is separated by a firewall from the Scopia Desktop Server.

Table 11: Outbound Ports to Open from the XMPP Server

Result of

Port Range Protocol Destination Functionality Blocking Port Required
389 TCP LDAP Server Enables LDAP Users cannot login  Mandatory for
(LDAP) communication for user to the XMPP LDAP
authentication, if the XMPP | Server authentication, if
Server is configured for there is a firewall
LDAP server (either Active between XMPP and
Directory or Domino) Scopia Desktop
Server
3336 TCP (XML) Scopia Enables XML Users cannot login  Mandatory for
Management communication for user to the XMPP Scopia
authentication, if the XMPP | Server Management
Server is configured for authentication if
Scopia Management there is a firewall
authentication between XMPP and
Scopia Desktop
Server
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Table 12: Inbound Ports to Open on the XMPP Server

. . , Result of :
Port Range Protocol Destination Functionality Blocking Port Required
5222 TCP Scopia Desktop  |Enables direct Scopia Desktop | Recommended if
Client connection between | Client tries to use there is a firewall
Scopia Desktop Client | port 443 for between XMPP
and XMPP server tunnelled and Scopia
connection to the | Desktop Server
Scopia Desktop
Server
5269 TCP Scopia Desktop Enables direct XMPP |Scopia Desktop ~ Recommended if
Client connections between Clients need to there is a firewall
Scopia Desktop proxy XMPP between the
Clients and the XMPP | connections via XMPP server and
server Scopia Desktop | Scopia Desktop
Server Clients

Table 13: Bidirectional Ports to Open Between Scopia Desktop Clients

. : : Result of :
Port Range Protocol Destination Functionality Blocking Port Required
5060 UDP (SIP) | Scopia Desktop | Establishes direct SIP point-to- |Calls are routed | 'Recommended
Client point connections between two | via the Scopia
Scopia Desktop Clients Desktop Server
1025-65535 UDP Scopia Desktop Establishes direct SIP point-to- |Calls are routed = Recommended
Client point connections between two | via the Scopia
Scopia Desktop Clients Desktop Server

Table 14: Inbound Ports to Open from the Scopia Desktop Client to the STUN Server

Result of Blocking

Port Required

Destination Functionality

Port Range Protocol

3478 UDP Scopia Enables connection between the STUN Scopia Desktop Optional
Desktop Server and Scopia Desktop Clients when | Client cannot
Clients making a point-to-point call. To connect connect to the

STUN server and
uses the Scopia
Desktop Server as
a relay agent.

point-to-point calls directly between two
Scopia Desktop Clients, open the UDP
ports (10000-65535, 6972-65535, 3478).

Planning your Scopia Desktop Server Deployment | 43

Administrator Guide for Scopia Desktop Server Version 7.7.3




O important:

Some firewalls are configured to block packets from the streaming server. You can either configure
the firewall to allow streaming packets, or reconfigure the streaming server and client to use different
network protocols that cross the firewall boundary.

The Streaming Server uses the IETF RTSP/RTP protocols. RTSP runs over TCP, while RTP runs
over UDP. The streaming server can tunnel RTSP/RTP traffic through standard HTTP. Some firewalls
may inspect traffic on port 80 and not allow the tunneled RTSP/RTP on that port. We therefore
recommend using the QuickTime standard port 7070 as the alternate TCP port for HTTP tunneling.
This is configured in the streaming server by default as long as you specify the port as part of the
streaming server virtual address, as described in Configuring the TCP Streaming Port on the Scopia

Desktop Server on page 46.

Limiting Port Ranges on the Scopia Desktop Server

About this task
This section provides instructions of how to limit the following port ranges on the Scopia Desktop Server:
Navigation

* Limiting the UDP Port Range for RTP/RTCP on the Scopia Desktop Server on page 44
* Limiting the TCP Port Range for H.245/Q.931 on the Scopia Desktop Server on page 45

* Configuring the TCP Streaming Port on the Scopia Desktop Server on page 46

Limiting the UDP Port Range for RTP/RTCP on the Scopia Desktop Server

About this task

The Scopia Desktop Server has designated 10000-65535 as the default port range for UDP
(RTP/RTCP). To provide additional security for your firewall, you can limit this range.

To calculate approximately how many ports the Scopia Desktop Server uses, multiply the number of
license connections by 14, which amounts to reserving 14 ports per client. In addition, add extra ports if
your deployment includes:

* Add 6 ports per recording in your deployment.
* Add an extra 6 ports per conference which activates streaming.
Procedure
1. Log in to the Scopia Desktop Server Administrator web user interface.
2. Select Client > Settings.

3. Locate the Multimedia Ports section (see Figure 26: Multimedia Ports Area on page 45).
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Settings  Mesting Features
Maximum Call Rate (Kibfs): 384 (352p) -
¥ High Definition
Maximum Call Rate (Kbis): 1024 (720p) -

Allow SCOPLA MCU version 5. to negotiate high definition calls down to 480p

The MTU Size spacifies the maximum transmission unit size the clisnt will use when communicating with
SCOPLA Deskiop.

MTU Sars: [135-3-

You can it the UDP port range that chents negobsabe with SCOPLA De:l\.tnp ko send audip and wideos. You must
use a limited scope between 2328 and 65535,

Lowast Multimacha Port [

Streaming Highest Multimedia Port |

Figure 26: Multimedia Ports Area

4. Configure your port range (using any values between 2326 and 65535) by doing the
following:
a. Enter the base port value in the Lowest Multimedia Port field.

b. Enter the upper port value in the Highest Multimedia Port field.

5. Select OK or Apply.

Limiting the TCP Port Range for H.245/Q.931 on the Scopia Desktop Server

About this task

The Scopia Desktop Server has designated ports 1024-65535 for TCP for H.245 and Q.931 signaling.
To provide additional security for your firewall, you can limit this range.

For each conference, the Scopia Desktop Server uses 2 ports. In addition, add extra ports for:
* Add 2 ports for each participating Scopia Desktop client.
* Add 2 ports per conference which activates recording.
* Add 2 ports per conference which activates streaming.

* Add 2 ports per conference which activates presenting using the content slider.

Procedure

1. Navigate to <Scopia Desktop install_dir>\ConfSrv.

2. Edit the config.val file as follows:
a. Locate the text 1 system.

b. At the bottom of that section, add two lines:

2 portFrom = <lowest range limit>
2 portTo = <highest range limit>
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Where <lowest range limit> is the base port of your port range and <highest
range limit>isthe upper value of your port range.

3. Access the Windows services and restart the Scopia Desktop - Conference Server service.

Configuring the TCP Streaming Port on the Scopia Desktop Server

About this task

The Streaming Server that is deployed with your Scopia Desktop Server is configured by default to use
the QuickTime standard port 7070 as the alternate TCP port for HTTP tunneling. If your firewall is
configured to block packets from the Streaming Server, you must reconfigure the Streaming Server and
client to use different network protocols which can cross the firewall boundary.

Procedure

1. Log in to the Scopia Desktop Server Administrator web user interface.

2. Select Streaming. The Settings page for the Streaming Server appears (see Figure
27: Setting the streaming port for Scopia Desktop Server on page 46).

Connection Information
If clients cannot resclve the Streaming Server address (perhaps because a
private address 15 used), specify an addibional publicly accessible address below.
‘ It 5 recommended to use a FQDN that clients can résalve.

Public Address:

Streaming

H;'I:::’T':'.""I;::'d Specify the TCP port that clients will use ta access the meeting. This must be
¢ ! configured on the Darwin Streaming Server, and openad on the firewall.

@‘ | TCP Fort: 7070 [
e
Authentication

Limit the total number of ports used for unicast streaming chents.
@ Part Limit 150

Presence and

Figure 27: Setting the streaming port for Scopia Desktop Server

3. Locate the Connection Information area.

4. Modify the port value in the TCP Port field.
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O important:

The Streaming Server uses the IETF RTSP/RTP protocols. RTSP runs over TCP, while
RTP runs over UDP. Many firewalls are configured to restrict TCP packets by port number
and are very restrictive on UDP. The Streaming Server can tunnel RTSP/RTP traffic
through standard HTTP. Some firewalls may inspect traffic on port 80 and not allow the
tunneled RTSP/RTP on that port. We therefore recommend using the QuickTime standard
port 7070 as the alternate TCP port for HTTP tunneling.

5. Select OK or Apply.

6. Do the following on the Scopia Desktop Server:
a. Navigate to the following directory: C:\Program Files\Darwin Streaming Server.
b. Open the streamingserver.xml file.
c. Locate the list of ports for the RTSP protocol by finding the text LIST-PREF
NAME=""rtsp_port" in the file.

<CONF IGURAT ION>
<SERVER>
<LIST-PREF NAME="rtsp_port"™ TYPE="UIntl1l6" >
<VALUE> 7070 </VALUE>
</LIST-PREF>

d. Within this section, add a new entry of <VALUE> xxxx </VALUE>, where xxxx is the
new port value.

e. Save the file.

f. Restart the Darwin Streaming Server.

g. Restart the Darwin Streaming Server service.

Obtaining the Scopia Desktop License keys

You need license keys to install and operate the Scopia Desktop Server, the Recording Server, the
Streaming Server, and Scopia Mobile device access. To obtain license keys, carefully read the
instructions enclosed in the customer support letter you received when you purchased the product. Then
navigate to http://licensing.radvision.com and enter the required information.

The recording key is required to activate Scopia Desktop Server recording and playback functionality, as
well as enabling the Scopia Content Slider feature. You can choose to install the recording server
without a license key. If so, the recording server is installed in demo mode, which limits recording to a
one five-minute session at a time.

The streaming key is required to activate Scopia Desktop Server streaming functionality. You can
choose to install the streaming server without a license key. If so, the streaming server is installed in
demo mode and only allows up to 5 webcast watchers in a given call. If you are upgrading from an
earlier release where you already had streaming installed, you are not prompted to enter the streaming
key.

To use Scopia Mobile with full functionality, you must install Scopia Management and obtain a Scopia
Mobile license as well.
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Table 15: Features offered by Scopia Desktop and Scopia Desktop Pro Licenses on page 48 lists the
features that Scopia Desktop and Scopia Desktop Pro licenses offer to customers.

Table 15: Features offered by Scopia Desktop and Scopia Desktop Pro Licenses

Feature ‘ Scopia Desktop Scopia Desktop Pro

Access to the portal/plug-in installation Yes Yes
Schedule a meeting from Microsoft Outlook Yes Yes
Attend a group meeting hosted on MCU Yes Yes
Share and annotate documents Yes Yes
Invite a phone or a room system by its number Yes Yes
View a previously recorded meeting Yes Yes
View a webcast Yes Yes
Configure your virtual room from the Web Portal Yes
Publish your presence to other meeting participants Yes
Use the Contact List to call people Yes
Desktop-to-desktop calling, seamless escalation to Yes
multi-party calls

Invite users or rooms from favorites, directory or by Yes
number

A guest user with no login can connect to existing meetings (unless Scopia Management is configured to
restrict such feature) from Scopia Desktop Client or Scopia Mobile.
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Chapter 3| Configuring Core Features of
Scopia Desktop Server

You can quickly configure the Scopia Desktop Server for initial use during the installation of the product, which
defines all the server's settings with their default values.

This section details how to change the default settings of the core server features.
Navigation

* Accessing the Scopia Desktop Server Web Administration Interface on page 49

* Defining a local Administrator Account on page 50

* Connecting Scopia Desktop Server with Video Network Devices on page 51

* Adding and Modifying Scopia Desktop Server in Scopia Management on page 54

* Enabling Scopia Desktop User Authentication in Scopia Management on page 56

* Verifying Scopia Desktop Server Installation and Connection with Other Components on page 60

* Defining Bandwidth Settings in Scopia Desktop Server on page 62

* Defining Scopia Desktop Server Public Address and Other Client Connection Settings on page 63

* Enabling or Disabling Scopia Desktop Client Features on page 64

» Synchronizing Contact Lists with a User Directory on page 67

* Rolling-Out Scopia Desktop to End Users on page 72

Accessing the Scopia Desktop Server Web Administration
Interface

About this task

The Scopia Desktop Server web administration interface is a web-based application to configure the
settings of your Scopia Desktop Server.

Perform this procedure to access the administration web interface.

O important:

In a service provider (multi-tenant) deployment the tenant’s organization administrator cannot be
granted access to the administration web interface.

Procedure

1. Access the Scopia Desktop Server Administration web interface in a browser at
http://<server_name>/scopia/admin
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where <server_name> is the FQDN of your corporate Scopia Desktop Server. If you have
deployed a non-standard port to access the Scopia Desktop Server, enter the port number in
the standard way: <server_name>:<port_number>. If you have implemented secure access
to the server, use the https:// prefix.

2. Enter your username and password.

The default username is admin and the password is admin.

3. Select Sign In.

Defining a local Administrator Account

About this task

You can define a username and password for a local administrator to access Scopia Desktop Server
Administration web interface. The local administrator cannot sign into the Scopia Desktop user portal
using credentials defined during this procedure.

In point-to-point-only and advanced deployments where the authentication option is enabled in Scopia
Management, Scopia Management administrators can access the Scopia Desktop Administration user
interface.

Procedure

1. Select Directory and Authentication in the sidebar.

The Settings tab is displayed.

Local Administrator

Settings

Flease enter the credentials used to log into these administration pages.

User Name: |admin
Fazzword! [onsnne
Confirm Fassword: |"""

Figure 28: Configuring the local administrator credentials
2. Enter credentials in the Local Administrator section.

3. Select OK.
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Connecting Scopia Desktop Server with Video Network
Devices

About this task

This section describes how to connect Scopia Desktop Server with the following servers in your video
network:

* Scopia Management which manages this Scopia Desktop Server
* A gatekeeper like Scopia Gatekeeper (built-in to Scopia Management) or Scopia ECS Gatekeeper
* A dedicated Recording Server for Scopia Desktop
* A dedicated Streaming Server for Scopia Desktop
This window is also displayed when you access the Scopia Desktop Server for the first time.

Ensure that Scopia Desktop Server has Scopia Management's IP address, and conversely Scopia
Management has Scopia Desktop Server's IP address. For more information on how to add Scopia
Desktop Server's IP address to Scopia Management, see Adding and Modifying Scopia Desktop Server
in Scopia Management on page 54.

To connect your Scopia Desktop Server to Microsoft Outlook, install the Scopia Add-in for Microsoft
Outlook. For more information, see the User Guide for Scopia Add-in for Microsoft Outlook. To connect
Scopia Desktop Server to IBM Sametime, install the Scopia Connector. For more information, see the
Installation Guide for Scopia Connector for IBM Sametime.

Procedure
1. Access the Scopia Desktop Server administration web interface.
2. Select Deployment in the sidebar.

3. Select Advanced if your network includes Scopia Management (Figure 29: Determining
whether to include Scopia Management in deployment on page 52).
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This deployment allows for
multiple SCOFPIA Desktop
Servers and multiple SCOPIA
MiCUs=. All features are available.

Flease select vour deployment: | Advanced -

Figure 29: Determining whether to include Scopia Management in deployment

IVIEW Suite

IVIEW Suite Address: | [ ]

[T Securs connection uging TLS

Gatekesper [P Address: | .

SCOPIA Desktop H.323 ID: [2032

Presence and Invitation

EMPF Server Address: [

STUN Server Address: |

Recording

Recording Serder Address: [ .
Streaming
Diarwin Streamang Sargcer Address; | R .

[T Use & differant address for rmedia and signalng

|

Figure 30: Connections to other servers including Scopia Management

4. Enter the fields as described in Table 16: Defining addresses of other servers in the network
on page 53.
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Table 16: Defining addresses of other servers in the network

Field Description

iVIEW Suite Address Enter the IP address of Scopia Management, for integrated user
management, bandwidth policies, and stronger integration with the full range
of Scopia Solution features.

By default, Scopia Management uses port 8080.

Secure connection using TLS Select this check box to encrypt communications between Scopia Desktop
Server and Scopia Management.

This functionality requires installing certificates signed by a recognized CA on
both Scopia Management and Scopia Desktop Server.

For more information on installing Scopia Management certificates, see
Administrator Guide for Scopia Management. For more information on
installing certificates on Scopia Desktop Server, see Securing Scopia Desktop
Server’s Connection to other Components on page 109.

o Important:

Using encryption is subject to local regulation. In some countries it is
restricted or limited for usage. For more information, consult your local
reseller.

Gatekeeper IP Address Enter the address of the gatekeeper. If you are using Scopia Management's
built-in gatekeeper, enter the IP address of Scopia Management.

Scopia Desktop H.323 ID Enter the name (H.323 alias) which Scopia Management uses to identify this
Scopia Desktop Server's clients, and then route them to the appropriate MCU.
This can have any of the following formats:

* H.323 alias. For example, username.
* |P address of an H.323 endpoint. For example, 123.45.678.9.

* URI dialing for H.323 or SIP endpoints. For example,
user@company .com

* E.164 dialing for H.323 or SIP endpoints. For example, 881234.

Presence and Invitation Select this check box if your deployment includes a presence and STUN
server, used to maintain the contact list and point-to-point functionality of
Scopia Desktop Pro.

XMPP Server Address Enter the IP address of the presence server, used to maintain the presence
information of the contact list in Scopia Desktop Pro.

STUN Server Address Enter the IP address of the STUN server, used to ensure a point-to-point call
can be made from a remote Scopia Desktop Client to one inside the
organization, finding the correct address via the firewall.

Recording Select this check box to enable recording in your deployment. This requires a
valid license key for recording.

Recording Server Address Enter the IP address of the Recording Server and Scopia Content Slider
Server. You can install the recording server on the same computer as the
other Scopia Desktop Server components, or you can deploy it as a dedicated
server.

Streaming Select this check box to enable streaming in your deployment. This requires a
valid license key for streaming.
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Field Description

Streaming Server Address Enter the IP address of the streaming server. You can install the streaming
server on the same computer as the other Scopia Desktop Server
components, or you can deploy it as a dedicated server.

Use a different address for media | Select this check box when you install the Streaming Server to configure it on
and signaling one IP address but users view webcasts on another IP address.

Adding and Modifying Scopia Desktop Server in Scopia
Management

About this task

The Scopia Desktop Server uses Scopia Management to retrieve the list of users from the corporate
directory, and also query information about current and scheduled meetings, including the participant
names in a meeting. Scopia Desktop Server profiles are manually added to Scopia Management.

Ensure that Scopia Desktop Server has Scopia Management's IP address, and conversely Scopia
Management has Scopia Desktop Server's IP address. For more information on how to add Scopia
Management's IP address to the Scopia Desktop Server, see Connecting Scopia Desktop Server with
Video Network Devices on page 51.

Procedure
1. Access the Scopia Management administrator portal.
2. Inthe Devices tab, select Desktop Servers.

3. Select the link in the Name column for the Scopia Desktop Server you require, or select Add
to create a new Scopia Desktop Server profile. The Add Scopia Desktop Server page
appears (Figure 31: Adding a Scopia Desktop profile on page 55).
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Basic Settings

Mame: -
IP Address: o
H.323 ID: -
Location: Beijing E

URL: -
Maximum Capacity: 100 -

Advanced Settings

Invitation:

To connect from your deskiop, go to <DIRECT_ACCESS_URL», . -
For other options mcludmg connectmg with presentatinn nnl}r or -.-.-atv:,hmg the LDH-ECt Access UR

webcast,
go to <ACCESS_URLs, | Access URL

We recommend you install the deskiop client beforehand, To install the client, Installer URL
go to <INSTALLER_URL>. :

[] secure connection between this server and SCOPIA Management using TLS
[] This SCOPIA Desktop Server has a recording server

Figure 31: Adding a Scopia Desktop profile

4. Enter the required information (Table 17: Configuring Scopia Desktop Server on page 55).

Table 17: Configuring Scopia Desktop Server

Field Name Description

Name Enter a name to identify this Scopia Desktop Server. This name is
displayed in the list of Scopia Desktop Servers.

IP address Enter the management IP address of Scopia Desktop Server.

URL Enter the URL used to access the Scopia Desktop Server. The URL must
be in the format http://<web URL>:<port number>/scopia.

H.323 1D Enter the H.323 ID used to identify connections from Scopia Desktop

Server in MCU conferences.

This must match the H.323 ID that is configured in the Scopia Desktop
administrator web interface.

Configuring this field allows Scopia Management to route calls from this
Scopia Desktop Server based on the predefined IP topology. The ID can
have one of the following formats:

* H.323 alias. For example, username.
* IP address of an H.323 endpoint. For example, 123.45.678.9.

* URI dialing for H.323 or SIP endpoints. For example,
user@company .com

* E.164 dialing for H.323 or SIP endpoints. For example, 881234.
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Field Name Description

Location

This is only relevant for service providers or deployments with multiple
locations.

Select the Scopia Desktop Server's location.

Invitation

You can modify the text that is displayed in email invitations sent to
meeting participants. You can insert placeholders for the following links,
which are generated by Scopia Management for each meeting:

* Direct Access URL.: Link for participants to automatically join the
meeting.

* Access URL: Link for participants to watch the meeting's webcast
or recording.

* Installer URL: Link for participants to install the Scopia Desktop
Client.

Maximum Capacity Enter the maximum number of simultaneous connections you want to

allow for your Scopia Desktop Server, based on computing power.

Secure the connection between this | To use the Transport Layer Security (TLS) protocol to secure the
server and Scopia Management transport link between Scopia Management and Scopia Desktop, select

this checkbox. For more information, see Administrator Guide for Scopia
Management.

This Scopia Desktop Server has a Select this checkbox to configure this Scopia Desktop Server with a
recording server recording server.

5. Select OK to save your changes.

Enabling Scopia Desktop User Authentication in Scopia
Management

About this task

When Scopia Desktop Server is managed by Scopia Management, you must enable the functionality of
registered Scopia Desktop users in Scopia Management. Registered users can login to the Scopia
Desktop Web Portal and have access to their own virtual room.

Depending on the privileges granted to different user groups in Scopia Management, registered Scopia
Desktop users can access meetings, record meetings, watch recordings and webcasts, and invite new
participants to meetings.

Before you begin

If you intend to use Scopia Management authentication in point-to-point deployments, ensure you have
a Scopia Desktop Pro license. By default, Scopia Management is installed with an evaluation license for
five users.
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Procedure
1. Access the Scopia Desktop Server web administration interface.

2. Verify that the Scopia Desktop Server is connected to Scopia Management:
a. Select the Status icon in the sidebar.

b. Verify the Scopia Desktop Server and Scopia Management connection status in the
Scopia Desktop Components section.

SCOPIA Desktop Components

SCOPIA Desktop Server: 132.168.114.236 Qo

IVIEW Suite: 132.168.114.236 Qo

Figure 32: Verifying the Scopia Management connection in Scopia Desktop Server
3. In Scopia Management, verify that the Scopia Desktop Server is added as a connected
server:
a. Access the Scopia Management web administrator portal.

b. Select the Devices tab.

All pevices (10)

J Avatar23D64 RADVISTON MOU w700 8.
AvatarMCU23062 RADWVISION MOU v7 . 8.x

) BAOGW RADVISION GW-B40 (4 BRI)

ClasgicMCU230109 RADVISION MOU vw5.x
& ElteMCU230137 RADVISION MOU v7./8.x
& ELiteMCUZ23072 RADVISION MOU v7.x/8.x
& ElteMCUZI083 RADVISION MOU v7.x/8.x
g |local_gatekespsr RADVISION ECS

RADVISION SCOPIA Desktop

RADVISION SCOPIA Desktop

Figure 33: Verifying the Scopia Desktop Server connection in Scopia Management
c. Verify that the required Scopia Desktop Server appears in the table of connected
servers.
4. Enable user authentication for Scopia Desktop:
a. Login to Scopia Management.

b. Select the Settings tab and navigate to Policies in the sidebar menu, located under
Users.

c. Select the Allow Scopia Desktop user authentication check box.
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| user Policies

Default Time Zone:
GMT+08:00 China Standard Tim =

Name Display Format:

Last name, first name -

Crate Display Format:
DO MM -

Maximum bandwidth allowed for SCOPLA Desktop calls: 2048 » Kpbs

I:J Allgw SCOPIA Deskiop user authentication

[¥] allow guests to acoess mesting

¥ Allow guests to access webcasts
[¥] Allow guests to start recordings
¥ Allgw guests to atoess recordings

Only Authenticated user can invite

Figure 34: Enabling registered users in Scopia Desktop

d. Select authorization options for unregistered users (known as guests) as required. You
can enable the following features for guests in your deployment:

* Access meetings without logging in to Scopia Desktop Server

* Access meetings without logging in to Scopia Desktop Server

* Access webcasts without logging in to Scopia Desktop Server

* Start a recording of a videoconference without logging in to Scopia Desktop Server

* Access a public recording without logging in to Scopia Desktop Server

* Invite participants to a videoconference without logging in to Scopia Desktop
Server.

5. Select LDAP Servers in the sidebar menu, located under Servers, and verify the type of
directory to which Scopia Management connects for user authentication using LDAP as an
authentication method:

* Internal Directory
* Microsoft Active Directory
* IBM Lotus Domino

| LDAP Server Settings

@ fom/ooman  medd

Idap:/ recn-dcl Active Directory Server

| | ldap://192.168.230.93 Lotus Domino Server
Figure 35: Examples of user directory server listed in Scopia Management

6. Select the Users tab to check the total number of Scopia Desktop Pro and/or Scopia Mobile
licensed users displayed at the top of the tab. Users with Scopia Desktop Pro and/or Scopia
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Mobile have a license icon next to their name (see Figure 36: Scopia Desktop Pro and
Scopia Mobile licensed users in Scopia Management on page 59).

Endpoints Jevices Reports Logs & Events

. Users (112) Pro Licenses (15/500) HMaobile Licenses (15/500)

Figure 36: Scopia Desktop Pro and Scopia Mobile licensed users in Scopia
Management

7. If necessary, enable a Scopia Desktop Pro license or Scopia Mobile for each user requiring
point-to-point or Scopia Mobile functionality.
a. In the Users tab, select the relevant user.
b. Select View in the User Profile field.

c. Select Can use all Scopia Desktop Pro features or Can use all Scopia Mobile
features.

User profile

Meeting Types

Salect the mesting types allowead for this user profila

W e e pren——mecum e oescopuon |
W A Point ko Point Faint to Point

M 71 Dafault Mesting Type Dafault Mesting Type

User Capabilities
[¥ Can schedule mestings

Can invite andpoints and reserve resources

% 7

Can record meetings

Can use all SCOPLA Desktop Pro festures (requires license)

Can use all SCOPIA Mobille features (requires icanse)

Can access SCOPIA Managemant administrator portal T Read-only

Can view all mestings in the user portal

= im N = m

Can use others virtual rooms

* Advanced
Maximurn bandwidth allowed for SCOPIA Desktop calls: 1024 ﬂl(phs

Figure 37: Enabling Scopia Desktop Pro or Scopia Mobile licenses in Scopia
Management

O important:

This procedure can also be done via group provisioning. You can group users in the Active
Directory / Domino, and then define properties for all users in that group. For detailed
information on setting up groups, see the Administrator Guide for Scopia Management.
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Verifying Scopia Desktop Server Installation and
Connection with Other Components

About this task

The Scopia Desktop Administrator web interface displays the connectivity status of your deployment.
The indicators next to each link shows whether or not the connection or registration to the target server
is successful. When the indicator is red, hover over the indicator to view the tooltip containing the error
details.

O important:

Configuration options which do not apply to your deployment are not displayed.

Procedure

1. To verify that Scopia Desktop Server is connected to the necessary video network devices,
select Status in the sidebar.

2. View the connection status for each server or component. If necessary, select any red
indicators to view further error information.

SCOFIA Desktop Status | Directory Status | Recording Status

SCOPIA Desktop Components

SCOPLA Deskiop Server: 192.168.114.236 .
VIEW Suite: 152.168.114.236 .
Gatekeeper: 1592.168.114.236 .
Streaming Server: 192.168.114.236 .
Sametime Server: rvnh-pedominc8s.radvisicn.com .

5019 : The connection to the specified server has nok been
established or has been lost,

Click. For mare details

Figure 38: Viewing the connection status with Scopia Desktop Server

3. In a service provider (multi-tenant) deployment, select the Directory tab, and select the
organization whose policies you want to check.
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P
SCOPIA Desktop  Directory  Recording | Content Slider | Logging

| Organizateon: Radwision, Img. |

Symehrarization: Swnehromped .
Suthentication: Enabled
Guest AcoEss to Mestings: Erabled
Crifstd Aremds b Wakemata: Fruaklmsd

Figure 39: Viewing an organization's status in a multi-tenant deployment

4. If you installed and configured a Scopia Desktop Recording Server, select the Recording
Status tab to verify the connectivity status of the recording components.

SCOPIA Decktop Status | Directory Statug | Recording Status

Recording Components

Fecording Server: 192.168.114.236 .
Recorder: 192.168.114.236 .
Gatekeeper: 192.168.114.236 .
MNIC Address: 192,1658.114,236

Figure 40: Viewing the connectivity

5. For Scopia Management deployments, Scopia Desktop Server must synchronize with Scopia
Management to download information about users, virtual rooms, and global policy. Select
the Directory Status tab and verify synchronization with Scopia Management.

SCOPIA Desktop Status | Directory Status | Recording Status

Global Directory - WIEW Suite

Synchronization: Synchronized .
Authentication: Enabled
Guest Access to Mestings: Enabled
Guest Access to Webcasts: Enabled
Guest Access to Recordings: Enabled

Figure 41: Directory Status Tab
6. (Optional) View the connection status of the Scopia Content Slider by selecting the Content
Slider tab. For more information on the Content Slider, see the Administrator Guide for
Scopia Desktop Server.

7. If necessary, select any red indicators to view further error information.
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Defining Bandwidth Settings in Scopia Desktop Server

About this task

This section details how to define the maximum bandwidth used between the Scopia Desktop Client and
the Scopia Desktop Server.

Maximum bandwidth is also defined in the MCU meeting type (service). You invoke a meeting type by
entering its prefix before the meeting ID. For example, if 88 is the defined MCU meeting type for HD
meetings, users would enter 88 followed by the meeting ID to invoke that meeting type's parameters in
the videoconference.

The bandwidth values defined here are subordinate to the bandwidth restrictions defined in the MCU
meeting type.

Procedure
1. Access the Scopia Desktop Server Administration web interface.
2. Select the Client icon in the sidebar.
3. Select the Settings tab.
4. Select the maximum call rate in the Maximum Video Quality section.

5. Configure call rate or bandwidth settings for SD and HD video by selecting the bandwidth
rate from the Maximum Call Rate list.

Maximum Video Quality

The Maximum Call Rate defines the maximum bandwidth used between the SCOFIA Desktop
client and the SCOPIA Desktop zerver.

Standard Definition

Maximum Call Rate (kKb/=): |-1-18 (352p) V|

High Crefinition

Maximum Call Rate (kb/=): | 1024 (720p) V|

[] Allow SCOPIA MCU version 5.x to negotiate high definition calls down to 480p

Figure 42: Maximum Call Rate Section

SD video has a default resolution of 352 x 288 pixels, known as 352p, with a default
bandwidth value of 384Kbps. If your MCU uses a meeting type (service) defined for higher
quality HD video, video is downgraded to SD.

HD video has a default resolution of 720p, with a default bandwidth of 1024Kbps. The
bandwidth rates are different for sending and receiving video. Scopia Desktop Clients send
up to 512 Kbps of 480p video resolution and receive 720p video resolution at the call rate
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defined in the MCU meeting type (service). If your MCU uses a meeting type (service)
defined for lower quality SD video or lower bandwidth, video is downgraded to those values.

Defining Scopia Desktop Server Public Address and Other
Client Connection Settings

About this task

This section details how to define the public address of the Scopia Desktop Server, which is pushed to
Scopia Desktop Clients participating in a videoconference on that server.

You can also define Scopia Desktop Server's size of network packets (MTU size), and you can place
arbitrary limits for the number of clients which can simultaneously connect to this server, in cases where
the server's specifications are not powerful enough to manage the maximum number of connections.

Procedure

1. Access the Scopia Desktop Server Administration web interface.
2. Select the Client icon in the sidebar.
3. Select the Settings tab.

4. Insert the public address of the Scopia Desktop Server to be accessed by the client. Use a
FQDN which Scopia Desktop Clients can resolve from their location, to arrive at the correct
IP address of the server.

If a DNS name is not specified in the Public Address field, the Scopia Desktop Server
network interface address is used.

Connection Information

SCOPIA Desktop clients will connect to the server by using either the
selected SCOPIA Deskiop Metworl Interface, or a public address (FQDN
recommended) if specified below.

Fublic Address: Isd.radvisian.cam

Figure 43: The public address for Scopia Desktop Clients to connect to the server

If your deployment uses dedicated servers for one or more Scopia Desktop Server
components, Scopia Desktop Clients would connect via this public address if those dedicated
servers cannot be reached due to NAT or firewall restrictions.

5. Define the MTU Size if your network routers and the MCU are configured to accept network
packets of a different size. The default value is 1360.
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The MTU Size specifies the maximum transmission unit size the client will use when

communicating with SCOPLA Desktop.

MTU Size: |1360

Figure 44: Setting the MTU size for Scopia Desktop Client

O important:

This value must remain the same across all network components to guard against packet
fragmentation.

6. Enter a value in the Call Limit field to limit the resources used by the system. Use this to limit
bandwidth or when the Scopia Desktop Server computer is not powerful enough to support
the maximum number of calls.

Limit the total number of ports used for group or relayed point to point calls.

Call Limit: |

Figure 45: Call Limit Section

7. Select OK or Apply.

Enabling or Disabling Scopia Desktop Client Features

About this task

This section describes how to enable or disable features in the Virtual Room window of the Scopia
Desktop Client for all users logged in to the Scopia Desktop Server. You can:

* Enable or disable presentations (desktop sharing).

* Enable or disable Scopia Content Slider.

* Enable or disable text chat.

* Enable or disable raising hand feature in lecture mode.

* Enable or disable encryption.

O important:

Using encryption is subject to local regulation. In some countries it is restricted or limited for
usage. For more information, consult your local reseller.
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* Enable or disable call back for users who have an H.323 endpoint but also want to connect a
dedicated PC to share presentations.

* Add a pane in the videoconferencing window containing web content for all users in your
organization.

Users with a login to Scopia Desktop Server can define their own virtual room preferences in the Scopia
Desktop Client (see User Guide for Scopia Desktop Client).

Users with a Scopia Management login can define the behavior of their virtual rooms in Scopia
Management (see User Guide for Scopia Management).

This section describes how to make global changes for the virtual rooms of all Scopia Desktop Server
users.

Procedure
1. Access the Scopia Desktop Server Administration web interface.
2. Select the Client icon in the sidebar.

3. Select the Meeting Features tab.

Meeting Room

Enable Desktop Sharing

Enable Content Slider feature in SCOPLA Desktop meetings

[] Allow only moderatars to share applications from their desktop
Enable Chat
Enable Raise Hand feature in SCOPIA Desktop meetings

[] Display an additional panel in the conference room

Figure 46: Enabling or disabling client videoconferencing features

4. Enter the fields as described in Table 18: Settings for the Scopia Desktop Client Virtual
Room window on page 65.

Table 18: Settings for the Scopia Desktop Client Virtual Room window

Field Description

Enable Desktop Sharing Determines whether participants can share their PC desktop content with others
in the videoconference.

If desktop sharing disabled, the Present button does not appear in the Virtual
Room window of Scopia Desktop Client.

Enable Content Slider feature Determines whether participants can review content which has already been
in Scopia Desktop meetings  shared in the meeting by scrolling back and forth.

Allow only moderators to Determines whether this feature is restricted to moderators of videoconferences
share applications from their  only.
desktop
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Field Description

Enable Chat Determines whether to display the chat window pane in the Virtual Room window
of Scopia Desktop Client.

Enable Raise Hand feature in | Determines whether a muted user (usually in lecture mode) can request
Scopia Desktop meetings permission to speak.

Display an additional panel in Determines whether to display an additional pane in Scopia Desktop Client's
the conference room Virtual Room window within your organization. The pane's contents are drawn
from an external web address.

URL to Display Enter the web address in this field. When the system accesses the web address,
it automatically appends two parameters: the current meeting ID and the
participant's nickname. This enables your external web content to relate to the
meeting and participant if required. The parameters added

are: ?meetingid=NNN&nickname=XXX. If your external web content already
takes different parameters in its URL, these parameters are appended to the URL
string.

Use standard URL-encoding in this field, for example '&' is %26, '="is %3D and so
on.

5. Configure the Push to Talk section to define how participants use the microphone button in
the Virtual Room window of Scopia Desktop Client.

{(®) Allow users to join a meeting with their microphone on

() Force users to join @ meeting with their microphone off

() Force users to hold down the microphone butten while zpeaking

Figure 47: Push to Talk Settings

Table 19: Defining microphone behavior during a meeting

Field Description

Allow users to join a meeting with their |When selected, this field enables the microphone by default, so

microphone on participants must select the microphone button to mute themselves.

Force users to join a meeting with their  (Recommended) When selected, this field disables the microphone by

microphone off default, so participants must select the microphone button to unmute
themselves.

This is eliminates background noise from a videoconference until the
participant is ready to contribute.

Force users to hold down their When selected, this field requires participants to select and hold down
microphone button while speaking the microphone button to activate their microphones and send their
audio.

6. Configure the Security section to determine encryption parameters.
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] Encrypt Media (between Desktop and Server)
Allow Users to have SCOPIA Deskiop call them back

Figure 48: Security Settings

Field Description

Encrypt Media Determines whether to encrypt the media (audio, video and
presentation) using SRTP between the Scopia Desktop Server and
Scopia Desktop Client.

o Important:

Using encryption is subject to local regulation. In some countries it
is restricted or limited for usage. For more information, consult your
local reseller.

Allow Users to have Scopia Desktop call 'When users with a dedicated videoconferencing endpoint connect
them back their PC to the meeting for data sharing only, this field determines
whether the system displays the check box for the system to call back
their H.323 device to connect video from there.

The check box is located on the Scopia Desktop web portal. Before
connecting to a meeting, select More Options > Use my computer
for presentation only > Callback my video device number.

0 Important:

When a computer connects as a dedicated data-only device, it
cannot view or send video or audio, but you can view the participant
list, moderate, chat, share content from the computer.

7. Select OK or Apply.

Synchronizing Contact Lists with a User Directory

About this task

One of the components in the Scopia Desktop Server is the Presence Server (see Figure

1: Components of the Scopia Desktop Server on page 7), which updates Scopia Desktop's Contact List,
part of a Scopia Desktop Pro deployment. It maintains the status of a user's listed contacts, whether or
not they are available.
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Figure 49: Status icons appear next to each contact

Scopia Desktop’s Presence (XMPP) Server is implemented by a service known as Jabber.

The Presence Server must therefore have access to a user directory, which it retrieves from Scopia
Management, which in turn can take its list of users either from an external source, like Microsoft's Active
Directory, or from Scopia Management's own internal directory.

This section describes how to configure the Presence Server with Scopia Management's user directory,
both its own internal user directory or with an external LDAP directory.

O important:
If your Scopia Management uses Domino as the source of its user directory, follow the same steps for
an Active Directory source.

Before you begin

Ensure Scopia Management is connected to the Scopia Desktop Server and is sharing its user
database. For more information, see Enabling Scopia Desktop User Authentication in Scopia

Management on page 56.

Procedure
1. Access the Scopia Desktop web administration interface.
2. Select the Deployment icon in the sidebar.

3. Select the Presence and Invitation check box. (Figure 50: Connecting the Scopia Desktop
Server to presence (XMPP) and STUN servers on page 69)
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Streaming

Figure 50:  Connecting the Scopia Desktop Server to presence (XMPP) and STUN
servers

4. Enter the IP addresses of each of the servers in the XMPP Server Address and STUN
Server Address fields (Figure 50: Connecting the Scopia Desktop Server to presence
(XMPP) and STUN servers on page 69).

5. Select the Presence and Invitation icon in the sidebar (Figure 51: Defining the Jabber
Domain on Scopia Desktop Server on page 69).

Setfings

Relayed Padnt to Point Calls

@ Use this SCOPLA Deskiop Server to host pont (o point calls,
Use a diferent SOOF1A Desbicp Server to heat point 1o peint calks:

Domain Mapping fer Presence and Invilation

Specify the: XHPP server to uss,

Ciomiain |n' ¥_Organzabsn_name

Presence and

Figure 51: Defining the Jabber Domain on Scopia Desktop Server

6. If Scopia Management uses its internal directory as its list of users, set the Domain field
(Figure 51: Defining the Jabber Domain on Scopia Desktop Server on page 69) to be the
internal Jabber domain name for your organization. Make a note of this name as you will use
it again later for the Jabber Domain field in the configuration tool in 10.

O important:

This is not a DNS domain. The Domain field here refers to an internal name for the Jabber
service, responsible for presence services. We recommend, therefore, using a name that
does not resolve to an IP address. For example, my_organization_name.

7. If your Scopia Management is configured to work with the Active Directory (Figure
52: Mapping Jabber domains to search bases in Active Directory on page 70):
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Figure 52: Mapping Jabber domains to search bases in Active Directory

a. You can either choose specific user groups (search bases) within the LDAP user list to
map to a Jabber domain, or map the whole database to a Jabber domain. To select
parts of the LDAP database, select the check box of the LDAP database (Figure
52: Mapping Jabber domains to search bases in Active Directory on page 70).

To choose the whole database, clear the check box.

b. For each search base (user group) you want the Presence Server (XMPP) to access,
enter its internal Jabber domain. Make a note of these names as you will use them again
later in this procedure for the Jabber Domain field in the configuration tool.

O important:

This is not a DNS domain. This Domain field refers to an internal name for the Jabber
service, responsible for presence services. We recommend, therefore, using a name
that does not resolve to an IP address. For example, my_organization_name.

In a multi-tenant deployment, you can create a different mapping per organization.

8. On the Presence Server computer, start the Scopia Desktop Configuration Tool by selecting
Start > All Programs > Scopia Desktop > ConfigTool.

9. Select the Jabber icon in the sidebar to configure the Presence Server.

10. If Scopia Management's user directory comes from its own internal directory:

a. Select iVIEW from the Authentication Type dropdown list at the top of the screen, and
then select Add.

b. In the Jabber Domain field, enter the same domain you used when enabling user
authentication in the Scopia Desktop Server (Figure 53: Connecting the Presence Server
to Scopia Management's internal directory on page 71).

This domain must match the Jabber Domain entered earlier in this procedure.

O important:

This is not a DNS domain. The Domain field here refers to an internal name for the
Jabber service, responsible for presence services. We recommend, therefore, using a
name that does not resolve to an IP address. For example, my_organization_name.
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Jabber Domain:

my_organization_name

iYIEW Address:
172.16.10.3
Local Bind Address:

172.16.10.3

Figure 53:  Connecting the Presence Server to Scopia Management’s internal
directory

c. Enter the IP Address of Scopia Management in the iVIEW Address field.
d. Enter the IP address of Scopia Desktop Server.
If the Jabber Server has multiple NICs, choose one of them for this configuration.
11. If your Scopia Management accesses its list of users from an external source like Microsoft's

Active Directory (Figure 54: Connecting the Presence Server with the Active Directory on
page 71):

o po WO

my_organization_name [(Active Directory )

labber Domain:
my_organization_name

Active rectory Address:

192 168217178

LDAP search base:
Cr=Users, DC=recsuk, 0l =local

Proxy Account User Mame {must have READ permiszion to directory)s

Password:

Confirm Passward;

LOAP Fort:

| Auply | Delete Virtual Host | Restart Jabber Service

Figure 54: Connecting the Presence Server with the Active Directory

a. Select Active Directory from the Authentication Type dropdown list at the top of the
screen, and then select Add.

For Domino implementations, select Domino.

b. Enter the IP address of the Active Directory server in the Active Directory Address
field.
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O important:

This domain must match the Active Directory address entered in the Deployment
page (4).

c. To limit the scope to one or more user groups within the Active Directory, specify the
search base in the LDAP Search Base field.

d. Enter the Proxy Account User Name and Password of a user with access to the Active
Directory database.

e. In case the Active Directory is configured with a port other than default port 389, change
the LDAP Port value.

12. If you have a service provider (multi-tenant) deployment, configure the XMPP domain for
each organization.

In a multi-tenant deployment the Jabber configuration tool displays many tabs, to enable a
different configuration in each organization. Select the relevant tab to configure the
authentication type per organization. See Figure 53: Connecting the Presence Server to
Scopia Management's internal directory on page 71.

O important:

In a multi-tenant deployment, you can have a different Jabber domain for each
organization, but all the organizations use the same Scopia Management, hence the
iVIEW Address field becomes read-only in all the tabs after you have configured it for the
first tab in one of the organizations.

13. Select Apply.

Rolling-Out Scopia Desktop to End Users

About this task

This section provides the recommended procedures for rolling-out your deployment to end users.

The section includes these topics:
Navigation

* Minimum Requirements for Scopia Desktop Client on page 72

* Installing Scopia Desktop Client Locally on a PC on page 73

* Pushing Scopia Desktop Client Installations in your Organization on page 75

Minimum Requirements for Scopia Desktop Client

This section details the minimum hardware and software requirements of the Scopia Desktop Client
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The minimum hardware requirements for the Scopia Desktop Client depend on the video resolution.
* Standard definition hardware specifications:
— PC Intel Pentium 4, 3.0 GHz or faster
— PC AMD Athlon 3.0 GHz or faster
— PC Intel Centrino Mobile Processor 1.8 GHz or faster
— Mac with Intel Core Duo 1.8 GHz or faster
— Netbook Intel Atom Processor 1.6 GHz or faster
— 1 GB of RAM or more
* Enhanced definition hardware specifications:
— PC Intel true dual core processors - Core 2 Duo 1.8 GHz or faster
— PC AMD true dual core processors - e.g. Phenom lIx4 91- 2.X GHz or faster
— Minimum 2 GB of RAM

* High definition hardware specifications:

PC Intel quad core or better processors

PC Intel Core i5 or i7 are recommended for an ultimate experience
PC AMD Quad-Core Opteron

Mac with Intel Core 2 Duo 2.7 GHz or faster

Minimum 2 GB of RAM, 3 GB of RAM or more recommended

The minimum software requirements of the Scopia Desktop Client are:

* Operating systems:

O Important:

Internet Explorer must be installed on your Windows PC when using the Scopia Desktop Client,
even if you access meetingings with other web browsers like Firefox or Chrome.

O important:

We recommend using the latest service pack of the Windows operating systems listed in this
section.

— Windows XP (SP3, 32 and 64-bit)

— Windows Vista (SP2 or higher, 32 and 64-bit)

— Windows 7 (32 and 64-bit)

— Windows 8 (desktop mode, 32 and 64-bit)

— Macintosh OS X version 10.6 (Snow Leopard) or higher, Intel CPU only
* Viewing live webcasts or recorded meetings

— Unlimited viewers with multicast streaming (Vince 7.6)

— Mac: QuickTime 7.4.5 or later (version 10 recommended)

— PC: QuickTime 7.4.5 minimum (version 7.7 recommended)
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Installing Scopia Desktop Client Locally on a PC

About this task

The Scopia Desktop Client Web Portal provides an automatic download and update manager. When
you select the Updates link, it displays any currently installed components and versions, and enables

you to install components, including the 32 bit version of Scopia Add-in for Microsoft Outlook and the
Contact List.

O important:

You must be logged in to the web portal to install all components at once. If you are not logged in, you
can only install the client, not the Contact List or the Scopia Add-in for Microsoft Outlook. These

components are reserved for users who are authenticated to access corporate systems for scheduling
and making calls.

For information about installing the 64 bit version of Scopia Add-in for Microsoft Outlook, refer to User
Guide for Scopia Add-in for Microsoft Outlook for Microsoft Office Outlook.

In a multi-tenant deployment the Contact List and the Scopia Add-in for Microsoft Outlook are configured
on installation with organization-specific URLs.

Before you begin

* Obtain login credentials. You may need to ask your Scopia Desktop administrator for a user name
and password if Scopia Desktop is configured so that only authenticated users can participate in
meetings, access webcasts, or watch recordings.

* Connect a headset or speaker and microphone to your computer, and ensure it is configured in the
control panel or system settings.

* Connect a video camera or webcam to your computer.

Procedure
1. To activate Scopia Desktop for the first time, go to the Scopia Desktop web portal page at
http://<Scopia Desktop domain hame>/scopia

For service provider (multi-tenant) deployments, access http://<Scopia Desktop domain
name>/<tenant> or http://<Scopia Desktop domain name>/scopia/mt/<tenant>. For example,
http://sd.company.com/orgl or http://sd.company.com/scopia/mt/org1l.

2. Select Updates in the top-right corner of the web portal.

Sign In | Settings  Updates (i

Figure 55: The Updates link in the top right corner of the web portal

The Scopia Desktop Update window opens.
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SCOPIA Desktop Update x

& There are updates to SCOPIA Desktop components available.
Conference Client
i There are optional SCOPLA Desktop components available,

SCOPLA Add-in for Microsoft Office Outlook (1.3.0.42)

Clicking Install means vou have accepted the terms of the End-User Licengs Agreement.

[ Install ][ Cancel |

Jiew Installed Updates

Figure 56: Updating Scopia Desktop Client
3. Select Conference Client to install or update the Scopia Desktop Client.

4. Select Scopia Add-in for Microsoft Office Outlook to install the add-in that allows you to
schedule videoconferences from Microsoft Office Outlook.

5. Select Install. When the Scopia Desktop Client installation is complete, you should see the
following icon in the task tray at the lower right corner of the screen: Q

6. To verify that any optional components were installed, select the View Installed Updates
link. A list of installed components appears.

| Installed Updates x

Hame Description Version Type

Contact List Contact List Package 1.0.0.29 Important
collab.pkg Collaboration Install package 1.1.0.19 Impaortant
clinstmagr.pkg Client Install Manager Package 1.1.0.37 Important
scopoladdin. pkg SCOFIA Outlook Addin 1.1.0.33 Important
Conference Client Client Install Package 7.10.0.69 Important

Close

Figure 57: Installed Updates and Components

7. If you installed the Scopia Add-in for Microsoft Outlook, restart your Microsoft Office Outlook.
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Pushing Scopia Desktop Client Installations in your Organization

About this task

You can push Scopia Desktop Clients simultaneously to end users using one of these standard
Microsoft server tools:

* Microsoft Active Directory (AD)
* Microsoft Systems Management Server (SMS).

Please contact Customer Support to obtain pre-prepared scripts which can run using either of these
infrastructures. There is also accompanying documentation on how to deploy throughout your
organization using either of these infrastructures.
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Chapter 4| Configuring Advanced Features
of Scopia Desktop Server

Scopia Desktop Server is a highly flexible system with many settings which can be configured manually.

This section details how to change the default settings of the more advanced server features.
Navigation

* Creating Meeting Invitation Templates for End Users on page 77

* Managing Scopia Desktop Server Recordings on page 79

* Defining Webcast Streaming on page 89

* Synchronizing Contact Lists with a User Directory on page 91

* Displaying Administrator Messages to End Users on page 96

* Configuring Dial String Rules on page 97

* Branding your Scopia Desktop User Interface on page 103

Creating Meeting Invitation Templates for End Users

About this task

This section describes how to create or edit the text automatically added to meeting invitations created
with the Scopia Add-in for Microsoft Outlook (32bit).

O important:

The text of the invitation for the 64bit version is configured in Scopia Management. For more
information, see User Guide for Scopia Add-in for Microsoft Outlook

Create the invitation text yourself, and use the buttons in this section to automatically insert the
addresses which are configured for this server. Addresses use the FQDN configured in the server during
installation.

O important:

In a multi-tenant deployment the Contact List and the Scopia Add-in for Microsoft Outlook are
configured during installation with organization-specific URLs.

Procedure

1. Access the Scopia Desktop Server Administration web user interface.

2. Select Messages and Invitations in the sidebar.
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3. Select the Invitations tab.

The default instructions for accessing the meeting from a desktop, phone or video
conferencing device appear in the screen.

Messages Inwitations | Dial Strings

Desktop Access

To connect from your deskrop, ctablet or mobile device, ga tao Insert URL for

http://ad. company.com/scaplia?lIl=<Elé4>fautojoin
For other options (including connecting with presentation only [REEERSELECIL

or watching the webcast), go to

heep://ad. company.com/scapia?ID=<E164> Portal

Client Installation

We recommend you install the client beforehand. To install the

client, go to http://sdbeta.radvision.com/scopia?client

Phone Access

To connect from a phone, please dial one of the following - Insert text for
numbers: E.164
Tnitced FKingdom +44 (D)20 8756 3200 =

France +33 (0) 15560 5120

China +86 (10) 835283988

Video-Conference Device Access

To connect from a videoconferencing device within - Insert text for
RADVISION, dial 10<E164>
To connect from a videoconferencing deviece oucaide
RADVISION, dial <Elé4>@rvil.radvision.com

Or dial £0.74.104.138,hit the Video IVR and choose the

m

SCOPIA Desktop for Avaya Aura Collaboration Suite Add-in for Microsoft Office Outlook

| Require users to be authenticated to install SCOPIA Desktop Add-in for Microsoft Office Outlook

Figure 58: Creating invitation text for Scopia Add-in for Microsoft Outlook (32bit)

4. Enter the invitation text, using the buttons to add web addresses as described in Table
20: Generating addresses for invitation text on page 79.
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Table 20: Generating addresses for invitation text

Field Description

Meeting Inserts the web address to connect directly to the videoconference from Scopia Desktop
Clients.

If you have multiple Scopia Desktop Servers and want participants to join from their local
server to conserve bandwidth, insert the link information for each server. For example:

From Europe, connect to http://europe.server.com/scopia?1D=1234
From Asia, connect to http://asia.server.com/scopia?1D=1234
From the US, connect to http://us.server.com/scopia?lD=1234

Data-Only Meeting Inserts the web address for participants who connect their computer to share content on
their screens separately from the video of a dedicated videoconferencing endpoint.

Portal Inserts the address for the Scopia Desktop web portal. Users would access this to enter a
different meeting ID or access a recorded meeting.

Client Installation Inserts the address to install Scopia Desktop Client on your computer. The installation
occurs within the web page.

Phone Access > Insert the telephone number of the gateway enabling phones to join the videoconference.

E.164

If your deployment does not include a gateway, de-select the Phone Accesscheckbox, so
the gateway information is not included in Outlook.

Videoconference Inserts the number to dial from dedicated videoconferencing endpoints to join the meeting.
Device Access >
E.164

5. Select OK or Apply.

Managing Scopia Desktop Server Recordings

This section details how to create and manage recordings within Scopia Desktop.

Navigation

* Defining Scopia Desktop Recording Settings on page 79

* Managing Recordings from the Scopia Desktop Web Portal on page 82

* Creating or Deleting a Recording Category on page 85

* Recording Meetings from Scopia Desktop Server on page 86

* Stopping a Recording in Progress from Scopia Desktop Server on page 87

* Assigning an Owner to a Recording on page 88

* Deleting a Recording on page 89
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Defining Scopia Desktop Recording Settings

About this task

A recording of a Scopia Desktop videoconference can be played back at any time. Recordings include
audio, video and shared data (if participants presented during the videoconference). Unless the
videoconference has a moderator, any participant in a videoconference can start recording it. Users can
access recordings from the Scopia Desktop web portal or using a link to the recording.

O important:

You can only define the location of recordings during installation of the Scopia Desktop Recording
Server component.

If you want to store recordings locally, a typical recording for a one-hour meeting at 384Kbps (standard
definition) takes up to 200MB. Alternatively, you can use a storage server in the enterprise. For more
information, see Installation Guide for Scopia Desktop Server.

Use the following formula to calculate the space required for recordings:
Recording Bandwidth (in megabytes) x Time (in seconds) + 20% Overhead
For example, for a call of 1 hour at 384 Kbps (standard definition), calculate as follows:

384 Kbps x (60 minutes x 60 seconds) = 1382400 kilobits
1382400 + 1024 = 1350 megabits

1350 + 8 = 168.75 megabytes (MB)

168.75 x 20% = 33.75MB (overhead)

Total is 168.75 + 33.75 = 202.5MB (including overhead)

If you have more than one Recording Server, you access each one to view the recordings stored by that
specific server. For example, if you want to access a recording stored on Recording Server A, you must
connect to Recording Server A. You cannot access it from Recording Server B.

You can define the recording policies of the Scopia Desktop Server with Scopia Management, to
determine whether users are allowed to record meetings.

O important:

In deployments where the Recording Server is installed on the same server as the Scopia Desktop
Server, users watching recorded meetings take up Scopia Desktop bandwidth which can be used for
other purposes, such as videoconferences.

Before you begin

Verify the recording server is defined in the Scopia Desktop Server administration web interface:
* Verify the Recording check box is selected in the Deployment section.
* Verify the Recording Server Address IP address in the Status section.

Before defining the bandwidth, read through how to calculate the recording bandwidth, as described in
Allocating Bandwidth for Downloading Recordings on page 35.

Procedure

1. Access the Scopia Desktop Server Administration web interface.

2. Select Recording > Settings.
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Limits
Configure the size of the viden and the bitrate.
Standard Definition
Maximum Bit Rate (Kb/s): 384 (352p) (=]
7] High Definition
Maximum Bit Rate (Kb/s): 1024 (720p)

The Maximum Recording Duration defines the longest allowed recording.
Recordings will stop at this limit without notification.

Maximum Recording Duration (minutes): |:2|:|

Playback Bandwidth
Define bandwidth allacation for dewnloading and watching recorded meestings.
Total Bandwidth Allowed (Mb/s): |:DCI

Minimum Bandwidth reguired for
download (Kb/s):

258

Send tone penodically during recording: Every 15 seconds E

| allow wirtual rooms and scheduled meetings to be recorded automatically

Allow meeting participants to recard

Connection Information

If clients cannot resolve the Recording Server address (perhaps because a private
address 15 used), specify an additional publicly accessible address below. It is
recommended to use a FQDN that clients can resolve.

Public Address: |

Specify the HTTP port that clients will use to aceess recordings. This must be
configured on the Recording Server, and opened on the firewall.

HTTP Port: |

Figure 59: Defining recording settings in Scopia Desktop Server

3. Enter the following fields.

Field Description

Standard Definition > Maximum Bit Enter the bitrate determining the quality of the recorded video in standard
Rate definition.

Setting this to lower than 256 Kbps can affect the quality of the
presentation data in the videoconferencing and streaming modes.

High Definition Select to enable recordings in HD.

High Definition > Maximum Bit Rate | Enter the bitrate determining the quality of HD recorded video.

Maximum Recording Duration Enter the maximum allowed duration of a recording.
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Field Description

Total Bandwidth Allowed Enter the total bandwidth Scopia Desktop can use for playing back
recorded meetings, to be shared by all users who are watching a
recording at the same time. The more simultaneous viewers, the lower the
bandwidth allocation per viewer.

For more information, see Allocating Bandwidth for Downloading
Recordings on page 35.

Minimum Bandwidth required for Enter the minimum bandwidth which every viewer of a recording is
download guaranteed to experience. Since the bandwidth drops per user as more
simultaneous users view recordings, this field prevents too many users
from watching recordings at the same time.

Send tone periodically during Choose the frequency of the sound signal played during a recording
recording which reminds users their meeting is being recorded.

Allow virtual rooms and scheduled Enables automatic recordings system-wide for virtual rooms and
meetings to be recorded scheduled meetings. Avoid enabling this functionality on more than one
automatically server in your organization to eliminate duplicate recordings.

Allow meeting participants to record | This setting cannot be modified since Scopia Management controls the
recording policies.

Public Address Enter the full name of the recording server (FQDN).

This is an address accessible from outside the NAT, in cases where the
regular IP address of the Scopia Desktop Recording Server may not be
directly accessible by clients.

HTTP Port This port is used by clients to access the recording. You must configure
the HTTP port on the Recording Server and open this port on the firewall.

4. Select OK or Apply.

Managing Recordings from the Scopia Desktop Web Portal

About this task

You can manage your recordings by organizing, protecting and deleting them.

You can organize recordings by assigning categories preconfigured by the administrator for your
organization. Assigning categories to recordings allows you to group recordings and to filter them for
easy search. For example, your organization may have categories for training sessions, board meetings,
product features and so on.

Categories behave in a similar way to playlists or Gmail labels. If the administrator renames an existing
category, Scopia Desktop automatically updates attributes for all recordings belonging to the modified
category. If a category is deleted, Scopia Desktop still keeps the recordings that belonged to the deleted
category.

You can protect and secure recordings by making them private or by limiting access to them. For more
information about protected and private recordings see Securing and Protecting Your Scopia Desktop

Recordings.
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Before you begin

To manage a recording made by other users, you need to know their username and password.

Procedure

1. Access the Scopia Desktop web portal as described in Accessing the Scopia Desktop Web
Portal.

2. Select the Watch Recording tab.
The list of available recordings is displayed.

Pt chooue B preveoushy recorded mestng Bt pou meed br mefoh
Search b )
. 'n"__mm.lm Ol oy Shewt L0 Baosrdagn w1 wFiltar
meeting ID
L . Sawt Tema R — -
= Download
) a84ITH pEmo DecfI002  gonis1 | Moger Molen e di
recordin
i M 31 3013 > 2 g
Play recording #——{k/ asioes KT3005 C3 Trawsng - 21002 17104 LI00 Aee Wl -l
X — i r rdi
= P Coificaies BTLS Traeg for C5 FbB220L2 1021 e el 5 .o 4G !'!.u':w eco ding
= . information
) M00r Beta Trainieg MITTE smme | Sharen Zeng B2 iR - @
. - - . - - it recording
D oo AT Ok S 1 W ogiie swemies B2 8 B rmaeis
) BEROOW V.0 Bats Trawwng Dy 1 - part 3 ‘.\'I"_";,::':"" T R EEA T ] B o4 -
¥.0 CF Trawwry = Gy 3, Seaston 3« o 08 2013 - - " :
) a0 el M et misense  Marce Camsbvecche (] O—f—mb—t—»Probected recording
P $ e e ) evigne

Refresh Rt:trding List
Figure 60: Watch Recording tab of the Scopia Desktop web portal
3. Find the recording:

¢ To search by the meeting ID, name or owner, select the relevant column, then enter the
value in the Search field and select Search .

(&) 889462 —
Search Name: E* s

(&) 889377 -

Search Meeting 1D: Sy

Meeating = Name
(&) ses111 RADVISION & AVAYA products

Figure 61: Search field changes when you select one of the columns

To return to the complete list of recordings, select Cancel .

* To sort the list, select column names.
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« Tofilter the list, select a category from the filtering list. The list shows only recordings
belonging to that category.

4. You can edit the information (metadata) associated with a recording. Select Edit Recording
next to it.

The Edit Recording window opens.

Meeting ID: 885415
Harme: |C‘E training
Description:

Main features overview for Customer Support. Advanced troubleshooting

¥ | Make this recording public, Tt will appear in the st of recordings.,

Status: Finished

Categories:  Unagsigned Aggigned
HMarkeating Customer Support
RED ﬁ Training

Dwner: Rl e Y

Accass PIN: Canfirm: |

Figure 62: Edit Recording window

5. You can change recording's properties as described in Table 21: Editing properties of a
recording on page 84.

Table 21: Editing properties of arecording

Element ‘ Description

Name You can change the name which appears at the Watch Recording
tab of the Scopia Desktop web portal.

Description Edit the short description that appears in the Recording Information
window (upon selecting the Recording Information button shown
in Figure 60: Watch Recording tab of the Scopia Desktop web portal

on page 83).
Make this recording |Select to make the recording public and clear it to make it private.
public
Categories Use the arrow buttons to assign or remove preconfigured
categories.
Access PIN To protect the recording by limiting access to it, enter the access
PIN. You can use any combination of alphanumeric characters.
Confirm Enter the same string to confirm the access PIN.

View Current PINs  Select to see the access PIN you entered.
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Select OK to save the changes you made to the recording's properties.

6. To delete the recording, select Delete and then select Yes in the confirmation message.

Creating or Deleting a Recording Category

About this task

You can organize recordings by assigning categories preconfigured by the administrator for your
organization. Assigning categories to recordings allows you to group recordings and to filter them for

easy search. For example, your organization may have categories for training sessions, board meetings,
product features and so on.

Categories behave in a similar way to playlists or Gmail labels. If the administrator renames an existing
category, Scopia Desktop automatically updates attributes for all recordings belonging to the modified

category. If a category is deleted, Scopia Desktop still keeps the recordings that belonged to the deleted
category.

Administrators manage categories by modifying a list of existing categories, while users can only select
categories from this list to associated them with recordings.

If you rename an existing category, Scopia Desktop automatically updates attributes for all recordings
belonging to the modified category. Deleting a category does not cause Scopia Desktop to delete
recordings belonging to the deleted category.

O important:

If needed, you can assign many recordings to a category in one action by navigating to Recording >
Recordings, selecting the recordings and then selecting Categorize.

Procedure

1. Navigate to the Scopia Desktop Server Administration web interface.

2. Select Recording > Categories.

—
Create a new category: |
| Delete Mote: deleting a category will not delete a recording with that category.
|:| Mame Occurrences
] 0 Recordings
] 1 Recording

3. Enter the name of a new category in Create a new category and select Create.
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4. Select the Edit icon to edit an existing category name.

5. Select Delete to remove a recording category.

The recordings in a deleted category remain in the database but are no longer categorized.

Recording Meetings from Scopia Desktop Server

About this task
This section describes how an administrator can record a meeting from the Scopia Desktop Server by
specifying its meeting ID. There are several ways to record meetings:

* You can configure Scopia Management to automatically record a user virtual room or a scheduled
meeting when the meeting begins. For detailed information, see the Administrator Guide for Scopia
Management.

* Scopia Desktop Client users (even guests) can manually record a meeting depending on that
user's rights as defined in Scopia Management. For more information, see User Guide for Scopia
Desktop Client.

* You can record meetings using the Scopia Desktop Server Administration web interface as
explained in this procedure.

O important:

In a service provider (multi-tenant) deployment, each recording is associated with one organization. A
recording is always listed under the organization in which the meeting was recorded, even if the
recording was started by a user belonging to a different organization than the meeting owner.

Procedure
1. Access the Scopia Desktop Server Administration web interface.
2. Select the Recording > Recordings icon in the sidebar.

3. Enter the meeting ID in Start recording meeting ID.

[
Start Recording Meeting ID:

Figure 63: Start Recording Button

4. Select Record.

The Start Recording window is displayed.
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To start recording the meeting, please provide the fallewing informatian:

Lo, LH |

ChasCription: ‘
Make this recording public. It will appear in the st of recordings.
Categories: Unassigned Assigned
i ~ e
| . -
Ownier PIN: | Canfirm: |
Access PIN: | Caonfirm:

Select Owner  Remowe Cran Start Recording Cancel

Figure 64: Start Recording Window
5. Enter recording name and description.
6. Assign categories as necessary.
7. To secure a recording's data so that only the owner can change it, enter the Owner PIN.
8. To restrict access to this recording to those with an a PIN, enter the Access PIN.
9. To set an owner for the meeting, select Select Owner.
10. If you set an owner for the meeting, select the Make this recording private check box.

11. Select Start Recording.
The meeting appears in the list, and its duration is indicated as In Progress.

Stopping a Recording in Progress from Scopia Desktop Server

About this task
You can stop any recording which is in progress. When you do so, meeting participants are notified that

the recording is stopped. The meeting moderator receives a naotification that the recording is stopped by
the administrator.

Procedure
1. Navigate to the Scopia Desktop Server Administration web interface.
2. Select Recording > Recordings.

3. Inthe recording list, select the check box for recordings you wish to stop.
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]
[] MeetingID = Name
711 SV technology in action

712 no presentation, no switching lecture mode
Figure 65: Selecting recordings you want to stop
4. Select Stop.

5. Select Yes in the confirmation message.

Assigning an Owner to a Recording

About this task

You can assign ownership to recordings when you want to grant administrative control for a recording to
a specific user.

Procedure

1. Access the Scopia Desktop Server Administration web interface.
2. Select Recording > Recordings.

3. Inthe recording list, select check boxes for each recording you want to assign to an owner.

Jan 21 2010

55.59 1:16:49 Adam Pitcher

7123 | Large Meeting January 21 4pm

4. Select Select Owner.

The Select Recording Owner window opens.

Select Recording Owner

Search: | |

Enter part of a user's name to search the directory.

Submit Cancel

Figure 66: Select Recording Owner Window

5. Select the owner name from the Search field.
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6. Select Submit.

7. To remove an owner which is currently assigned to selected recordings:
a. Select the check box for the recording in the list.

b. Select Remove.

Deleting a Recording

About this task

You can permanently remove a recording from Scopia Desktop by deleting it from the recording list.

When you delete a recording which is in progress, the meeting participants are notified that the recording
is stopped. Also, the meeting moderator receives a notification that the recording was deleted by the
administrator.

Procedure
1. Navigate to the Scopia Desktop Server Administration web interface.
2. Select Recording > Recordings.
3. Inthe recording list, select the recordings you wish to delete.
4. Select Delete.

5. Select Yes in the confirmation message.

Defining Webcast Streaming

About this task

This section details how to define the bandwidth of standard definition and HD webcasts, and also
determines the type of webcast: unicast or multicast. A unicast requires a data packet to be sent
separately to each viewer of the stream, while a multicast allows you to send a single packet to a range
of addresses, if your network infrastructure (routers etc) can handle multicasts.

Before you begin

* Install the streaming license. Without the correct license, by default you can only use streaming for
evaluation, which limits webcasts to only five simultaneous participants, with no multicast.

* Enable the streaming functionality in Scopia Desktop Server. Select Deployment > Servers and
verify that streaming is enabled.
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Procedure

1. Access the Scopia Desktop Server Administration web interface.

2. Select Streaming > Settings.

Maximum Video Quality
Configure the size of the video and the bitrate.
Standard Definition
Mancimum Bit Rate (Kb/s): 384 (352p) (=]
[7] High Definition

Maximum Bit Rate (Kb/'s): 768 (720p

| Enable Multicast

Multicast IP Address: |

Time to Live {TTL): |

Applicable IP Ranges:

Low IP High IP
There are no I[P Ranges defined.

Connection Information

|E

If clients cannct resclve the Streaming Server address (perhaps because a private
address is used), specify an additional publicly accessible address below. It is
recommended to use a FQDN that chents can resolve.

Public Address: I*_:u:l.radvl-smn.ccm

Specify the TCP port that clients will use to access the meeting. This must be
configured on the Darwin Streaming Server, and opened on the firewall.

TCP Port: [7070

Port Limit

Limit the total number of ports used for unicast streaming clients.

Paort Limnit |'.5|.‘.l

Figure 67: Defining streaming in Scopia Desktop Server

3. Enter the following fields:

Field Description

Standard Definition > Maximum Bit Enter the bitrate determining the quality of the streamed video in standard
Rate definition.

High Definition Select to enable streaming video in HD.
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Field Description

High Definition > Maximum Bit Rate | Enter the bitrate determining the quality of HD streamed video.

Enable Multicast Select if the network you are planning to stream to supports multicasting.
Multicasting can reduce network traffic significantly by sending the
streaming packets just once for all viewing clients.

Multicast IP Address Enter the IP address to which all multicast media should be routed.

Any change applies only to newly created meetings created. Ongoing
meetings are not affected.

Time to Live (TTL) Enter the number of router traversals where the multicast packet is
allowed to remain active. This is in the formal multicast protocol definition.
Set the value to 1 to ensure it remains in the same subnet. 32 limits it to
the same site or organization.

Any change applies only to newly created meetings created. Ongoing
meetings are not affected.

Applicable IP ranges The range of IP addresses which form the subnet whose infrastructure
can support the multicast protocol.

If a client outside this range tries to stream the videoconference, it will
receive the media via the unicast protocol.

The valid multicast IP address is in the range of 224.0.0.1 and
239.255.255.255.

Any change applies only to newly created meetings created. Ongoing
meetings are not affected.

Public Address Enter the full name of the streaming server (FQDN).

This is an address accessible from outside the NAT, in cases where the
regular IP address of the Scopia Desktop Streaming Server may not be
directly accessible by clients.

TCP Port Enter the TCP port to be used by the Streaming Server. The default value
is 7070.
Port Limit Enter the maximum number of unicast streams on this Streaming Server.

Since unicast streams send a packet to each viewing client, this is an
effective cap on the bandwidth usage of streaming in your organization.

4. Select OK or Apply.

Synchronizing Contact Lists with a User Directory

About this task

One of the components in the Scopia Desktop Server is the Presence Server (see Figure

1: Components of the Scopia Desktop Server on page 7), which updates Scopia Desktop's Contact List,
part of a Scopia Desktop Pro deployment. It maintains the status of a user's listed contacts, whether or
not they are available.

Administrator Guide for Scopia Desktop Server Version 7.7.3 Configuring Advanced Features of Scopia Desktop Server | 91
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My Room  Meetings  Settings

& David Evans

&J Hampshire Conference Room
g John Wallman

& John Wilhams

¢ Mate Harmsson

\'_; Mary Edwards

gl Susan Melson

SCLIPIA

Figure 68: Status icons appear next to each contact

Scopia Desktop’s Presence (XMPP) Server is implemented by a service known as Jabber.

The Presence Server must therefore have access to a user directory, which it retrieves from Scopia
Management, which in turn can take its list of users either from an external source, like Microsoft's Active
Directory, or from Scopia Management's own internal directory.

This section describes how to configure the Presence Server with Scopia Management's user directory,
both its own internal user directory or with an external LDAP directory.

O important:
If your Scopia Management uses Domino as the source of its user directory, follow the same steps for
an Active Directory source.

Before you begin

Ensure Scopia Management is connected to the Scopia Desktop Server and is sharing its user
database. For more information, see Enabling Scopia Desktop User Authentication in Scopia

Management on page 56.

Procedure
1. Access the Scopia Desktop web administration interface.
2. Select the Deployment icon in the sidebar.

3. Select the Presence and Invitation check box. (Figure 69: Connecting the Scopia Desktop
Server to presence (XMPP) and STUN servers on page 93)
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Sarvers

Please select your deployment:  Advanced This deployment allows for mull

awailable.
IVIEW Suite
VIEW Surte Address: | .

[T Secure connection using TLS

H.323

Gateksapar [P Address: | .

SCOPLA Desktop H.323 1D |SDE—:3

B Presence and Invitation

XMFP Server Address [

STUN Server Address: |-
Streaming

Figure 69:  Connecting the Scopia Desktop Server to presence (XMPP) and STUN
servers

4. Enter the IP addresses of each of the servers in the XMPP Server Address and STUN
Server Address fields (Figure 69: Connecting the Scopia Desktop Server to presence
(XMPP) and STUN servers on page 93).

5. Select the Presence and Invitation icon in the sidebar (Figure 70: Defining the Jabber
Domain on Scopia Desktop Server on page 93).

Setfings

Relayed Padnt to Point Calls

@ Use this SCOPLA Deskiop Server to host pont (o point calls,
Use a diferent SOOF1A Desbicp Server to heat point 1o peint calks:

Domain Mapping fer Presence and Invilation

Specify the: XHPP server to uss,

Ciomiain |n' ¥_Organzabsn_name

Presence and

Figure 70: Defining the Jabber Domain on Scopia Desktop Server

6. If Scopia Management uses its internal directory as its list of users, set the Domain field
(Eigure 70: Defining the Jabber Domain on Scopia Desktop Server on page 93) to be the
internal Jabber domain name for your organization. Make a note of this name as you will use
it again later for the Jabber Domain field in the configuration tool in 10.

O important:

This is not a DNS domain. The Domain field here refers to an internal name for the Jabber
service, responsible for presence services. We recommend, therefore, using a name that
does not resolve to an IP address. For example, my_organization_name.

7. If your Scopia Management is configured to work with the Active Directory (Figure
71: Mapping Jabber domains to search bases in Active Directory on page 94):
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Straaming

(¥) Use this SCOPLA Deskiop Sarver to host point to poant calls,

-:':"- Use a different SCOOP1A Desktop Server to host point to point calls:

Domain Mapping for Presence and Invitation

Users come from a Directory Server. Specify the XMFF server to use.

Idap:/ f192.168.212.178
[Actrve Directory)

CHwlsers, DT mrvesuk, DC wlocal
OumlE affice, DCwrvesul, DCwlocal

Presence and
Inwitation

Figure 71: Mapping Jabber domains to search bases in Active Directory

a. You can either choose specific user groups (search bases) within the LDAP user list to
map to a Jabber domain, or map the whole database to a Jabber domain. To select
parts of the LDAP database, select the check box of the LDAP database (Figure
71: Mapping Jabber domains to search bases in Active Directory on page 94).

To choose the whole database, clear the check box.

b. For each search base (user group) you want the Presence Server (XMPP) to access,
enter its internal Jabber domain. Make a note of these names as you will use them again
later in this procedure for the Jabber Domain field in the configuration tool.

O important:

This is not a DNS domain. This Domain field refers to an internal name for the Jabber
service, responsible for presence services. We recommend, therefore, using a name
that does not resolve to an IP address. For example, my_organization_name.

In a multi-tenant deployment, you can create a different mapping per organization.

8. On the Presence Server computer, start the Scopia Desktop Configuration Tool by selecting
Start > All Programs > Scopia Desktop > ConfigTool.

9. Select the Jabber icon in the sidebar to configure the Presence Server.

10. If Scopia Management's user directory comes from its own internal directory:

a. Select iVIEW from the Authentication Type dropdown list at the top of the screen, and
then select Add.

b. In the Jabber Domain field, enter the same domain you used when enabling user
authentication in the Scopia Desktop Server (Figure 72: Connecting the Presence Server
to Scopia Management's internal directory on page 95).

This domain must match the Jabber Domain entered earlier in this procedure.

O important:

This is not a DNS domain. The Domain field here refers to an internal name for the
Jabber service, responsible for presence services. We recommend, therefore, using a
name that does not resolve to an IP address. For example, my_organization_name.
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Jabber Domain:

my_organization_name

iYIEW Address:
172.16.10.3
Local Bind Address:

172.16.10.3

Figure 72:  Connecting the Presence Server to Scopia Management’s internal
directory

c. Enter the IP Address of Scopia Management in the iVIEW Address field.
d. Enter the IP address of Scopia Desktop Server.
If the Jabber Server has multiple NICs, choose one of them for this configuration.
11. If your Scopia Management accesses its list of users from an external source like Microsoft's

Active Directory (Figure 73: Connecting the Presence Server with the Active Directory on
page 95):

o po WO

my_organization_name [(Active Directory )

labber Domain:
my_organization_name

Active rectory Address:

192 168217178

LDAP search base:
Cr=Users, DC=recsuk, 0l =local

Proxy Account User Mame {must have READ permiszion to directory)s

Password:

Confirm Passward;

LOAP Fort:

| Auply | Delete Virtual Host | Restart Jabber Service

Figure 73: Connecting the Presence Server with the Active Directory

a. Select Active Directory from the Authentication Type dropdown list at the top of the
screen, and then select Add.

For Domino implementations, select Domino.

b. Enter the IP address of the Active Directory server in the Active Directory Address
field.
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O important:

This domain must match the Active Directory address entered in the Deployment
page (4).

c. To limit the scope to one or more user groups within the Active Directory, specify the
search base in the LDAP Search Base field.

d. Enter the Proxy Account User Name and Password of a user with access to the Active
Directory database.

e. In case the Active Directory is configured with a port other than default port 389, change
the LDAP Port value.

12. If you have a service provider (multi-tenant) deployment, configure the XMPP domain for
each organization.

In a multi-tenant deployment the Jabber configuration tool displays many tabs, to enable a
different configuration in each organization. Select the relevant tab to configure the
authentication type per organization. See Figure 72: Connecting the Presence Server to
Scopia Management's internal directory on page 95.

O important:

In a multi-tenant deployment, you can have a different Jabber domain for each
organization, but all the organizations use the same Scopia Management, hence the
iVIEW Address field becomes read-only in all the tabs after you have configured it for the
first tab in one of the organizations.

13. Select Apply.

Displaying Administrator Messages to End Users

About this task

This section describes how to edit the administrator and dial plan messages. Use administrator
messages on the Scopia Desktop Server Web Portal page to post important information like the system
status, scheduled shutdowns, or configuration tips.

The dial plan message appears in the Invitation dialog box. You can use this to provide users with
dialing tips, for example, to explain the prefixes to use for different gateways.

The following HTML tags and attributes are supported in the administrator messages text editor:

<a href="http*" target=""_blank></a>

<img src="http*’>

<iframe src="http*’></iframe>

<font color=#123456]red|green|blue]”’></font>
<u>underlined text</u>

<i>italic text</i>

<b>bold text</b>

<br> to break a line

<ol><li>0rdered list items</li></ol>
<ul><li>Unordered list items</li></ul>
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<p></p>
<div></div>

You must fix a width and height of the <iframe> tag according to the style sheet of the corresponding
page. For example, for the portal entry page, the style sheet looks like this:

<style>
-motd iframe

width: 100%
height: 150px

</style>

The administrator message text editor replaces single & characters with &amp ;. It also replaces < and >
of unrecognized tags with &t and &gt respectively.

Procedure

1. Access the Scopia Desktop Server Administration web interface.
2. Select Messages and Invitations > Messages.

3. Select the Administrative Message check box.

B Administrative Message

<iframs allowtcransparsency="true” widch="100%" height="120" src=" 1)

hoop://www.radvision.com/rvan sd tod/tips.htm”

frameborder="0"></iframe>

Figure 74: Modifying the entry-page message for end-users
4. Modify the text of the entry page message as required.

5. Select the Invitation Dial Plan Assistance check box.

Invitation Dial Plan Assistance

Figure 75: Modifying the invitation message for end-users
6. Modify the text of the invitation message as required.

7. Select OK or Apply.
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Configuring Dial String Rules

About this task

This section describes how to configure dial string rules in Scopia Desktop. Dial string rules look for

prefixes in the dial string, alter the string according to your organization’s policy, and route the call to the
correct gateway or gatekeeper.

Navigation

* Planning Rules to Modify Dial Strings on page 98

* Adding or Editing a Dial String Rule on page 100

* Deleting a Dial String Rule on page 102

Planning Rules to Modify Dial Strings

About this task

Depending on the phone system of your organization, you may already have a prefix of ‘9’ (or some
other number) to call outside the organization. More specifically, a gateway reads and interprets the dial
string, sees the ‘9’, and routes the call to a gateway to reach an external phone line. It then alters the dial
string by removing the ‘9’, and sends the remainder of the number to the external phone exchange.

Similarly, you may also have a prefix of ‘1’ or ‘0’ to dial outside your city or state (long distance calls),
and ‘00’ or ‘011’ for international calls. If you have branches in other locations, your
gateways/gatekeepers may have dedicated prefixes to reach that branch’s exchange. For example, all
dial strings beginning with ‘5’ may be routed to the Hong Kong office. In each case, your call system
routes to different gateways or gatekeepers by reading and interpreting your dial prefixes.

In Scopia Solution deployments, dial prefixes are interpreted and altered when:

* When a call is routed to a local H.323 PSTN or ISDN gateway. Scopia Desktop modifies the prefix
to add routing information.

* When there is a SIP PBX either on-site or at a remote location, Scopia Desktop detects phone
numbers in the directory and appends the SIP URL to forward it to the right gateway.

There are several methods to alter dial strings:

* String normalization removes all non-digits from a string (except '+'). For example: +1 (603)
407-5956 becomes 16034075956. This is always the first rule.

* Replace a prefix or suffix
* Add a prefix or suffix

* Remove a prefix by leaving the replacement string blank.
O important:

Dial rules are applied in the specific order they are listed.

List your rules so that the more specific rules are applied first, followed by the more general. For
example, a rule which replaces all +1603 prefixes is more specific than a rule which replaces all +1
prefixes. Therefore the more specific +1603 rule should be executed first.
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Table 22: Simplified example for local, national and international dial string rules on page 99 shows the
rules required to edit the dial strings so that:

* Any phone number starting with an area code of +1603, 1603, or 603 and followed by exactly
seven digits should be routed to a gatekeeper/gateway which is accessed with the prefix 1370. The
seven digits following the prefix remain intact.

* Any other long distance (national) number indicated by +1 and followed by 10-digit phone number
should be routed to a gatekeeper/gateway by substituting 11701 for the +1 and keeping the
subsequent 10 digits.

* Any calls starting with the international country code prefix of +44 for the UK followed by any
random number of digits is re-routed to the 10700 gateway.

Table 22: Simplified example for local, national and international dial string rules

Optional Example Input Example Result
Suffix String String

BOIXXXXXXX 1370 6035555555 13705555555 A call to area code 603 with seven digits
following is routed to a local call gateway,
accessed with the number 1370. The
remainder of the numbers remain intact.

1B603XXXXXXX 1370 16035555555 13705555555 A call to area code 603, also when
prefaced by a ‘1’, is also routed to a local
call gateway, accessed with the number
1370. The remainder of the numbers
remain intact.

+1603xxxxxxx 1370 +16035555555 | 13705555555 A call to area code 603, even when
prefaced by a ‘+1’, is also routed to a
local call gateway, accessed with the
number 1370. The remainder of the
numbers remain intact.

Comments

Match Prefix Replace

FIXXXXXXXXXX 11701 +15085555555 11701508555555 All other long distance calls routed to
5 another gateway, accessed with the
number 11701.
+44 10700 +44555666666 10700555666666 |International calls to England go to the
6 6 London local call gateway, accessed by

the number 10700.

Table 23: Example dial rules to add a suffix to route to a SIP gateway on page 100 shows the rules
required to edit the dial strings so that:

* Any phone number starting with the area code +1603, 1603 or 603 and then followed by exactly
seven digits is routed to the ‘aa’ SIP gateway by adding the “@sip_aa.acme.com” suffix to the
remaining seven digits.

* Any long distance (national) number indicated by +1 and followed by 10-digit phone number is
routed to the ‘bb’ SIP gateway by adding the “@sip_bb.acme.com” suffix to the 10 digits.

* Any calls starting with the international country code prefix of +44 for the UK followed by any
random number of digits is re-routed to the 10700 London gateway by replacing the prefix with O
and adding the “@sipg+_cc.acme.com” suffix.
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Table 23: Example dial rules to add a suffix to route to a SIP gateway

I\P/I?etfci: Replace Ogﬂ%r;(al Exan;tp)rlii;nput Example Result String Comments
BO3XXXXXX @sip_aa.acme 6035555555 5555555@sip_aa.acme.com A call to area code 603
X .com with seven digits

following is routed to the
‘aa’ SIP gateway with the
area code removed.
1603XXXXX @sip_aa.acme | 16035555555 |5555555@sip_aa.acme.com A call to area code 603
XX .com with a ‘1" in front is also
routed to the ‘aa’ SIP
gateway with the area
code removed.
+1603xXXXX @sip_aa.acme | +16035555555 |5555555@sip_aa.acme.com A call to area code 603
XXX .com with a ‘+1’ in front is also
routed to the ‘aa’ SIP
gateway with the area
code removed.
FIXXXXXXX |1 @sip_bb.acme | +15085555555 |15085555555@sip_bb.acme.co |All other long distance
XXX .com m (national) calls routed to
the ‘bb’ SIP gateway.
The ‘+1’ is replaced with
1
+44 0 @sip_cc.acme |+44555666666 05556666666@sip_cc.acme.co | International calls to the
.com 6 m UK go to the ‘cc’ SIP
gateway. The ‘+44’ is
replaced by ‘0’.

Adding or Editing a Dial String Rule

About this task

A dial string rule alters dial strings to reflect the routing policy of your organization. For example, a dial
string that starts with ‘9’ can be defined to route to an outside line. The rule usually specifies a dial prefix
which is replaced, or adds a suffix to the end of the dial string, so that it can be sent to the appropriate

gateway/gatekeeper.

To correctly represent the number of digits in a string, use the 'x' character to denote ‘any number’.

For example, a rule that looks for ‘603’ matches any dial string that begins with ‘603’, while a rule looking
for '603xxxxxxx’ matches only a dial string which begins with ‘603’ and is followed by seven digits. You
cannot use any other characters, such as a spaces, hyphens or brackets.

This section details how to create or edit a dial string rule.

Procedure

1. Access the Scopia Desktop Server Administration web interface.

2. Select Messages and Invitations > Dial Strings.
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Test a Dial Siring Test
==

I
[[1 "Match Prefix =" Replacement Suffix Comment A
[ +1sooonoon: 115531 UsA ;‘;
L] +42 145530 UK b
[0 +zs2 15553 Hic ol
[ 1xooooonooon: 115531 s mb
O sozmoooox 115531603 NH US & .

Figure 76: List of Dial string rules

3. Select Add to create a dial rule.

To edit an existing rule, select the edit icon on the right hand side of the row.

Add New Entry x

Match Prefix: | (1]
® replace: | L]
() Remove

O Leave A= I=

] append Suffix: | Q@

Comment: |

Figure 77: New dial string rule
4. Enter the prefix in the Match Prefix field.

5. Select one of these options:
* Replace—A string matching the prefix is replaced with another string.
* Remove—A string matching the prefix is stripped from the dial string.

* Leave As Is—A string matching the prefix is left as is.
6. If you selected the Replace option, enter the replacing prefix in the field.
7. To add a suffix, select the Append Suffix check box, and then enter the suffix in the field.
8. Enter a comment.
9. Select OK.

10. To test the new dial string rule:

a. Enter a string in the Test a Dial String field.
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Test a Dial String | | ﬂ

Figure 78: Dial String Test

b. Select the check box for the rule you want to apply to this string.
c. Select Test.

The Dial String Test window appears displaying the dial string after the rule is applied.

Dial String Test

Before: +44
After: 145530

o< ]

Figure 79: Dial String Test Results

Deleting a Dial String Rule

About this task

A dial string rule is the method used to alter dial strings to reflect the routing policy of your organization.
For example, a dial string that starts with ‘9’ can be defined to be routed to an outside line. The rule
usually specifies a dial prefix, which the rule then replaces, or adds a suffix to the end of the dial string,
so that it can be sent to the appropriate gateway/gatekeeper.

This section details how to remove an existing dial string rule.

Procedure

1. Access the Scopia Desktop Administration web interface.

2. Select Messages and Invitations > Dial Strings.
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[[1 "Match Prefix =" Replacement Suffix Comment A
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Figure 80: List of Dial string rules

3. Locate the rule you need to remove and select the check box next to it.
The Add button changes to a Delete button.

4. Select Delete.

5. Select OK to confirm.

Branding your Scopia Desktop User Interface

Customers can change logos and text from the Radvision or Scopia Desktop branding to their own
custom branding. You can change images and strings using the Scopia Desktop Branding application.

O important:

You can export or import all the customized images and text strings for your organization in the
Scopia Desktop Branding application, by selecting File > Export or File > Import.

To restore the default Scopia Desktop GUI text and images, select File > Restore All.

Navigation

* Replacing Brand Logos and Other Images on page 103

* Customizing GUI Text Strings for your Organization on page 105

Replacing Brand Logos and Other Images

About this task

You can replace images appearing in the Scopia Desktop user interface by using the Branding
application on Scopia Desktop Server. Changes takes affect immediately, therefore we recommend not
to replace images on a live server. Most web browsers store local cached copies of images, therefore to
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ensure an up-to-date view of the application, clear your browser's cache. Scopia Desktop Server is
released with a set of default images which you can restore at any time.

Procedure
1. Select Start > Programs > Scopia Desktop > Branding Application.

2. Select the Images tab.

Images Stringsl
esktop logo
primary logo This is the deskbop logo that appears & the top of the enfry page, admin ertry page and the shouk dial
toclbar Iogo background.
Recommended image size: w480 X h:50
The instaled image is properly sized.
Defaulk image

SCLIPIN DESKTO P

Currently installed mage

SCLIPIN DESKTOPR

Praview

Mo image has been selected, Use the ‘Select File' butkon, | Select File...

Figure 81: Viewing and changing logos in the Scopia Desktop GUI

O important:

If an image has a transparent background, it appears with a gray and white “checkerboard”
background in the preview fields.
3. Choose the image you want to replace from the list at the top left of the window.
A brief description of the image is displayed along with the recommended image size. The
Default image area shows the image originally distributed with the product. The Currently
installed image shows the image that appears in the user interface.
4. Select Select File, to choose the new logo.
If you use an image that the application indicates as not properly sized, a warning appears
below the image description.
5. If you use an image that is not properly sized, verify that the image is displayed correctly:
a. Verify that the Scopia Desktop Server is running.

b. Review the Scopia Desktop user interface to verify that the image appears correctly.

6. Select Install Image to use the new image.
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O important:
If an old image still appears, refresh your browser's cache.

7. To restore a default image, select Restore Original Image.

Customizing GUI Text Strings for your Organization

About this task

You can modify some of the text displayed in the Scopia Desktop user interface. If you update any text
strings, you need to restart Scopia Desktop Server to see the effect of the update.

Procedure
1. Select Start > Programs > Scopia Desktop > Branding Application.

2. Select the Strings tab.

Strings

Skring Mew valle Rebranded Yalue Default Yalue
product name SCOPIA Deskiop SCOPLA Deskhop -
SEFYEL Name SCOPIA Deskbop Server  SCOPLA Deskkop Server
plural server name SCOPIA Desktop Servers SCOPLA Desklop Servers
MZU name SCOPTA MCU SCOPTA MZU o
plural MCU name SCOPTA MCs SCOPTA MCUs
professional opkion SCOPIA Deskiop Pro SCOPLA Deskiop Pro .
meeting control server WIEMWY Suite VIEW Suite i
Description

The "_pr-:u:luu:t ne!me" sFring is used to display the product name in places where available space in the user
& server restart is required,

Restore All Default Skrings Apply Cancel

Figure 82: Creating replacement strings for Scopia Desktop GUI

3. Enter the new text strings in the New Value column.
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Table 24: Changing the GUI strings

Field Description

String The internal label of the string whose value is displayed in the
GUL.

New Value Insert the text you would like to display in place of the existing
text.

Rebranded Value This column displays the values that are currently saved. When

the Scopia Desktop Server is restarted, these are the values
which appear in the user interface.

Double-click this value to copy it to the New Value column.

Default Value This column displays the original text strings that were distributed
with Scopia Desktop.

4. Select Apply.
The new values are saved and appear in the Rebranded Value column.
5. In the Windows Services panel, restart the Scopia Desktop - Apache Tomcat service to
apply the changes.
6. To restore default strings:
a. Select Restore All Default Strings.
b. Select Apply.

c. Restart the Scopia Desktop - Apache Tomcat service to apply the changes.
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Chapter 5| Securing Your Scopia Desktop
Deployment

This section describes how you can enhance the security of your Scopia Desktop deployment by encrypting
communications using the encryption keys held in certificates which are uploaded to the various deployment
components.

O important:
Using encryption is subject to local regulation. In some countries it is restricted or limited for usage. For more
information, consult your local reseller.
There are two types of certificates which can be installed.

* Install certificates on the Conference Server to encrypt the media travelling between Scopia Desktop Clients
and the Scopia Desktop Server. These certificates also secure all web traffic to the Scopia Desktop Server, for
example, when you access the server's web administration user interface or when a user accesses their
meeting portal.

* Install certificates in the server’s keystore file, part of the Java installation, to secure communications with
Scopia Management and other components. Mutual authentication requires a certificate stored on each side of
the communication line.

The details of each certificate type and their configuration are detailed in the sections below:

Navigation

* Securing Web Connections and Media Traffic to Scopia Desktop Server on page 107

* Securing Scopia Desktop Server's Connection to other Components on page 109

* Securing Login Access to Scopia Desktop Server using IWA on page 111

Securing Web Connections and Media Traffic to Scopia
Desktop Server

About this task

This procedure explains how to secure all web traffic to the Scopia Desktop Server with HTTPS,
including the administrator interface and user portals. This also secures the actual media (audio and
video) of any videoconferences which take place.

The certificate which secures web traffic and videoconference media is installed in the Scopia Desktop
Conference Server.

O important:

This procedure requires a signed certificate ready for the Scopia Desktop Server. You can either use
the certificate shipped with the server, or create your own unique certificate.
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Procedure
1. Select Start > All Programs > Scopia Desktop > ConfigTool.
2. Select the Enable HTTPS check box in the HTTPS tab.
3. Select Apply.
4. Select Add Certificate to upload an existing signed certificate.
5. Stop the service Scopia Desktop Conference Server.
6. Navigate to <SD_install_dir>\Confsrv
7. Run the Certificate Configuration Utility by launching CertificateConfiguration.exe file.

8. If the certificate is installed in the local machine's certificate store:
a. Select the Configure Certificate via Certificate Store
b. Select Select Certificate.

c. Select the certificate from the list.

9. If the certificate is in PKCS12 format:
a. Select Configure Certificate via File Name.
b. Browse to the PKCS12 certificate and select it.

c. Enter the private key password for the certificate.
10. Select OK.
11. Verify that the certificate information is listed in the Selected Certificate pane.
12. Select Apply.
13. Select OK.
14. Select OK.
15. Start the service Scopia Desktop Conference Server.
16. Select Restart Services.

17. Change the URL in the Invitations section of the Scopia Desktop Administration web
interface to use the secure HTTPS protocol:
a. Log into the Scopia Desktop Administration web interface.
b. Select Messages and Invitations on the sidebar.
c. Select the Invitations tab.

d. In the Desktop Access section, verify all URLs have the prefix of https.

O important:

By default, there are two URLSs present in this section.
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Securing Scopia Desktop Server’s Connection to other
Components

About this task

You can secure the management communication sent between Scopia Desktop Server and other
components like Scopia Management with TLS encryption. This method also checks the data integrity of
messages.

Mutual authentication would require a certificate on each side of the connection. On Scopia Desktop
Server, use the keytool utility, which is part of the Java installation. For more information about
securing Scopia Management's connections with other components, see the Administration Guide for
Scopia Management.

To open a mutually authenticated TLS connection, each server authenticates the other by exchanging
certificates.

O important:

Scopia Desktop Server is shipped with a pre-created and pre-installed certificate, but its encryption
keys are non-unique.

To create certificates with unique keys for true authentication (step 3 onwards), you must first remove
the pre-installed certificates held in keytool's .keystore file, then generate and install new unique
certificates.

The password on the _keystore file is radvision.

This section does not explain each of the parameters of the keytool command. For a full description of
this Java utility, see http://java.sun.com/j2se/1.4.2/search.html.

Procedure

1. Enable the management encryption on the Scopia Desktop Server side:
a. Access the Scopia Desktop Server Administrator web user interface.
b. Select the Deployment icon on the sidebar.

c. Select the Secure connection using TLS check box in the Scopia Management
section.

IWIEW Suite Address: 192.168.114.236 Q9

[v Secure connection using TLS

Figure 83: Secure Connection Check Box
d. Select OK.

2. On the side of Scopia Management, enable the management encryption connection:

a. Login to the Scopia Management.
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b. Select Resource Management in the sidebar.

c. Select the Scopia Desktop tab.

d. Select the Scopia Desktop Server whose communications you want to encrypt.
e. Select the check box Secure XML connection using TLS.

f. Select OK.

3. Stop the Scopia Desktop - Apache Tomcat service.

4. Copy the .keystore file located in <SD_install_dir>\data\sds.keystore to a temporary
working folder, for example C:\cert. The keystore file holds the certificates on each server.
Currently they hold the default non-unique certificates.

5. Open a command line window. The keytool utility is located in <SD_install_dir>\JRE\bin.

6. Use the keytool utility to remove the pre-installed certificate from the . keystore file with
the —-delete parameter. The default certificate has an alias of default:

keytool -delete -alias default -keystore sds.keystore -storepass radvision

7. Generate a unique key pair using an appropriate DN with the —~genkeypai r parameter:

keytool -genkeypair -keyalg RSA -alias sds -sigalg MD5withRSA
-dname "CN=<FQDN of server>" -keystore sds.keystore -storepass radvision -validity 365 -keysize 1024

8. Create a certificate signing request file (CSR) for the newly generated key pair using the -
certreq parameter:

keytool -certreq -alias sds -sigalg MD5withRSA -keystore sds.keystore
-storepass radvision -file C:\cert\certreq.csr

9. Send the certificate request to a Certificate Authority.

10. The CA returns the certificate signed in form of .crt file, for example signed_cert.crt. It
also returns a root certificate, root_cert.crt.

11. Import the root certificate of the CA into the keystore file using the - import parameter:

keytool -import -trustcacerts -alias root -file root_cert.crt
-keystore sds.keystore -storepass radvision

where root_cert.crtis the trusted root certificate.

The trustcacerts parameter instructs keytool to check both the specific and the
system.keystore file for the root certificate.

12. Import the signed certificate into the keystore file. Use the same alias you used in 8.

keytool -import -trustcacerts -alias sds -file signed_cert.crt
-keystore sds.keystore -storepass radvision

Keytool issues a confirmation message if the certificate was uploaded successfully.
13. Copy the .keystore file back to its original location (see 4).

14. Restart the service on each side (see 3).
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Securing Login Access to Scopia Desktop Server using
IWA

About this task

Scopia Desktop Server can use the standard Integrated Windows Authentication (IWA) to login to the
Scopia Desktop Server, avoiding sending the username and password over the network. With IWA, the
browser encrypts and sends the current Windows username and password to access Scopia Desktop
Server.

O important:

Scopia Desktop Server provides IWA cannot be enabled in service provider (multi-tenant)
deployments.

In addition, if you use Microsoft Internet Explorer to access the Scopia Desktop Server, its address must
be listed either as one of the trusted sites or as part of the Intranet zone.

Before you begin

Ensure that authentication settings are configured for Scopia Management.

Procedure

1. Access the Scopia Desktop Administration web interface.

2. Select the Directory and Authentication icon in the sidebar.

The Settings tab is displayed.

3. Select the Integrated Windows Authentication check box.
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Integrated Windows Authentication

Specify the Windows domain to which users belong, for example, "mydomain.com”.

Windows Authentication Demain: |

Specify the NetBIOS short domain name, for example, "MYDOMAIN".

NetSI0S Short Domain Name: [

Specll'_'-,r the credentials of @ prowy user account that may be used to establish a connection to the
demain controller.

Proxy Account User Name: |

Proxy Account Password: [------

Confinm Froxy Account Password: |u~u"

Determine the domain controllers to use. A domain controller address should only be explicithy
specified if & WINS server is not defined in your deployment.

() Cbtain automatically [recommended)

() Obtain from WINS server: | Li ]
(%) Use this Domain Controller address: | (13

Figure 84: Encrypting login to Scopia Desktop Server
4. Enter the windows domain to which users belong.
5. Enter the NetBIOS short domain name.
O important:
The NetBIOS short domain name field is case sensitive.
6. Enter the Proxy account user name.
7. Enter the Proxy account password.
8. If a WINS server is not defined, enter the domain controller address.

9. On the client side, verify that Integrated Windows Authentication is enabled for your Internet
Explorer:
a. In the Internet Explorer window, select Tools > Internet Options > Advanced.
b. Under Security section, verify that Enable Integrated Windows Authentication is
selected.
10. To add Scopia Desktop Server to the list of Internet Explorer trusted sites:

a. In the Internet Explorer window, from Tools > Internet Options > Security > Trusted
Sites > Sites.
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Trusted sites

& You can add and remove websites From this zone, Al websites in
- this zone will use the zone's security settings.

Add this website to the zone:

Websites:

. A —
- b

i il A . -
w

[ Require server verification (https:) for all sibes in this zone

Figure 85: Adding Scopia Desktop Server as a trusted site

b. Enter the Scopia Desktop Server site address, for example sd.server.com and then
select Add.

c. Select Custom level.

d. Under the User Authentication section, select Automatic logon with current user
name and password.

e. Select OK.

11. To add Scopia Desktop Server to the Internet Explorer intranet zone:

a. In the Internet Explorer window, from Tools menu select Internet Options > Security >
Local Intranet > Sites > Advanced.

g You can add and remove websibes Fram this zone. All webskes in

this zone wil usa e zone's securky settings,

Add this website to bhe zome:
sd.Sarver.com

Websites:

ol -

TR

[#]Require server verification (htkps:) for all sites in this zone

(o)

Figure 86: Adding Scopia Desktop Server as atrusted intranet site

b. Enter the Scopia Desktop Server site address, for example sd.server.com and then
select Add.

c. Select Custom level.
d. Under User Authentication section, select Automatic logon only in Intranet zone.
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e. Select OK.
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Chapter 6 | Maintaining the Scopia Desktop
Deployment

About this task

Occasional system upgrades and infrastructure changes in your network may require additional system maintenance
activities to maintain your Scopia Desktop deployment. This section includes the following topic to assist you in
maintaining your deployment:

Navigation

* Upgrading the Scopia Desktop Server License on page 115

* Backing Up Scopia Desktop Server Configuration Settings on page 116

* Restoring Scopia Desktop Server Configuration Settings on page 117

* Accessing Scopia Desktop Server Log Files on page 117

Upgrading the Scopia Desktop Server License

About this task

You can update the Scopia Desktop Server license for:
* Recording license

If you want to add the recording feature or increase the number of simultaneous recordings, you
need a new or updated recording serial key.

A server with recording features enabled must have a valid recording license installed. Without a
license, you are restricted to the default evaluation license allowing you to record one five-minute
meeting at a time. Scopia Desktop Server supports up to 10 simultaneous recordings.

* Increased call capacity

If you upgrade your video network capacity, you can upgrade the maximum number of
simultaneous calls on the Scopia Desktop Server with an updated license.

Before you begin

Obtain an Scopia Desktop Server license key and an optional recording serial key.

Procedure
1. Select Start > Settings > Control Panel.

2. Double-click Add or Remove Programs.
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3. From the list of programs, choose Scopia Desktop, and then Change.

The Setup Wizard opens.
4. In the Welcome screen select Next.
5. In the Program Maintenance screen, choose Modify, and select Next.
6. Inthe Custom Setup screen, select Next.
7. In the Scopia Desktop Serial Key window, enter updated keys, and then select Next.

8. Follow on-screen instructions to complete installation configuration.

Backing Up Scopia Desktop Server Configuration Settings

About this task

Certain configuration files used by Scopia Desktop should be backed up regularly to allow recovery from
catastrophic system failure or instances of corrupted files. During this backup procedure you copy the
xml files which contain these settings:

* Dial string rules

* Administrative message

* Invitation message

* Presence Server database
* Local database

* Local configuration

Procedure
1. Navigate to the following directory: <installdir>\data.

2. Copy the relevant files into a location outside the installation directory:
* ctmx.ini—for local configuration
* motd.html—for administrator message
¢ dialplanhelp.html—for invitation message
* members.xml—for local database

* dial_string_manipulators.xml—for dial string rules

O important:

The file members.xml is created only if you use Scopia Desktop without Scopia
Management and add endpoints to a local directory. As a result, the directory status in the
system web interface shows a synchronization error with Scopia Management as
explained in Viewing Directory Status on page 142.
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Restoring Scopia Desktop Server Configuration Settings

About this task

You may need to restore some of the configuration files used by Scopia Desktop to allow recovery from
catastrophic system failure or instances of corrupted files.

Procedure

1. Stop the service Scopia Desktop - Apache Tomcat.
2. Navigate to the following directory: <install_dir>\data.

3. Replace the relevant file with the backup file:
* motd.html—for administrator message
¢ dialplanhelp.html—for invitation message
* members.xml—for local database

* dial_string_manipulators.xml—for dial string rules
4. Start the service Scopia Desktop - Apache Tomcat.
O important:

The members.xml file is created only if you add terminals to a local directory. As a result,
the directory status in the system web interface shows a synchronization error with Scopia
Management as explained in Viewing Directory Status on page 142.

Accessing Scopia Desktop Server Log Files

About this task

Scopia Desktop automatically maintains extensive logs to help maintain your deployment and
troubleshoot problems. By accessing the Logging tab, you can enable enhanced logging, which
provides a network trace on the server (with or without media, depending on your selection) as well as
extended middleware logging.

O important:

Enabling enhanced logging for extended periods of time adds large log files to the system.
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Procedure
1. Navigate to the Scopia Desktop Server Administration web interface.
2. Select the Status icon in the sidebar.

3. Select the Logging tab.

SCOPIA Desktop | Durectory | Recordsng  Content Slider | Logging

Logging Control Logqging Summary

Enhanced Logging:

Disabled

Log Fele:

Enhanced Logging: Leg All Media

Figure 87: Enabling enhanced logs
4. To download a zipped version of current log files, select Download.

5. (Optional) To enable enhanced logging, select Enable.

The Logging Summary pane displays the current status of enhanced logging.
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Chapter 7| Deploying Multiple Scopia
Desktop Servers with a Load
Balancer

Scopia Desktop is a scalable solution, enabling you to add more Scopia Desktop Servers to your deployment to
increase server availability by making your solution resistant to server downtime, and increases the number of
participants who can simultaneously connect to videoconferences.

You can deploy multiple Scopia Desktop Servers in a number of ways (see Planning your Scopia Desktop Server
Deployment on page 10), including managing a set of servers with a load balancer. A load balancer groups together
a set (or cluster) of servers to give them a single IP address, known as a virtual IP address. In this way, other
components in the solution relate to the cluster as though they were a single server (Figure 88: Scopia Desktop
Servers with load balancer on page 119).

Scopia DesktopServers

Load Balancer
sd.comparny.com

Figure 88: Scopia Desktop Servers with load balancer

A load balancer groups together a set (or cluster) of servers to give them a single IP address, known as a virtual IP
address. It distributes client service requests amongst a group of servers. It distributes loads according to different
criteria such as bandwidth, CPU usage, or cyclic (round robin). Load balancers are also known as application
delivery controllers (ADC).

O important:
All servers in the deployment must be configured with the same functionality and the same security mode
(http/https).
We recommend using the health checks of ICMP echo request and HTTP Web (TCP port 80) to monitor the cluster
in your deployment.

All servers in the cluster should have identical functionality enabled, since one server must take over if another is
overloaded or fails. If you deploy dedicated servers for the different components of Scopia Desktop (for example, a
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dedicated recording or streaming server), these dedicated servers should be located outside the cluster. For more
information, see Configuring Streaming and Recording in a Load Balancing Environment on page 133.

This section guides you through deploying a load balancer with Scopia Desktop. Perform these tasks in the order
listed below:

Navigation

Configuring Scopia Desktop Server for Load Balancing on page 120

Configuring Radware AppDirector on page 124

Configuring Other Load Balancers on page 131

Configuring Streaming and Recording in a Load Balancing Environment on page 133

o M WD E

Securing a Load Balanced Environment on page 136

Configuring Scopia Desktop Server for Load Balancing

About this task

For scalability and high availability, you can deploy multiple Scopia Desktop Servers with a load
balancer. This section focuses on configuring settings on the Scopia Desktop Servers. For configuring
load balancer settings, see Configuring Radware AppDirector on page 124 or Configuring Other Load
Balancers on page 131.

Load balancers must direct all participants in a videoconference to the same Scopia Desktop Server,
even if this server has no longer enough resources to handle the calls.

When a participant requests to join a videoconference on an overflowing server, the server (not the load
balancer, but the server itself) points to another server in the cluster, enabling the participant to join the
same meeting from a second server. Redirecting participants in the same conference can only be done
from within the Scopia Desktop Server which hosts the videoconference (Figure 89: Redirecting
participants in a load balanced environment on page 121).

This is separate and distinct from the load balancer's redirection, which redirects traffic between different
videoconferences, not within the same videoconference.

For example, in a new videoconference the load balancer uses the configured load distribution algorithm
(such as round robin or least traffic) to forward the first participant to server A (Figure 89: Redirecting
participants in a load balanced environment on page 121). The load balancer then forwards subsequent
participants of the same videoconference to the same server. If server A runs out of ports, configure it to
redirect calls to the next server in the cluster (or farm):
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Scopia Scopia Scopia Scopia Scopia Scopia
Deskmop Desktop Desktop Deskop Desktop Deskiop
Serveri Sener B Senver C Server A Server B ServerC
H\\ L - — =
\\"\-\. __,-f’ “"‘-\-,,_H_
Load Balancer Load Balancer
ScopiaDesktop ScopiaMobile Scopia Desktop ScopiaMobile
< Client 4 A Client 4
Load balancer redirection Server redirection
of different videoconferences within the same videoconference

Figure 89: Redirecting participants in a load balanced environment

1. If server A is out of resources for the same videoconference, redirect participants to server B.

2. If server B is out of resources for the same videoconference, redirect participants to server C, and
S0 on.

The Scopia Solution allows both registered participants and guests to join a videoconference. To further
improve registered user experience, all servers in the group must share the meeting login of registered
users. Otherwise, participants might have to re-enter their credentials when the load balancer routes
calls to other servers in the farm. Therefore, enable the underlying Tomcat clustering in each Scopia
Desktop Server (About Components of the Scopia Desktop Server on page 7), so participants enter their
username and password only once when they join the videoconference.

O important:
When all participants are guests with no logins, you do not need to set up Tomcat clusters.

This procedure describes how to configure Scopia Desktop Server redirection for participants within the
same videoconference, for deployment with any type of load balancer.

Before you begin

1. Plan your load balancer deployment as part of your overall topology. For more information, see
Planning your Scopia Desktop Server Deployment on page 10.

2. Configure the Scopia Desktop Server's basic settings as described in Configuring Core Features of
Scopia Desktop Server on page 49.

3. Read Deploying Multiple Scopia Desktop Servers with a Load Balancer on page 119 for an
overview on load balancing in the Scopia Desktop deployment.

4. Remember to back up any settings file which you edit as part of this procedure.
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Procedure
1. Open the ctmx.ini file located in <install directory>\data\

2. Locate the [redundancy] section of the file (Figure 90: The redundancy section in the
ctmx.ini file on page 122).

H [redundancy]
loadbalancerenabled=true
clusteringenabled=true
redirectenabled=true

# address ©o redirectc to
address=152.168.2491.599

# number of re-direct attempts

maxattempta=3

Figure 90: The redundancy section in the ctmx.ini file

3. Set loadbalancerenabled to true (Figure 90: The redundancy section in the ctmx.ini file
on page 122).

4. Setredirectenabled to true (Figure 90: The redundancy section in the ctmx.ini file on
page 122).

5. Inthe address line, enter the address (either IP or FQDN) of the server to which the system
redirects a participant of the same call when this server is full. Redirect each server to the
next one in line (Figure 89: Redirecting participants in a load balanced environment on page
121). You must specify only one redirection address in each server.

For example, the server's address has one of these formats:

* |IP address:
address=192.168.241.99
* FQDN:
address=scopiaserverl.com
* IP address with port when the port is not the default:
address=192.168.241.99:8080
6. Enter the maximum number of redirections in maxattempts (Figure 90: The redundancy

section in the ctmx.ini file on page 122). Keep this number consistent in all the servers across
the deployment to ensure a predictable redirection behavior.

To prevent an infinite loop, limit the total number of redirections to the total number of Scopia
Desktop Servers in the deployment.

7. (Required only if you have registered SDC users with usernames and passwords.) Enable
Tomcat clustering in Scopia Desktop Server with full memory replication of sessions. For
more information, see http://ftomcat.apache.org.

a. In the same [redundancy] section, set clusteringenabled to true (Figure
90: The redundancy section in the ctmx.ini file on page 122).
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b. Save and close the ctmx.ini file.
c. Open the server.xml file located in <install directory>\tomcat\conf\
d. Locate the text <Cluster (without the close bracket >").

e. Verify this line is not commented out by removing the surrounding comment indicators
(<¥--and -->).

f. Replace that element with the following code:

<Cluster className="'org.apache.catalina.ha.tcp.SimpleTcpCluster' channelSendOptions="8">
<Manager className=""org.apache.catalina.ha.session.DeltaManager""
expireSessionsOnShutdown=""false" notifyListenersOnReplication="true"/>
<Channel className=""org.apache.catalina.tribes.group.GroupChannel>
<Membership className=""org.apache.catalina.tribes._membership.McastService"
address='"228.0.0.4" port="45564" frequency="500" dropTime="3000"/>
<Receiver className="org.apache.catalina.tribes.transport.nio.NioReceiver"
address=""auto" port="4000" autoBind="100" selectorTimeout="5000" maxThreads=""6"/>
<Sender className="'org.apache.catalina.tribes.transport.ReplicationTransmitter'>
<Transport className=""org.apache.catalina.tribes.transport.nio.PooledParallelSender"/>
</Sender>
<Interceptor className="org.apache.catalina.tribes.group.interceptors.TcpFailureDetector"/>
<Interceptor className="org.apache.catalina.tribes.group.interceptors.MessageDispatchl5Interceptor"/>
</Channel>
<Valve className=""org.apache.catalina.ha.tcp.ReplicationValve" filter=""/>
<Valve className="'org.apache.catalina.ha.session.JvmRouteBinderValve"/>
<Deployer className="'org.apache.catalina.ha.deploy.FarmWarDeployer"
tempDir="/tmp/war-temp/"* deployDir="/tmp/war-deploy/* watchDir="/tmp/war-listen/"
watchEnabled="false"/>
<ClusterListener className="'org.apache.catalina.ha.session.JvmRouteSessionlDBinderListener"/>
<ClusterListener className="org.apache.catalina.ha.session.ClusterSessionListener"/>
</Cluster>

g. Save and close the file.
h. Open the web.xml file located in \tomcat\webapps\scopia\WEB-INF\
i. Add a new line before the </web-app> line and enter <distributable/> in the line.
This allows the server to distribute session information to other servers in the cluster.

j- Save and close the file.

k. Open the context.xml file in \tomcat\conf\ and locate the line containing <Manager
pathname=""" />. Verify the line is commented, or delete it.

|. Save and close the file.
8. Restart the Scopia Desktop — Apache Tomcat service.
9. Repeat the above procedure for each Scopia Desktop Server in the group.

10. (Optional) To verify whether the cluster is correctly configured on all the servers, you can
perform your own stress tests and capture network traces using the Wireshark filter ip.dst
Filter==228.0.0.4 which presents the cluster's synchronization traffic (or "heartbeat").

For example, enter the filter to verify that each server in the cluster broadcasts a message
every 0.5 seconds to the specified IP address (Figure 91: Capturing network traces on page
124).
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Figure 91: Capturing network traces

11. Configure the load balancer used in your deployment (see Configuring Radware AppDirector
on page 124 or Configuring Other Load Balancers on page 131).

Configuring Radware AppDirector

About this task

For scalability and high availability you can cluster multiple Scopia Desktop Servers behind a load
balancer such as Radware's AppDirector.

You can configure AppDirector to route all network traffic or part of it (Figure 92: Media can either bypass
or travel via the load balancer on page 125) depending on your deployment requirements:

* In full load balancing deployments, all network traffic between servers and clients, including the
media (audio, video, data presentations), is routed via the load balancer. This is best for powerful
load balancer servers, and has the added security advantage of withholding the private IP of a
Scopia Desktop Server to the outside world.

* In partial load balancing deployments, the media data travels directly between client and server,
bypassing the load balancer, while signaling and management still travel via the load balancer.
This is better for less powerful load balancer computers, but directly exposes the servers' private 1P
addresses to the outside world.
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O important:

You can set up your load balancer so the servers route everything via the load balancer, by defining
the Scopia Desktop Server default gateway to be the load balancer. If you deploy servers whose only
connection to the network is via the load balancer, then clearly there is no way for the media to
bypass the load balancer.

This procedure describes how to configure AppDirector for a Scopia Desktop deployment. For complete
flexibility in AppDirector configuration, see AppDirector's documentation.

O important:

Only system integrators familiar with AppDirector should configure the load balancer.

Before you begin

1. Plan your load balancer deployment as part of your overall topology. For more information, see
Planning your Scopia Desktop Server Deployment on page 10.

2. Configure the Scopia Desktop Server's basic settings as described in Configuring Core Features of
Scopia Desktop Server on page 49.

3. Read Deploying Multiple Scopia Desktop Servers with a Load Balancer on page 119 for an
overview on load balancing in the Scopia Desktop deployment.

4. Follow the procedure in Configuring Scopia Desktop Server for Load Balancing on page 120 to
configure settings on each Scopia Desktop Server.

Procedure
1. Login to AppDirector.

2. Configure the server farm in the load balancer. The farm is the AppDirector's terminology of a
cluster of servers. It is a virtual entity that integrates one or more physical servers.

a. Create a farm by selecting AppDirector > Farms > Farm Table > Create.
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b. Enter the basic settings for this server farm (Figure 93: Configuring the virtual farm on
page 126 and Table 25: The virtual farm settings on page 126).

Fadrn Mame: 5D - Farm |

Admin Status Enabled - Dispatch Method  Cyche
Sessions Mode:  EntryPerSession I - Aging Time 300
Bandwidth Limst:  No Limat -

Connectivity Choecks

Conneclrity Check Method: TGP Port I - Connectraly Check Retries: 5

Figure 93: Configuring the virtual farm

Table 25: The virtual farm settings

Field Name Description

Farm Name Server farm name

Aging Time Indicates the number of seconds before the Scopia
Desktop Client connection is timed out (disconnected).

Set the aging time to a high value (for example, 90000).
Within that period of time, AppDirector routes the re-
connecting client to that specific server.

Dispatch Method Select the method the load balancer uses for distributing
traffic among servers in this farm. For example, select
Cyclic for the load balancer to direct traffic to each server
in a round robin mode.

Sessions Mode Select EntryPerSession for the load balancer to route
packets from the same client to the same server
throughout the duration of the videoconference.

Connectivity Check Select TCP Port for AppDirector to check the Scopia
Method Desktop Server availability during the videoconference.

3. Configure the Layer 4 rules (or policies) the load balancer uses to manage traffic.
AppDirector uses the Layer 4 protocol and the request’s destination port to select the farm.

a. Create a policy by selecting AppDirector > Layer 4 Traffic Redirection > Layer 4
Policies > Create.

b. Enter the basic settings for this policy (Figure 94: Configuring the Layer 4 Policies on
page 127 and Table 26: The Layer 4 Policy settings on page 127).
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Figure 94: Configuring the Layer 4 Policies

Table 26: The Layer 4 Policy settings

Field Name Description

L4 Policy Name Policy name

Virtual IP Farm's virtual IP address. The load balancer uses the
virtual IP to act as a single server to other components in
the deployment.

L4 Protocol Select Any for the Layer 4 traffic policy to support any IP
protocol including TCP and UDP.
Farm Name Select the name of the farm you previously created.

c. Configure the farm's virtual IP in the organization's firewalls to ensure communication
with the farm.

4. (Optional) If you want the media traffic (audio, video, presentation data) to bypass the load
balancer, verify the client NAT feature on the load balancer is disabled (default setting). The
client NAT would re-route traffic destined for the Scopia Desktop Client to go via the load
balancer. Therefore to bypass it, client NAT must be disabled.

a. Verify the Client NAT in AppDirector > NAT > Client NAT > Global Parameters is
disabled (Figure 97: Enabling Client NAT on page 128).

Device Tuning  Client NAT Intercept Tab

Client MAT: Disabled -

Figure 95: Disabling Client NAT

b. Configure Scopia Desktop Server to send its individual IP address (or FQDN) to Scopia
Desktop Clients, not its virtual IP address, so media can be sent directly between the
client and server, bypassing the load balancer.

In the Scopia Desktop Server's administration web interface, navigate to Client >
Connection Information.
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Connection Information

SCOFIA Desktep chents will connect to the server by using either the selected SCOFIA Deskicp Network
Interface, or a public address (FQDN recommended) if specified below,

Public Address: [tez.168.281.131

Figure 96: Configuring direct media traffic between client and server

c. Enter this server's IP address, not the virtual IP address. It sends this address to the
client at call setup, so both client and server can route media traffic directly between
them.

5. (Optional) If you want the media traffic (audio, video, presentation data) to route via the load
balancer, enable the client NAT feature on the load balancer. Client NAT re-routes traffic
destined for the Scopia Desktop Client to go via the load balancer.

a. Enable Client NAT in AppDirector > NAT > Client NAT > Global Parameters (Figure
97: Enabling Client NAT on page 128).

Device Tuning  Client NAT Intercept Table
Chent HAT: Enabled ~

Figure 97: Enabling Client NAT

With Client NAT enabled, the load balancer replaces Scopia Desktop Client's IP address
with the load balancer's IP address. The server uses this address to send replies to
clients.

b. Configure the range of client IP addresses on which the system performs NAT by
selecting Client NAT Intercept Table (Figure 98: The Client NAT Intercept Table on
page 128).

Cliant NAT Intercept Table > Client NAT Intercept Table Create

Client NAT Global Parameters  Device Tuning  Client HAT Address Table

From Client IP: 0.0.0.0 To Chent IP: 255 285 255 254

Figure 98: The Client NAT Intercept Table

c¢. Configure the NAT IP addresses in Client NAT Address Table (Figure 99: The Client
NAT Address Table on page 128). The load balancer replaces the client IP address
calling into the farm with the load balancer IP address. Usually you configure both fields
to the same IP address (the load balancer's IP address).

Client NAT Address Table > Client NAT Address Table Create

Client NAT Global Parameters  Client NAT Intercept Table  Device Tuning  Client MAT Guick Setup

From P Addrass 192 168 241,207 To IP Address: 192 168241207

Figure 99: The Client NAT Address Table
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d. Configure the Client NAT's basic settings in Client NAT Quick Setup (Figure 100: The
Client NAT Quick Setup window on page 129.

IE_Ileﬂl: MAT Range: 152168 241 207 I'l'

Hew Client HAT Range

From IP Address: 0.0.00

Fanmns

PFS - Farm

# Apply for all chent $owce IP ad&essasl

Enable X-Forwarded-For Header on Sedected Farms

To IP Address

0.0.0.0

Select All Farms

d |SD - Farmi

ol

Figure 100: The Client NAT Quick Setup window

Fill the fields as described in Table 27: The Client NAT Quick Setup settings on page
129.

Table 27: The Client NAT Quick Setup settings

Field Name Description

Client NAT Range

Select the IP address in the list of configured Client
NAT ranges.

Farm

Select the farm for which Client NAT is performed.

Apply for all client source IP
addresses

Select to indicate the load balancer performs this
IP replacement (re-routing) for all clients calling into

this load balancer.

e. Configure Scopia Desktop Server to send the virtual IP address of the farm to Scopia
Desktop Clients, so media can be sent via the load balancer.

In the Scopia Desktop Server's administration web interface, navigate to Client >
Connection Information.

Conneclion Information

SCOPEA Desktop clients will connect to the server by using either the sslected SCOPIA Desktop Network
Interface, or a public address (FQDM recommended) if specified below.

Public Addrass; [ acluster, COMPary. Som

Figure 101: Routing media traffic through the load balancer

f. Enter the farm's virtual IP address. Scopia Desktop Server sends this address to clients
at call setup, so both client and server can route media via the load balancer.

6. Add each Scopia Desktop Server to the farm.

a. Enter the server details in AppDirector > Servers > Application Servers > Table >
Create (Figure 102: Configuring the server table on page 130 and Table 28: The server

table settings on page 130).
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Figure 102: Configuring the server table

Table 28: The server table settings

Field Name Description

Server Name Scopia Desktop Server name

Farm Name Select the name of the newly created farm.

Server Address IP address of the Scopia Desktop Server

Server Description A short text describing the Scopia Desktop Server

Client NAT Set to Enabled when routing media as well as
signaling through the load balancer.

Client NAT Address Range Select the configured client NAT address.

b. Repeat these steps for each Scopia Desktop Server in the farm.

7. Configure cookie persistency in the load balancer.

The persistency rule routes clients of the same videoconference to the same server. The rule
examines the HTTP persistent cookie sent by Scopia Desktop Clients. The cookie has the
format CONFSESSIONID = <meeting number>.

a. Create the persistency rule in AppDirector > Layer 7 Server Persistency > Text
Match > Create.

b. Enter the rule's basic settings (Figure 103: Configuring session persistency on page 131
and Table 29: The session persistency settings on page 131).
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Figure 103: Configuring session persistency

Table 29: The session persistency settings

Field Name Description

Farm Name Select the name of the farm grouping Scopia
Desktop Servers.

Lookup Mode Select Cookie. Configure the cookie name in the
Persistency Parameter field.

Persistency Parameter Enter CONFSESSIONID. The cookie is case
sensitive.

Inactivity Timeout [sec] Indicates how long AppDirector keeps linking a

meeting ID to a specific server after the
videoconference becomes inactive. If a client
connects again within that period of time,
AppDirector routes it to that specific server.

Learning Direction Select Client Request for AppDirector to inspect the
client request only for the HTTP persistent cookie.

Ignore Source IP Select Enabled so AppDirector uses the meeting ID
to forward the same videoconference to the same
server.

Configuring Other Load Balancers

About this task

For scalability and high availability you can cluster several Scopia Desktop Servers behind a non-
Radware load balancer. This allows continued service even when one or more of the servers fails.

Administrator Guide for Scopia Desktop Server Version 7.7.3 Deploying Multiple Scopia Desktop Servers with a Load Balancer |

131




This procedure describes how to configure load balancers other than AppDirector to correctly route calls
to the Scopia Desktop Servers. If your deployment uses AppDirector, see Configuring Radware

AppDirector on page 124.
O important:

Only experts familiar with the load balancing tool and HTTP protocol may set up this deployment.

Before you begin

* Plan your load balancer deployment as part of your overall topology. For more information, see
Planning your Scopia Desktop Server Deployment on page 10.

* Configure the Scopia Desktop Server's basic settings as described in Configuring Core Features of
Scopia Desktop Server on page 49.

* Read Deploying Multiple Scopia Desktop Servers with a Load Balancer on page 119 for an
overview on load balancing in the Scopia Desktop deployment.

* Perform the procedure in Configuring Scopia Desktop Server for Load Balancing on page 120.

Procedure

1. Define the load balancer settings, including defining the servers, their cluster or group name,
and their virtual IP (VIP) address.

Scopia Desktop Clients use the VIP to reach that cluster.

2. Select a routing method for the load balancer.

To optimize resource utilization, load balancers use different methods for rotating the load of
calls among servers in the deployment. We tested load balancing with the round-robin
method which ensures good load balancing and is widely used in the videoconferencing
industry.

3. Configure a persistency rule in the load balancer so all the clients belonging to the same
meeting are routed to the same server.

The rule must examine the HTTP persistent cookie sent by Scopia Desktop Clients. The
cookie has the format CONFSESSIONID = <meeting number>.

If an HTTP request arrives from the client and contains an HTTP cookie with a
CONFSESSIONID key, the persistency rule must route as follows:

* If the load balancer has previously routed an HTTP request with this cookie to a specific
server, it must route the new request to the same server.

* If the load balancer did not yet encounter a cookie with this value, it must route the
request to the next available server and learn this cookie.

O important:

If you do not set up these rules, the system uses ports less efficiently. In addition, some
moderation features (such as muting participants) may fail. We strongly recommend to
verify correct routing using a network tracing tool such as Wireshark.

4. Set the aging time of the persistency rule to a high value.

The aging time indicates how long the load balancer keeps linking a meeting ID to a specific
server after the videoconference becomes inactive. If a participant connects again to that
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videoconference within the specified period of time, the load balancer routes the call to that
same server.

Configuring Streaming and Recording in a Load Balancing
Environment

About this task

Scopia Desktop Server allows users to record meetings and to view recorded meetings. A recorded
Scopia Desktop videoconference can be played at any time. Recordings include audio, video, and
shared data (if participants present data during the videoconference).

Scopia Desktop Server’s streaming functionality enables viewers to watch a webcast. A Scopia Desktop
webcast is a live broadcast of a Scopia Desktop videoconference over the internet. Viewers of the
webcast cannot interact with other participants in the meeting.

To view a webcast, you can use any client that accepts Real Time Streaming Protocol (RTSP), such as
Apple Quicktime.

Scopia Desktop Server includes the Recording and Streaming Server components. You can enable this
functionality within Scopia Desktop Server, or you can deploy dedicated recording and streaming
servers. For more information, see Medium Scopia Desktop Server Deployment with Dedicated Servers
on page 18.

To configure a streaming and/or recording server in a load balancing environment, you can:

* Point all Scopia Desktop Servers in the cluster to a single dedicated streaming and/or recording
server outside the cluster. The playback client communicates directly with the dedicated server.

* Enable streaming capabilities in each Scopia Desktop Server in the cluster .
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Figure 104: Dedicated recording/streaming, or local streaming

With a dedicated Recording or Streaming Server, you also need to list the Scopia Desktop Servers
allowed to access it, by editing its access control list using the Scopia Desktop Server Configuration
Tool. Furthermore, the number of simultaneous streaming and/or recording clients depends on the
license enabled in the dedicated server. For example, if you install a 600-port streaming server, it can
communicate with 600 streaming clients.

With streaming enabled locally, the number of simultaneous streaming clients depends on the number of
licensed streams per server times the number of servers in the cluster. For example, if each streaming
server has 600 ports and you install three of them, they can communicate with 1800 streaming clients.

This section describes how to either point the servers to a dedicated streaming/recording server, or
locally enable streaming on each server in the farm.

Before you begin

For an overview of the recording and streaming components in Scopia Desktop Servers, see About
Components of the Scopia Desktop Server on page 7.

Procedure
1. Access the Scopia Desktop Server administrator portal.

2. Select Deployment in the sidebar menu (Figure 105: Recording and streaming on page
135).
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Figure 105: Recording and streaming

3. Enter the settings for the dedicated or local Scopia Desktop Server:

Table 30: Recording and streaming settings

Field Name Description

Recording Select the checkbox to enable recording in
the dedicated server.

Streaming Select the checkbox to enable streaming in
the dedicated or local server.

Recording Server Address Enter the IP address of the server used for
recording (either this server or a dedicated
recording server).

Darwin Streaming Server Address Enter the IP address of the dedicated or local
server.

4, Select Ok or Apply.

5. If you are configuring a streaming server locally, repeat the above steps for each Scopia
Desktop Server in the cluster.

6. For any Scopia Desktop Server accessing a dedicated Content Center Server (recording or
streaming), enter each Scopia Desktop Server IP address in the access control list using the
Scopia Desktop Server Configuration Tool.

a. On the dedicated Content Server for Scopia Desktop, select Start > Programs > Scopia
Desktop > ConfigTool.

b. Select Content in the sidebar.

The system lists the IP addresses of the Scopia Desktop Servers allowed to access this
Dedicated Content Server (#unique_ 76/
unique 76 _Connect_42 fig_ CF52F803861F4AC48A967BFCB5F01BCF).
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Figure 106:  Enabling multiple Scopia Desktop Servers to access a Dedicated
Content Server

c. Select Add to add the IP address of each Scopia Desktop Server using this Content
Server.

d. Select OK.

Securing a Load Balanced Environment

You can route the media of a videoconference via the load balancer if its computer is powerful enough,
or the media can bypass the load balancer creating a direct flow from the server to the Scopia Desktop
Client (see Configuring Radware AppDirector on page 124).
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Figure 107: Media can either bypass or travel via the load balancer
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When a device establishes a secure connection with another component, it sends a signed certificate
verifying its identity. The signature on the certificate must be from a known (trusted) certification authority
(CA).

O important:

Using encryption is subject to local regulation. In some countries it is restricted or limited for usage.
For more information, consult your local reseller.

* When media flows via the load balancer, install the Scopia Desktop Server certificates on the load
balancer only (Figure 108: Encrypting communication with the load balancer certificate on page
137). If each server has its own certificate, install all of them on the load balancer. If they all share
the same certificate, you only need to install it once.

For more information on installing certificates on your load balancer, see the load balancer

documentation.
Scopia Desktop Client HTTPS Load Balancer HTT Scopia Desktop Server

Scopia Desktop

Figure 108: Encrypting communication with the load balancer certificate

* When media flows directly between client and server, bypassing the load balancer, install
certificates both on the load balancer and the servers in the cluster (Figure 109: Encrypting
communication with the load balancer and server certificates on page 138). As with the previous
example, if all servers in the cluster share the same certificate, you only need to install that single
certificate on the load balancer.
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For more information on installing Scopia Desktop Server certificates, see Securing Your Scopia
Desktop Deployment on page 107. To install certificates on your load balancer, see the load
balancer documentation.

Scopia Desktop Client HTTPS Load Balancer HTTPS Scopia Desktop Server

Figure 109: Encrypting communication with the load balancer and server certificates

O important:

All servers in the deployment must be configured with the same functionality and the same security
mode (http/https).
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Chapter 8| Troubleshooting Common
Issues

Each of the following sections presents the symptoms of common problems that may occur during the use of the
Scopia Desktop. Recommended actions for each symptom are also provided. For more information related to known
issues, see the Scopia Desktop Release Notes.

When Scopia Desktop is part of a multi-tenant deployment, you can view the component connection and
communication status in a page that enables you to verify any issues per organization located in the deployment.
Once you accessed the page, select the Directory tab, enter the cursor into the dropdown list and select the
organization whose policies you want to check.

These topics include:
Navigation

* Viewing Status of Servers and Directory on page 139

* Recording Does not Start Automatically on page 146

* Changing the IP Address of the Scopia Desktop Server on page 146

* Updating the IP Address on the Recording or Streaming Server on page 147

* Client -734 Error and other Certificate Problems on page 147

* Upgrading Scopia Desktop Server Recordings on page 148

* Reinstalling Scopia Desktop Presence Server Configuration on page 149

* Enabling a User to Sign In on page 150

* Troubleshooting Scopia Mobile on page 151

Viewing Status of Servers and Directory

Viewing the status of your Scopia Desktop deployment is a helpful way to assess resource availability
and troubleshoot connectivity problems. The following sections provide useful information for utilizing the
View Status functionality of Scopia Desktop.

Navigation

* Viewing Server Status and Port Resource Usage on page 139

* Viewing Directory Status on page 142

* Viewing Recording Server Status on page 143

* Viewing Content Slider Status on page 145
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Viewing Server Status and Port Resource Usage

About this task

Select Status in the sidebar and select the Scopia Desktop tab to view the status information about the
Scopia Desktop Server and other connected video network devices.

SCOPIA Desktop Components

SCOPLA Deskiop Server: 162.168.114.236

IWVIEW Suite: 192.168.114.236

Streaming Server: 192.168.114.236

Sametime Server: rvnh-pedominogs.radyvision.com

o
o
Gatekeeper: 192.168.114.236 .
o
o

Figure 110: Component Status
The Scopia Desktop Components section includes the IP address and status of the following video
network devices:
* iVIEW Suite when Scopia Management manages the Scopia Desktop Server.
* Gatekeeper for Scopia ECS Gatekeeper.
* Streaming Server if the Scopia Desktop Server is configured to manage streaming.

* Scopia MCU if the Scopia Desktop Server is managed by an MCU rather than Scopia
Management.

* Sametime Server if the Scopia Desktop Server is configured to work with IBM Lotus Sametime
Web.

The indicator next to each link shows whether or not the connection to the target device or registration
with the gatekeeper is successful. When the indicator is red, hover the mouse pointer over the icon to
view the error details. Select the red indicator to view further error information.

The Scopia Desktop tab also shows port usage statistics and presents port usage graphically.
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Figure 111: Port Status Graph

Depending on your needs you may choose one of the graph reports described in Viewing Server Status
and Port Resource Usage on page 139.

O important:

We recommend waiting several minutes before refreshing the status information to view the updated
port information.

Depending on the deployment the Scopia Desktop Status tab also displays additional statistics:
* For deployment without Scopia Management
— Number of participants in group calls
— Number of streaming ports
* For deployments with enabled point-to-point-only functionality
— Number of relayed point-to-point calls

* For advanced deployments

Number of total live ports

Number of relayed point-to-point calls

Number of participants in group calls
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If calls exceed the maximum allowed, the number of connected participants appears in red, with a
warning that Usage has exceeded the maximum allocated resources.

If you set the call limit to a number lower than defined by the license, an error message is displayed next
to the number of participants in group calls.

Viewing Directory Status

About this task

In deployments where Scopia Desktop is configured to work with Scopia Management, Scopia Desktop
Server must synchronize with Scopia Management to download information about users, virtual rooms,
and global policy. Scopia Desktop Server synchronizes with Scopia Management when it connects to it
for the first time; then Scopia Management updates Scopia Desktop Server each time there is new or
modified information. These are the following synchronization states:

* Synchronized—Scopia Desktop Server is synchronized with Scopia Management.

* Synchronizing—Scopia Desktop Server is caching information from Scopia Management. Users
cannot search for users and terminals in the contact list or in the Invite dialog box.

* Not Synchronized—Scopia Desktop Server functions using locally cached information.The Scopia
Desktop functionality is not influenced except one feature: standard login is not available. In
deployments where the Integrated Windows Authentication is enabled, users can still log in using
Single Sign-On.

* Synchronization error—Scopia Desktop Server is not synchronized with Scopia Management, no
information is cached. The Scopia Desktop functionality is reduced.

Select Status > Directory Status to display an organization’s directory information. All the settings in
this screen are configured in Scopia Management.

Figure 112: Viewing the directory status of an organization pertaining to a single tenant deployment on
page 143 illustrates the directory status of a company pertaining to a single tenant deployment.

Administrator Guide for Scopia Desktop Server Version 7.7.3 Troubleshooting Common Issues | 142




Global Directory - iIVIEW Suite

Synchronization: Synchronized .
Authentication: Enabled
Guest Access to Meetings: Enabled
Guest Access to Webcasts: Enabled
Guest Access to Recordings: Enabled
Figure 112: Viewing the directory status of an organization pertaining to a single tenant
deployment

Figure 113: Viewing the directory status of a company pertaining to multi-tenant deployment on page
143 shows the directory status of an organization pertaining to a multi-tenant deployment. Scroll the
dropdown list in the Organization field to select the organization whose directory you need to check.

Global Directory - iVIEW Suite

Organization: Radwvision, Inc. -
Synchronization: Synchronized .
Authentication: Enabled

Guest Access to Meetings: Enabled

Guest Arcees bn Weheaste: Frahled

Figure 113: Viewing the directory status of a company pertaining to multi-tenant deployment

You can also view the maximum call rate value. This setting is configured in Scopia Management.

Global User Policy

Maximum Call Rate (Kb/=s):

1024

Figure 114: Viewing the maximum call rate policy

Viewing Recording Server Status

About this task

You can view the Recording Server Status information only if recording is enabled in your deployment.
The Recording Status tab displays this information:

* Recording Components:
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Recording Components

Fecording Server: 192.168.114.236 .
Recorder: 192.1638.114.236 .
Gatekeeper: 192.168.114.236 .
NIC Address: 192.168.114.236

Figure 115: Recording Components Status

— Recording Server—Displays the address of the Scopia Desktop Recording Server.

— Recorder—Displays the connection status between the Scopia Desktop Recording Server
and the Scopia Desktop Conference Server.

— Gatekeeper—Displays the address of the gatekeeper to which the Conference Server is
registered. In the special case that the Scopia Desktop Recording Server is installed
separately from the Scopia Desktop Server and has its own Conference Server, the
Conference Server must be registered to the same gatekeeper as the Scopia Desktop
Server.

— NIC Address—Displays the NIC address used by the Scopia Desktop Recording Server to
communicate with MCU.

* Recording Server Information:

Recording Server Information

CiWFrogram Files'\Radvision\SCOFIA

Recordings Folder: Cesktop'Movies\recordings',

Figure 116: Recording Server Information
— Recordings Folder—Displays the location of the folder on the Scopia Desktop Recording
Server used for storing recordings.

— Remaining Disk Space—Shows how much space is remaining on the disk on which
recordings are stored.

If the remaining disk space is less than the disk space allocated for recordings, a warning
icon is displayed. Click the icon for details.

* Storage Capacity—Shows the amount of disk space used by all recordings.

Storage Capacity

U=zed (MB) Allocated (MB)

6606 8192

Figure 117: Storage Capacity Status

The maximum value is configured during installation.To change the maximum disk space, run the
installer on the Scopia Desktop Recording Server in the modification mode.

* Recording Ports:
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Total Live Ports

In Use Allowed

0 250

Figure 118: Port Usage Status

— In Use—Shows the number of recordings being recorded at the present moment. The
maximum value appears as specified in the recording license installed for this Scopia
Desktop.

— Licensed—Shows the number of recording ports defined by the license.

* Available Recordings:

Available Recordings

Completed Beconstructed

163 0

Figure 119: Available Recordings Status

— Completed—Shows the total number of completed recordings available for watching.
— Reconstructed—Shows the number of reconstructed recordings.

Scopia Desktop saves actual recordings and recording attributes in different folders. If a user
restores only a recording without restoring its attributes, the recording appears as
reconstructed. In this case you need to manually define recording attributes, such as the
name and the owner PIN, to finalize reconstruction of a recording. After the reconstruction is
completed, the recording appears on Watch Recording page of the Scopia Desktop portal. If
recording attributes are not reconstructed, the yellow attention icon is displayed. Click the
icon for more information.

Select Status > Recording Status to access Recording Server information.

Viewing Content Slider Status

About this task

You can view the Content Server status information only if recording is enabled in your deployment.

The Content Slider Status tab displays this information:
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SCOPIA Desktop | Directory Raecording Content Shider  Logging

Content Slider Status Refresh Content Slider Summary

Recording Servers Sessions Problems Total Sessions Total Problems
107.63.132.88 Q s« 4

T | 660 73
190.172.196.141 0 13

21.74.179.154 ® o 10

Figure 120: Content Slider Status

* Recording Server Status:
— Recording Server—Displays the address of the Scopia Desktop Recording Server.

— Sessions—All slider sessions currently in progress, with details on the server(s) that have
sessions.

Problems—If there are problems with slider sessions, they appear (per server) in the
problems column. To view details, select the link in the Problems column: Results show the
date/time of the problem and a brief summary of the problem details.

Recording Does not Start Automatically

Problem Scopia Management configured to work with the Scopia Desktop Server does not record
virtual room meetings or scheduled meetings automatically, even though Scopia
Management is configured to do so.

Solution Verify that one of these problems does not interfere with recording:

* There are not enough available recording ports on the Scopia Desktop at the time when
the meeting is scheduled.

* There are not enough available recording ports on the Scopia Desktop at the time when
the meeting is scheduled.

* The maximum number of simultaneous recordings is reached.

Changing the IP Address of the Scopia Desktop Server

Problem The Scopia Desktop Status tab indicates that the Scopia Desktop Server is not connected.

Solution If the IP address of the server on which the Scopia Desktop Server is installed changes, you
need to update Scopia Desktop Server components with its new IP address.

Procedure
1. Select Start > Settings > Control Panel.
2. Double-click Add or Remove Programs.

3. From the list of programs, choose Scopia Desktop, and then Change.

The Setup Wizard opens.
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4. In the Welcome screen select Next.

5. In the Program Maintenance screen, choose Modify, and select Next.

6. Inthe Custom Setup screen, select Next.

7. Inthe Scopia Desktop Serial Key screen, select Next.

8. In the Scopia Desktop Network Configuration screen, select Next.

9. In the Scopia Desktop Hostname Configuration screen, select Next.
10. In the Scopia Desktop Recording Configuration screen, select Next.

11. Select Install.

Updating the IP Address on the Recording or Streaming
Server

Problem The Scopia Desktop Status tab indicates that the Streaming or Recording Server is not
connected. If you select the Streaming Server indicator, it displays the error 5003 Access
denied error from proxy.

Solution When the Streaming or Recording components of Scopia Desktop are installed on their own
server, separately from the Scopia Desktop Server, they are configured with the IP address
of the Scopia Desktop Server which is allowed to connect to them. If the IP address of the
Scopia Desktop Server changes, you need to update it on the Streaming and Recording
Servers.

Procedure
1. From the Start menu, select Programs > Scopia Desktop > ConfigTool.
2. Select the Content Center tab.
3. Click the Add button and enter the new IP address of the Scopia Desktop Server.

4. Select the old IP address of Scopia Desktop Server, and click the Remove button to remove
it from the list.

Client -734 Error and other Certificate Problems

Problem The client issues a -734 error, and the client call log states:

get _verify result error = 19, the peer certificate is invalid.
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In cases of an incorrect Scopia Desktop Server certificate setting, the Scopia Desktop Client
returns errors 21 or 26.

Possible Causes The Scopia Desktop Client is attempting to connect to the Scopia Desktop Server when the
connection is encrypted but the server’s certificate is signed by an unknown (untrusted) CA.

Solution Install the root CA certificate on the Scopia Desktop Client computer using the standard
Microsoft Management Console.

Procedure
1. Obtain the root certificate of the CA used to sign the certificate on the Conference Server.
2. Launch the Microsoft Management Console.
3. Select File > Add/Remove Snap-in.
4. Select Add.
5. Select Certificates, and then select Add.
6. Select Computer Account in the Certificates snap-in window, and then select Next.

7. Select Local computer (the computer this console is running on), and then select
Finish.

8. Select Close and OK.

9. Verify that the console shows the Certificates (Local Computer) in the main console
window’s left hand pane.

10. Expand the entry Certificates (Local Computer) and navigate to Certificates (Local
Computer) > Trusted Root Certification Authorities > Certificates.

11. Right-click Certificates and select All Tasks > Import.
12. Select Next.

13. Select Browse, and select the signed certificate file you want to upload.

By default the file type in the browse window is set to show only X.509 Certificates. Change
this to Personal Information Exchange (*.pfx;*.p12) or All Files (*.*), and select Next.

14. Select Place all certificates in the following store, and then verify that the Certificate
store: Trusted Root Certification Authorities option is selected.

15. Select Next.
16. Verify the information and select Finish.

17. Verify that the Certificate Chain is located in the Trust Root Certification Authorities store.
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Upgrading Scopia Desktop Server Recordings

About this task

If there are recordings created using Scopia Desktop Server version 5.x, upgrade them by performing
these steps:

O important:

You can upgrade recordings at any time.

Procedure

1. Install QuickTime version 7.6.2 or higher. You can download QuickTime at
http:/Mww.apple.com/quicktime/download/.

2. On the Scopia Desktop Server, navigate to the <INSTALLDIR>\config location.
3. Double-click the recording_converter.exe file.

4. Follow the on-screen instructions. Depending of the size and amount of recordings, the
upgrade may take time.

5. The recordings are converted and the log files are created in this folder.
6. Verify that the recordings are converted correctly.

7. Delete backed up recordings.

Reinstalling Scopia Desktop Presence Server
Configuration

About this task

Perform this procedure to backup and reinstall the Scopia Desktop Presence Server.

Procedure

1. Backup the current Presence Server configuration:
a. Save the ejabberd.cfg file at the ..\Jabber\conf location into a different location.

b. Save any folders under the ...\Jabber\database folder into a different location.

2. Navigate to ...\Jabbeninstall and launch ejabberd-2.0.3-windows-installer.exe.

The Installation wizard opens.
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3. Modify the installation directory in the Installation Directory window to be C:\Program Files
\Radvision\SCOPIA Desktop\Jabber, and then select Next.

4. Leave the default domain in the ejabberd server domain window, and then select Next.

The default domain is changed either via the Jabber Config tool or by replacing the
ejabberd.cfg file after installation, and then select Next.

5. Leave the default admin name in the Administrator user name window, and then select
Next.

6. Enter the administrator password and re-enter it for confirmation. Select Next.
7. Select the required option in the Cluster window, and then select Next.

8. After the installation is complete:
¢ Restore the database and ejabberd.cfqg file.

* Set the service to automatic.

Enabling a User to Sign In

Problem A user cannot sign in.

Solution Verify that the following problems do not interfere with user signing in:

* Authentication is turned off on Scopia Management. In the Scopia Desktop
Administrator web user interface, select Status in the sidebar, and then select the
Directory Status tab. Verify that authentication is enabled.

General User Policies:
Enable SCOPlA Deskiop uzer authentication
Allew guestz to acceze meetings
|:| Allew guests to accezs webcaztz
|:| Allew guests to =tart recording
|:| Allew guests to access recordings
|:| Onhy authenticated users can invite

Dizplay all meeting records on My Mestings =creen

Figure 121: General User Policies
* This particular user does not have a Scopia Desktop Pro license.

* If Scopia Desktop is enabled for Integrated Windows Authentication and the user does
not use a valid proxy account. In the Scopia Desktop Administrator web user interface,
select Directory and Authentication in the sidebar, check the proxy account
configured in the Integrated Windows Authentication area.
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Specify the credentials of a proxy user account that may be used to establish a connection
to the domain controller.

Froxy Account User Mame: |r'~.'nh-kn|:|'f\.-
Proxy Account Password: |"u"
Zonfirm Proxy Account Password: |""u

Figure 122: Proxy Account Settings

* If Scopia Desktop is not enabled for Integrated Windows Authentication and uses
Scopia Management to authenticate, select Status in the sidebar and verify that Scopia
Desktop Server is connected to Scopia Management.

SCOPIA Desktop Components

IWVIEW Suite: 192.168.114.236

SCOPIA Desktop Server: 182.168.114.036 9

Figure 123: Scopia Desktop and Scopia Management Connectivity

Troubleshooting Scopia Mobile

If Scopia Mobile stops running (or crashes), a crash report is generated and copied to the computer the
next time the device is synchronized with iTunes.

Two files are generated for each crash: .crash and .plist. You can find them in these locations,
depending on the computer you are using:

* On an OSX device, look for the files in
~/Library/Logs/CrashReporter/MobileDevice/<DEVICE_NAME>\SCOPIAMobile*

* In a PC using Windows Vista/Windows 7, look for the files in %APPDATA%\Roaming\Apple
Computer\Logs\CrashReporter\MobileDevice\<DEVICE_NAME>\SCOPIAMobile*

* In a PC using Windows XP, look for the files in %APPDATA%\Apple Computer\Logs
\CrashReporter\MobileDevice\<DEVICE_NAME>\SCOPIAMobile*
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RADVISION®

an Avaya company

About Radvision

Radvision, an Avaya company, is a leading provider of videoconferencing and
telepresence technologies over IP and wireless networks. We offer end-to-end
visual communications that help businesses -collaborate more efficiently.
Together, Radvision and Avaya are propelling the unified communications
evolution forward with unique technologies that harness the power of video,
voice, and data over any network.

www.radvision.com
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